Accounts Payable Guide

INTRODUCTION ................................................................. 1
Standard Modules ............................................................ 2
Optional Modules ............................................................. 3
Accounts Payable Documentation ..................................... 4
Online Help ......................................................................... 7
Additional Documentation Resources .............................. 11

SYSTEM BASICS ............................................................... 13
Navigating in Accounts Payable ........................................ 14
Grouping Records in Queries ............................................. 25

CONFIGURATION ............................................................. 27
General Tab ........................................................................ 29
Preferences Tab .................................................................. 31
Tables Tab .......................................................................... 36
Attributes Tab ..................................................................... 40
Products Tab ......................................................................... 42
Addresses Tab ...................................................................... 44
Miscellaneous Line Items Tab .......................................... 46
Distributions Tab ................................................................. 48
Aging Information Tab ......................................................... 51
General Ledger Tab ............................................................. 52
International Tab ................................................................. 53

SECURITY ............................................................................ 57
Security Groups ................................................................. 59
Security Users ................................................................... 64
Passwords .......................................................................... 68

UTILITIES AND HOUSEKEEPING ................................. 71
Posting Rules ...................................................................... 72
Purging Activity ................................................................. 80
Posting and Purging Procedures ...................................... 81

VENDORS .......................................................................... 95
Accessing Vendors ................................................. 96
Setting Vendor Preferences .................................. 97
New Records ..................................................... 99

INVOICES AND CREDIT MEMOS ..................... 117

Working with Invoices ........................................ 118
Working with Recurring Invoices ....................... 128
Working with Credit Memos ................................. 133

BANK ACCOUNTS ............................................. 139

Bank Account Preferences ................................ 140
Managing Bank Accounts .................................. 143

CHECKS ......................................................... 149

Printing Checks ................................................ 151
Managing Direct Disbursements ....................... 158
Recording Manual Checks ................................. 161
Recording Bank Drafts .................................... 162
Clearing Checks ............................................... 163
Renumbering Checks ....................................... 164
Voiding Checks .............................................. 164
Purging Checks ............................................... 165
Viewing Transaction Details ............................. 166

QUERY AND EXPORT ..................................... 167

Query Types .................................................. 168
Understanding Query Criteria Operators ........... 168
Accessing Query and Export ............................. 171
Establishing General Query Preferences ............ 171
Refreshing a Static Query ................................ 191
Exporting Queries .......................................... 191
Favorites .................................................... 192

MAIL ......................................................... 195

Mail Basics .................................................. 197
Labels ......................................................... 200
Envelopes ..................................................... 207
Rolodex/Index Cards ...................................... 209
Letters ......................................................... 212
1099 Forms .................................................. 214

REPORTS .................................................... 217

Accounts Payable Reports ............................... 218
Creating Reports .......................................... 221
Reference ...................................................... 238
Introduction

In This Chapter

Standard Modules ...................................................... 2
Optional Modules .......................................................... 3
Accounting Queue ......................................................... 3
Bank Account Reconciliation ........................................... 3
Electronic Funds Transfer ............................................... 4
Purchase Orders ............................................................ 4
Accounts Payable Documentation ...................................... 4
User’s Guide Format ......................................................... 5
  Chapter Format ............................................................ 5
  Text Format ............................................................... 5
  Shortcut Keys ............................................................. 6
Online Help ................................................................. 7
  Using Online Help ....................................................... 7
Additional Documentation Resources ............................... 11
Welcome to *Accounts Payable*, Blackbaud’s comprehensive check writing and payment information program. As you become familiar with this program, you will see the many benefits and features incorporated into this easy-to-use software package.

A variety of system preferences allow you to tailor the program to meet your organization’s particular needs.

Because the *Accounts Payable* program shares a central database with Blackbaud’s *General Ledger for Windows*, you can post data directly to *General Ledger*. If needed, you can adjust invoices, credit memos, and purchase order line items that have been posted to *General Ledger*, and post correcting entries.

This chapter is designed to acquaint you with the documentation and resources available to you for *Accounts Payable*.

## Standard Modules

Blackbaud’s financial products are fully integrated, sharing common *Security*, *Bank Accounts*, *Mail*, *Import*, *Global Change*, and *Reports* modules. Your *Accounts Payable* program is comprised of four additional modules: *Configuration*, *Query and Export*, *Utilities and Housekeeping*, and *Vendors*.

The following modules are included in *Accounts Payable*:

- **Bank Accounts**: With this module you can enter information about your bank, such as the account number, address, phone number, and contact information. You can also select the *General Ledger* cash, AP summary, and discount accounts. And, if the optional *Electronic Funds Transfer* module is present, you can establish the necessary routing information.

- **Configuration**: With this module you can establish system settings, preferences, table entries, distributions, product lists, shipping fees, aging information, international settings, secondary addresses, and settings that allow *Accounts Payable* to post to *General Ledger*.

- **Import**: With this module you can bring information from an outside source into *Accounts Payable*. *Import* allows you to set up and save reusable import parameter files, define field mappings as you go with drag-and-drop ease, use separate header files to identify field mappings, browse field examples to eliminate confusion, and inspect the raw import data before running the import process.

- **Mail**: With this module you can use the information stored in your *Accounts Payable* database to create 1099 forms, vendor letters, labels, envelopes, and index and Rolodex cards.

- **Query and Export**: With this module you can create, open, run, and delete queries. Queries can be used in *Accounts Payable* to create reports and verify data for a specific set of records. Other features include refreshing, merging, and exporting queries.

- **Reports**: With this module you can create various reports that keep you up to date with every aspect of your operation. Select from more than 30 standard reports, including Invoice, Purchase Order, and Vendor reports. You can use filters to customize the reports for your specific needs, then save the custom report for future use. Reports can be previewed, printed, exported, or sent as e-mail.
• **Security**: With this module you can establish access rights for the system. Security is based on groups, with each group assigned access to specific areas of the program. Each user is assigned to an appropriate group and given a password. Access rights are based on a user’s group assignments. Users can be members of more than one group. You can limit access to a module or to individual functions within a module, depending on your organization’s needs and preferences.

• **Utilities and Housekeeping**: With this module you can view system statistics, store electronic signatures, purge vendor activity, purge inactive vendors, generate a duplicate vendor report, and validate your database. In addition, a Post to General Ledger option allows you to create a post file for General Ledger, or you can create an export file for use with other accounting programs.

• **Vendors**: With this module you can enter biographical information about your vendors, including address, credit limits, contact information, due days, discount days, and discount percentage. You can also add vendor activity (e.g., invoices, credit memos, recurring invoices, and purchase orders) in this module. In addition, you can enter 1099 information, set general ledger distributions, establish bank information, and view summary account information.

## Optional Modules

Most of the topics discussed in this manual relate to the basic Accounts Payable package. However, there are some references to optional modules, such as Accounting Queue, Bank Account Reconciliation, Electronic Funds Transfer, Purchase Orders, and other programs with which Accounts Payable can interface, such as Blackbaud’s General Ledger.

### Accounting Queue

This module allows you to schedule a sequence of tasks that can be executed, one after the other, automatically and unattended. Using this optional module can save you time with many of the repetitive functions performed by the Accounting for Nonprofits programs.

Because you can set up a queue to run overnight or while you are at lunch, using queues can save you time on almost all of the tasks the Accounting for Nonprofits software performs.

For example, you can schedule a queue of financial reports, a queue of mailings, and a queue of statistical reports to run overnight. This will free up your workstation and printer for other tasks during normal working hours.

For detailed information about this module, please refer to the Accounting Queue User’s Guide.

### Bank Account Reconciliation

This module enhances the Bank Accounts module of your Blackbaud programs. With Bank Account Reconciliation, you can reconcile your bank account, track the account balance, and review in-depth details about individual transactions. The module displays all transactions affecting a single bank and lets you view information from The Raiser’s Edge for Windows.
With Bank Account Reconciliation, you can view both deposits and checks on the same screen, along with the bank account balance. For example, you can view a Student Billing deposit, Accounts Payable computer check, Miscellaneous Cash Receipts deposit, and The Raiser's Edge batch total, all from the same screen.

Additional options become available in Bank Accounts when you install Bank Account Reconciliation. These options include a Setup Wizard feature that helps you establish the beginning balance for your bank account. You can reconcile manually or electronically, and you can add adjustments, such as service fees, during reconciliation. These adjustment transactions can then be posted to your general ledger.

**Electronic Funds Transfer**

This module adds fields and options to the Vendors, Bank Accounts, Reports, and Utilities and Housekeeping modules of Accounts Payable.

In Accounts Payable, invoices can be paid either by checks, bank drafts, or electronic funds transfers. Vendors is where you change the payment method for any existing invoices.

In Bank Accounts, you can allow electronic funds transfers, define parameters for electronic funds transfers, and establish interfund transfer entries to use for posting.

**Purchase Orders**

This module allows you to process purchase orders and receipts for your organization, and gives you the capability of tracking supply and shipment needs and costs.

When Purchase Orders is present, the Purchase Order tab is added to the vendor record and the Product and Misc. Line Items tabs are added to Configuration. A new category of reports appears in the Reports module, and you can create purchase order and receipt type queries and print purchase orders from Mail.

Please contact Blackbaud’s Sales Department at 1-800-443-9441 for more information about these additional modules and programs.

**Accounts Payable Documentation**

The documentation for Accounts Payable includes this guide, the Accounting for Nonprofits Administrator’s Guide, the online help file, and the online manual.

This guide consists of three sections. The first section provides information required for setting up and maintaining the program. Section two contains information specific to entering and maintaining records such as vendors and invoices. Section three addresses the parts of the system that you can use to manipulate your data such as reports, query, and export.
User’s Guide Format

This guide follows a number of formatting conventions to help you locate and identify information you need to make the most of Accounts Payable.

Chapter Format

Most chapters consist of the following basic sections:

<table>
<thead>
<tr>
<th>Format</th>
<th>Denotes</th>
</tr>
</thead>
<tbody>
<tr>
<td>In This Chapter</td>
<td>A listing of the contents of the chapter.</td>
</tr>
<tr>
<td>Overview</td>
<td>A brief description of the chapter.</td>
</tr>
<tr>
<td>Procedures</td>
<td>Explanations of a process and step-by-step instructions for completing that process.</td>
</tr>
<tr>
<td>Reference</td>
<td>A brief overview of each screen, as well as field-by-field descriptions.</td>
</tr>
</tbody>
</table>

Text Format

This guide uses the following conventions as a visual cue that an item is a field, program name, note, tip, or caution:

<table>
<thead>
<tr>
<th>Format</th>
<th>Denotes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bold Italics</td>
<td>This is a Blackbaud program name, for example, Payroll.</td>
</tr>
<tr>
<td>Italics</td>
<td>This is a Blackbaud program’s module name, for example, Utilities and Housekeeping.</td>
</tr>
<tr>
<td>Bold</td>
<td>This is the name of a field or button, for example, Delete refers to a button on the screen.</td>
</tr>
<tr>
<td>SMALL CAPS or KEYS</td>
<td>This is a key on your keyboard. “Press DELETE,” refers to the key on your keyboard. “Click Delete,” refers to an on screen button.</td>
</tr>
<tr>
<td>KEY+KEY</td>
<td>Two keys joined by a plus sign indicates you must press the keys simultaneously to execute the command. For example, if you are instructed to “Press CTRL + F” you must press the CONTROL key, hold it, then press the F key.</td>
</tr>
<tr>
<td>KEY, KEY</td>
<td>Two keys separated by a comma indicates you must press the keys in the order in which they appear. For example, if you are instructed to press ALT, F, you must press the ALT key, release it, then press the F key.</td>
</tr>
<tr>
<td>▶</td>
<td>The arrow indicates the beginning of a procedure.</td>
</tr>
<tr>
<td></td>
<td>The traffic light indicates a cautionary note. Generally, this is used to point out a step that may have unwanted results.</td>
</tr>
<tr>
<td></td>
<td>The notepad symbol designates a note or tip related to the information in the main text column.</td>
</tr>
</tbody>
</table>
Shortcut Keys

Throughout *Accounts Payable* there are shortcut keys and methods to help you with data entry. Function keys are the primary source for shortcuts. When a shortcut is available, the status bar at the bottom of the screen tells you which function key to press.

<table>
<thead>
<tr>
<th>Key</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>ENTER</strong></td>
<td>The <strong>ENTER</strong> key (sometimes called the <strong>RETURN</strong> key) signals the computer that entry of a command, field, or data is complete.</td>
</tr>
<tr>
<td><strong>TAB</strong></td>
<td>The <strong>TAB</strong> key notifies the computer that entry of a command, field, or data is complete. Pressing this key moves the cursor forward to the next field.</td>
</tr>
<tr>
<td><strong>SHIFT</strong></td>
<td>The <strong>SHIFT</strong> key allows you to select consecutive items from a grid. To select consecutive items, highlight the first item, then press and hold <strong>SHIFT</strong> while selecting the last item.</td>
</tr>
<tr>
<td><strong>BACKSPACE</strong></td>
<td>The <strong>BACKSPACE</strong> key moves the cursor back one character, deleting the character.</td>
</tr>
<tr>
<td><strong>HOME</strong></td>
<td>The <strong>HOME</strong> key places the cursor at the beginning of a field.</td>
</tr>
<tr>
<td><strong>END</strong></td>
<td>The <strong>END</strong> key places the cursor at the end of a field.</td>
</tr>
<tr>
<td><strong>DELETE</strong></td>
<td>The <strong>DELETE</strong> key removes the highlighted characters or entry.</td>
</tr>
<tr>
<td><strong>CTRL</strong></td>
<td>The <strong>CONTROL</strong> key allows you to select more than one item in a list. To select items not in consecutive order, select the first item, press <strong>CONTROL</strong>, hold the key down, and select the second item.</td>
</tr>
<tr>
<td><strong>F1</strong></td>
<td>The <strong>F1</strong> key activates online help. Press this key at any time to access context-sensitive help.</td>
</tr>
<tr>
<td><strong>F3</strong></td>
<td>In date fields, the <strong>F3</strong> key inserts the current date. <strong>F3</strong> also inserts the default value of a field if one is available. A message appears on the status bar if a default value is available.</td>
</tr>
<tr>
<td><strong>F7</strong></td>
<td>The primary function of the <strong>F7</strong> key is activating Table Lookups; however, this key also activates a calendar in date fields and a calculator in currency fields. In addition, <strong>F7</strong> provides access to the Search screen, where linking of records is available.</td>
</tr>
</tbody>
</table>
Online Help

The Accounts Payable online Help file provides access to many different kinds of help: overview information, reference information, procedures, online manual, contact information, and user-defined notes.

You can access online Help in three ways:
- selecting Help from the menu bar
- clicking the question mark on the toolbar
- pressing F1 from most screens in the program

Online Help contains concise information about specific processes and tasks within Accounts Payable. Selecting Help from the menu bar or clicking the question mark on the toolbar enables you to search for help topics, view online documentation, and connect to Blackbaud’s home page. Pressing F1 displays information about the part of the program you are using.

Select Help and Blackbaud on the Web to display the submenu shown below.

- **Accounts Payable Help Topics** opens the online Help file.
- **Online Documentation** opens a PDF (Portable Document Format) file in Acrobat Reader. If the Acrobat Reader is not installed, you can install it from your installation CD, or you can download it, without charge, from the Adobe web page: [http://www.adobe.com/](http://www.adobe.com/).
- You can view the user’s guide on your computer’s monitor. Bookmarks in the left pane enable you to jump from topic to topic.
- **Contacting Support** provides information about contacting Blackbaud’s support staff and other resources.
- **Blackbaud on the Web** provides links to Online Support and the Blackbaud Home Page.
- **About Accounts Payable** provides serial number, version number, and copyright information.

Using Online Help

This procedure demonstrates how you can use online help to locate information about Accounts Payable. By following these steps, you can gain an understanding of the look and feel of online help.
Demonstrating Online Help

1. From Vendors, Select Help, Accounts Payable Help Topics. The Help Topics screen appears.

2. Double click the Vendors folder in the left pane. The menu expands as follows.
3. From the expanded menu, double click **Vendors Overview**. The Vendors Overview screen appears.

![Vendors Overview](image)

4. Open the **Procedures** folder to view a list of common procedures performed in **Vendors**.

![Procedures](image)
5. Open any of the record type folder, **Invoices** for example, listed in the **Procedures** folder to view a list of procedures associated with that record type.

6. Double click any of the procedures listed to view the procedure. For example, if you double click the **Adding Invoices** procedure under the **Invoices** book, the following screen appears.
7. Click **Help Topics** to return to the previous screen.

---

**Additional Documentation Resources**

If you need resources beyond online Help, you can open the online manual by clicking **Start**, **Programs**, **Blackbaud Accounts Payable**, **Accounts Payable Online Manual**. You can also access the online manual by selecting **Online Documentation** from the **Help** menu. If you choose not to install the online manual, you can open the PDF files from your installation CD.

The Table of Contents contains bookmarks in the left pane that link to individual chapters, the glossary and index, as well as other User Guides in your system.

We also provide files for your user-defined notes, accessed by clicking **Notes** on the Help file toolbar. These files (apnotes.doc and apnotes.txt) are located in your Blackbaud folder. Depending on your word processor, you can use either the Microsoft Word document or the text file. This gives you a handy place to store information specific to your organization’s needs. The big advantage of the notes file over the **Annotate** feature in the Help file is you can maintain one notes file for everyone in your organization. To share your notes/tips with your coworkers, copy the notes file to the Blackbaud folder on their hard drive.

If you do not have Microsoft Word, delete apnotes.doc in the \Blackbaud directory on your hard drive (or on the drive where your **Accounts Payable** program resides). Once you delete apnotes.doc, the **Notes** button can access apnotes.txt using Notepad.

---

If you already have notes/tips documented in other files, you can copy them into the **Accounts Payable** notes file and access the information directly from the help file.
System Basics

In This Chapter

Navigating in Accounts Payable .................................................. 14
Parts of the Accounts Payable Screen ............................................. 14
   Title Bar ................................................................. 14
   Menu Bar .............................................................. 15
   Status Bar ............................................................ 15
   Toolbar ................................................................. 15
Standard Screen Buttons ............................................................ 18
Using Shortcut Menus ............................................................... 19
Common Screens ................................................................. 19
   Using the Calculator ....................................................... 21
   Using the Calendar ....................................................... 22
   Tabs ............................................................................ 23
   Accessing Lookup Tables ................................................ 23
   Exporting to Excel ......................................................... 24
Grouping Records in Queries ....................................................... 25
Sorting Grid Information by Column Header .................................. 26
This chapter familiarizes you with the screens and terms used throughout *Accounts Payable*. It addresses standard items such as the parts of a screen, toolbar buttons, standard screen buttons, and common screens that appear throughout the program. By reading *System Basics* you will become familiar with the screens, tools, and commands you need to navigate successfully through *Accounts Payable*.

More detailed information and step-by-step procedures are presented in the individual topic chapters.

**Navigating in Accounts Payable**

In order to navigate through *Accounts Payable*, it is important to have an understanding of the standard screen, and where items are typically located.

**Parts of the Accounts Payable Screen**

![Accounts Payable Screen](image)

**Title Bar**

The title bar, across the top of the screen, states the title of the program. It also contains buttons in the upper right corner of the screen for minimizing, maximizing, and closing.
Menu Bar

The menu bar, just below the title bar, contains commands for all *Accounts Payable* functions. *Accounts Payable* has the same basic menu options: *File*, *Edit*, *View*, and *Help*. Some *Accounts Payable* modules have additional menu options. To access a command on the menu bar, either:

- Position the pointer over the desired command and click the left mouse button
- or
- Press **ALT** + the underlined letter. For example, to access *File*, press **ALT** + **F**.

Status Bar

The status bar, across the bottom of the window, acts as your guide throughout *Accounts Payable*. As you move through the program, messages such as available shortcut keys are displayed on the status bar. For example, when you are in a date field, the message *Press F3 for Today’s Date, F7 for Calendar* is displayed.

Toolbar

The toolbar contains buttons representing common commands used within *Accounts Payable*. You can use the mouse to click any of these buttons.

Toolbar Buttons

The toolbar buttons represent common commands used within *Accounts Payable*. When you click the button, you easily perform a function, such as saving, without using the menu bar. Some of the buttons listed below are only enabled when a record is open.

<table>
<thead>
<tr>
<th>![Button]</th>
<th>Open new bank account</th>
<th>![Button]</th>
<th>Open new adjustment</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Button]</td>
<td>Bank account list</td>
<td>![Button]</td>
<td>Reconciliation</td>
</tr>
<tr>
<td>![Button]</td>
<td>Bank summary</td>
<td>![Button]</td>
<td>Bank information</td>
</tr>
<tr>
<td>![Button]</td>
<td>Print check</td>
<td>![Button]</td>
<td>Bank draft</td>
</tr>
<tr>
<td>![Button]</td>
<td>Add a new record</td>
<td>![Button]</td>
<td>Add a new record in <em>Vendors</em></td>
</tr>
<tr>
<td>![Button]</td>
<td>Open an existing record</td>
<td>![Button]</td>
<td>Save</td>
</tr>
<tr>
<td>Action</td>
<td>Icon</td>
<td>Description</td>
<td></td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-----------------</td>
<td>------------------------------------</td>
<td></td>
</tr>
<tr>
<td>Close</td>
<td></td>
<td>Run Import process</td>
<td></td>
</tr>
<tr>
<td>Set legend colors</td>
<td></td>
<td>Preferences</td>
<td></td>
</tr>
<tr>
<td>Copy a record</td>
<td></td>
<td>Chart organizer</td>
<td></td>
</tr>
<tr>
<td>Print data</td>
<td></td>
<td>Preview data prior to printing</td>
<td></td>
</tr>
<tr>
<td>Print setup</td>
<td></td>
<td>Export data</td>
<td></td>
</tr>
<tr>
<td>Run query</td>
<td></td>
<td>Export to Excel</td>
<td></td>
</tr>
<tr>
<td>Go to the first record</td>
<td></td>
<td>Go to the previous record</td>
<td></td>
</tr>
<tr>
<td>Go to the next record</td>
<td></td>
<td>Go to the last record</td>
<td></td>
</tr>
<tr>
<td>Add bookmark</td>
<td></td>
<td>Restore bookmark</td>
<td></td>
</tr>
<tr>
<td>Generate recurring invoice</td>
<td></td>
<td>Open help topics</td>
<td></td>
</tr>
<tr>
<td>View properties</td>
<td></td>
<td>Add to favorites</td>
<td></td>
</tr>
<tr>
<td>Annotate</td>
<td></td>
<td>Search for data</td>
<td></td>
</tr>
<tr>
<td>Display large icons</td>
<td></td>
<td>Display small icons</td>
<td></td>
</tr>
<tr>
<td>Display list view</td>
<td></td>
<td>Display detail view</td>
<td></td>
</tr>
<tr>
<td>Add a new group</td>
<td></td>
<td>Add a new user</td>
<td></td>
</tr>
<tr>
<td>Up one level</td>
<td></td>
<td>E-mail data</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Close purchase orders</td>
<td></td>
</tr>
</tbody>
</table>
Toolbar Buttons with Drop-Down Menus

*Accounts Payable* contains some toolbar buttons with drop-down menus that display various options.

New Record Menu

Another toolbar button feature that makes adding records easier is the **New** record menu. Click the down arrow, to the right of the **New** button, to access a drop-down menu of record types. For example, if you are in *Vendors* and click the down arrow, the drop-down menu appears.

![New Record Menu](image)

The **New Account** button displays by default when *Bank Accounts* opens. Click the down arrow and select the type of record you want to create.

Save/New and Save/Close

While clicking the **Save** button saves the data in a current record, two other options are available. The **Save and New** and **Save and Close** options, available from either the **File** menu or the toolbar, help make data entry an easier task.

Click the down arrow on the **Save** button to display the drop-down menu shown below.

![Save Options](image)

Save saves the information entered on the current record.

**Save and New** automatically saves and closes the current record, then opens a new, blank record. This eliminates the additional steps of saving and closing the record, and then selecting **File, New** to open the next blank record. This feature greatly reduces data entry time when adding a large number of records in one sitting.
For ease of data entry, select the **Automatically Complete Table Entry** option, in **Configuration**, to let **Accounts Payable** automatically complete the remaining part of the table entry. For example, typing “S” will automatically display the first table entry beginning with the letter S.

**Save and Close** saves, and then closes the current record, combining two steps into one and ensures all additional information is saved.

## Standard Screen Buttons

There are many standard buttons throughout **Accounts Payable** that appear on the screen, rather than the toolbar. These buttons function in the same manner regardless of where they are located. The function of each button is described below.

<table>
<thead>
<tr>
<th>Button</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Search" /></td>
<td>Search for data to enter a field. (This button appears on the toolbar and screens.)</td>
</tr>
<tr>
<td><img src="image" alt="Drop-down list" /></td>
<td>Access a drop-down list associated with that field.</td>
</tr>
<tr>
<td><img src="image" alt="Search" /></td>
<td>Search for a file.</td>
</tr>
<tr>
<td><img src="image" alt="Search" /></td>
<td>Search the system to select the correct path and file name.</td>
</tr>
<tr>
<td><img src="image" alt="Adjust numbering" /></td>
<td>Adjust numbering, in numeric fields, by clicking up or down.</td>
</tr>
<tr>
<td><img src="image" alt="Calculate financial data" /></td>
<td>Calculate the appropriate financial data for the field.</td>
</tr>
<tr>
<td><img src="image" alt="Locate date" /></td>
<td>Locate the correct date for the field.</td>
</tr>
<tr>
<td><img src="image" alt="Move left" /></td>
<td>Move selected item to frame on the left.</td>
</tr>
<tr>
<td><img src="image" alt="Move all left" /></td>
<td>Move all items to the frame on the left.</td>
</tr>
<tr>
<td><img src="image" alt="Move right" /></td>
<td>Move selected item to frame on the right.</td>
</tr>
<tr>
<td><img src="image" alt="Move all right" /></td>
<td>Move all items to the frame on the right.</td>
</tr>
<tr>
<td><img src="image" alt="Move forward" /></td>
<td>Move forward one screen to the next step.</td>
</tr>
<tr>
<td><img src="image" alt="Move back" /></td>
<td>Move back one screen or step.</td>
</tr>
<tr>
<td><img src="image" alt="Cancel" /></td>
<td>Cancel an operation.</td>
</tr>
</tbody>
</table>
Using Shortcut Menus

Throughout *Accounts Payable*, you can access commonly used commands by placing the cursor in a field or grid and clicking the right mouse button. A shortcut menu, similar to those shown below, appears. The available commands vary depending on where you are in the program.

![Shortcut Menu Example]

Common Screens

The following screens are common throughout *Accounts Payable*.

Print Setup Screen

You use the Print Setup screen to select a printer and set printer properties. The exact options available depend on your printer and network configuration. *Accounts Payable* uses your default printer and properties unless you make another selection on this screen. Select **File**, **Print Setup** to open this screen.

![Print Setup Screen Example]
Change Password Screen

From any *Accounts Payable* module, select *Edit, Change Password* to open the following screen.

![Change Password Screen](image1)

Select a Directory Screen

In fields requiring a path and file name click the browse button to open a search screen.

![Select a Directory Screen](image2)

*The appearance of this screen may vary depending on where you are in the program.*
**Search Screen**

Click the open icon to open the record search screen. A variety of filters are available to narrow your search.

![Search Screen](image)

**Using the Calculator**

In fields requiring a monetary amount, a calculator button appears. Clicking this button opens a calculator you use to determine the entry amount.

![Using the Calculator](image)
Calculate the entry amount by using your cursor to click the calculator buttons. Click **Paste** to enter the amount in the field and automatically close the calculator.

### Using the Calendar

In fields requiring a date, a calendar button (📅) is available. Clicking this button opens a calendar from which you can search for and enter dates.

Clicking the month opens a drop-down list of the months. Select the correct month by clicking it.
Clicking the year activates a set of scroll buttons. You can scroll through to select the correct year.

Once the correct month and year display, click the date to enter them in the field.

**Tabs**

Another integral part of *Accounts Payable* is the tab. Tabs in *Accounts Payable* function the same as tabs on folders in a filing cabinet; they allow you to see at a glance what information is available in each folder by the tab name. Information is accessed by clicking the tab. The screen below shows the tabs available for a standard vendor record.

### Accessing Lookup Tables

Lookup tables are used throughout *Accounts Payable* to increase data entry speed and efficiency. There are four ways to access tables entries:

<table>
<thead>
<tr>
<th>Method</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Down Arrow</td>
<td>A down arrow next to a text box indicates a table lookup is available. Click the arrow to access a drop-down list of entries for the field.</td>
</tr>
<tr>
<td>Arrow Keys</td>
<td>Place the cursor in a text box and then press the down arrow key on your keyboard to scroll through the available entries.</td>
</tr>
<tr>
<td>Typing</td>
<td>You can also type an entry into a text box. If the entry you type does not exist in the table, the program displays a dialog box asking if you want to add the new table entry. Click Yes to add the new entry to the table.</td>
</tr>
</tbody>
</table>
When F7 is pressed, a window similar to the one below appears.

From this window, you can add, delete, edit, or sort table entries.

**Exporting to Excel**

Throughout *Accounts Payable* grids are used to enter and display information. Using the **Export to Excel** function, you can export information from these grids to use in *Microsoft Excel*.

With your cursor in the grid, select **File, Export to Excel**, or use the toolbar icon.
Accounts Payable opens Excel and begins exporting the grid information. The following screen appears.

When complete, the Excel worksheet appears containing the information from the grid.

This information can now be manipulated and used within Excel.

Grouping Records in Queries

In Query and Export, you can query the database for information about records meeting specified criteria. For example, you might want to view unpaid invoices. Rather than searching for each record, opening it and locating the information, you can group the desired records and open the list of records with one simple operation.

Records are grouped by creating a query. The query process examines all records, selecting and grouping those matching the criteria you have established. For the example above, all invoices from the query group are viewed, and those that are unpaid are included in the query. The unpaid invoices then display on the Results tab. You can print or export the results directly from the Results tab. After you establish the criteria for a query, you can name and save the query for future use. For additional information about creating and using queries refer to the Query and Export chapter of this User’s Guide.
Sorting Grid Information by Column Header

Wherever a grid appears in the program, you can sort the grid information by clicking the column header with the left mouse button. Clicking the column header toggles the sort order between ascending and descending order.

For example, if you click the date header it shows the list in ascending order with the oldest date at the bottom. Click again to show the list in descending order with the oldest date at the top.
# Configuration

## In This Chapter

<table>
<thead>
<tr>
<th>Tab</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>General Tab</td>
<td>29</td>
</tr>
<tr>
<td>Preferences Tab</td>
<td>31</td>
</tr>
<tr>
<td>User Preferences</td>
<td>31</td>
</tr>
<tr>
<td>System Preferences</td>
<td>34</td>
</tr>
<tr>
<td>Tables Tab</td>
<td>36</td>
</tr>
<tr>
<td>Attributes Tab</td>
<td>40</td>
</tr>
<tr>
<td>Products Tab</td>
<td>42</td>
</tr>
<tr>
<td>Addresses Tab</td>
<td>44</td>
</tr>
<tr>
<td>Miscellaneous Line Items Tab</td>
<td>46</td>
</tr>
<tr>
<td>Distributions Tab</td>
<td>48</td>
</tr>
<tr>
<td>Aging Information Tab</td>
<td>51</td>
</tr>
<tr>
<td>General Ledger Tab</td>
<td>52</td>
</tr>
<tr>
<td>International Tab</td>
<td>53</td>
</tr>
</tbody>
</table>
**Configuration** is where you set up *Accounts Payable* to fit the needs of your organization. The module consists of a series of tabs that allow you to customize the program to your organization’s specific needs.

For example, you can define aging information and create tables and attributes. You can also specify when recurring invoices are generated and determine how account numbers are entered for an account search.

Pictures of screens and field-by-field explanations of each tab are provided in the reference section. A short description of each tab in *Configuration* follows.

- **General tab**: On this tab, you can establish your organization’s address and phone information, federal and state ID numbers, and indicate if the program should automatically generate recurring invoices, as well as vendor and purchase order IDs.

- **Preferences tab**: On this tab, you can establish system preferences (duplicate information and budget checking) and individualize user preferences (checks and miscellaneous) for your workstation.

- **Tables tab**: On this tab, you can create, edit, or delete table entries.

- **Attributes tab**: On this tab, you can add, edit, and delete attributes for vendors, invoices, credit memos, and purchase orders. You can also create user-defined tables from this tab.

- **Products tab**: On this tab, you define products purchased from vendors on a regular basis. You can establish products specific to *Accounts Payable*, *Accounts Receivable* (if *Accounts Receivable* is present), or available to both modules. This tab is only available only if the optional *Purchase Orders* module is present.

- **Addresses tab**: On this tab, you can add multiple addresses for your organization. This tab is available only if the optional *Purchase Orders* module is present.

- **Misc. Line Items tab**: On this tab, you can define line items entered on a purchase order under the code of *Miscellaneous item*, as opposed to *Regular line item*. This tab is available only if the optional *Purchase Orders* module is present.

- **Distributions tab**: On this tab, you can define default account distributions and project distributions for invoices and credit memos. You can also store common distributions and use the default distributions when entering invoices and credit memos to save data entry time and increase accuracy.

- **Aging Information tab**: On this tab, you can define aging periods specific to your organization for aging transactions.

- **General Ledger tab**: On this tab, you can define options for interfacing with Blackbaud’s *General Ledger* program such as the journal reference and source code. You can also establish settings if *General Ledger* is not present.

- **International tab**: On this tab, you can add countries and establish settings for each country.

➤ **Accessing Configuration**

1. From the Start menu, select Programs, Blackbaud Accounts Payable.
2. Select **Configuration** from the **Accounts Payable** modules.

### General Tab

The General tab is where you establish basic information about your organization, as well as some specific settings for **Accounts Payable**. The name of your organization is displayed as read-only at the top of the tab.

The address and phone information you enter on this tab appear on printed documents and correspondence. You can select the state and country codes from a drop-down list of table entries by clicking the down arrow. The address block automatically formats itself based on the country code you select.

The **Federal ID No.** and **State ID No.** are used for tax identification and for printing 1099 forms.

If you mark the **Automatically Generate Recurring Invoices** checkbox, the program notifies you when **Vendors** is opened of any recurring invoices that need to be generated. You can prevent users from having this option by restricting the group’s rights in **Security**. If you mark the **Automatically Generate Recurring Invoices** checkbox, you can specify the number of days before a recurring invoice is generated in the **day(s) before invoice date** field.

When you mark the **Automatically generate vendor ID’s** checkbox, new vendor records without Vendor ID’s are automatically assigned a sequential number. When you save the record, you can overwrite or change the assigned number, as long as the new ID is not a duplicate of another Vendor’s ID.

When you mark the **Validate purchase order numbers on invoice** checkbox, the program checks purchase order numbers when an invoice is saved to determine if the number entered is a valid purchase order number.
When you mark the **Automatically generate purchase order ID’s** checkbox, new purchase orders are automatically assigned a sequential number based on the start number you define. You can change the assigned number on the purchase order as long as it does not duplicate another purchase order.

- **Accessing the General tab**
  1. From *Configuration*, select the General tab.

- **Establishing organization specific settings**
  1. From the General tab, enter your organization’s address in the **Address** field.
  2. Enter the **City**, **State**, **ZIP**, **Country**, and **Phone** information.
  3. Enter the **Federal ID No.**, and **State ID No.** information.
  4. Mark the **Automatically Generate Recurring Invoices** checkbox if you want the program to notify you when *Vendors* is opened of any recurring invoices that need to be generated. You can prevent users from having this option by restricting user rights in *Security*. If the **Automatically Generate Recurring Invoices** checkbox is not marked, the **day(s) before invoice date** field, which allows you to specify the number of days before a recurring invoice is generated, is disabled.

---

Only certain users are allowed to automatically generate recurring invoices. Those users are determined in *Security*. 
5. Mark the checkboxes if you want to **Automatically generate vendor ID’s**, **Validate purchase order numbers on invoices**, and **Automatically generate purchase order ID’s**. If you mark **Automatically generate purchase order ID’s**, you can enter a start number. This option is only available if the optional *Purchase Orders* module is present.

6. After entering information on the General tab, select another tab or **File**, **Exit** to close *Configuration*.

**Preferences Tab**

The Preferences tab is where you establish system preferences (duplicate info and budget checking) and individualize user preferences (checks and miscellaneous) for your workstation.

User preferences are stored by user name, while system preferences apply to all users.

**User Preferences**

User preferences consist of **Checks** and **Miscellaneous** user options. Select **Checks** to establish the default check format.

Select **Miscellaneous** to define other user-specific settings. The **Enter key moves to next field** checkbox lets you use ENTER (in addition to TAB) to move to the next field. The **Automatically complete table entries** checkbox, when marked, lets you type a portion of a table entry, and the program fills in the entry by matching the letters already entered (e.g., in a country field, if you type U, the program fills in USA).

The **Data Entry** frame lets you determine whether **Vendor Name** or **Vendor ID** appears as the first field on new transactions. The **Account Search Mask** frame is where you determine how account numbers are entered for an account search.

---

*If you automatically generate IDs, the ID is numeric. If desired, you can type an alpha-numeric ID, even if the automatically generate checkbox is marked. The ID generates only if the field is blank when saved. Purchase order numbers are always numeric.*
Accessing the Preferences tab

1. From Configuration, select the Preferences tab.

Establishing default check format

In the Select default check format as field, you can use the down arrow to select from Single stub laser checks (Pre-printed), Double stub laser checks (Pre-printed), AP 5.00 double stub checks, AP 5.00 single stub checks, Double stub laser checks (Blank Paper), and Single stub laser checks (Blank Paper).

1. From the Preferences tab mark User preferences.
2. In the **User Options** frame, mark **Checks**. The check format information appears on the tab.

3. In the **Select default check format** as field, select a format from the drop-down list.

4. Once you finish entering information on the Checks screen, you can select another Preferences option from the tab or **File, Exit** to close **Configuration**.

   ➢ **Entering miscellaneous preferences**

   1. From the Preferences tab, mark **User preferences**.
2. In the **User Options** frame, mark **Miscellaneous**. The Miscellaneous information options appears.

3. If desired, mark the **Enter key moves to next field** checkbox. When marked, both the **ENTER** key and the **TAB** key advance the cursor to the next field.

4. Mark the **Automatically complete table entries** checkbox if you want the program to fill in the first matching entry when you type the first portion of the table entry. For example, if you are in the **Country** field and enter “U”, the program inserts “USA.”

5. In the **Data Entry** frame, use the down arrow to determine what to show as the first field on new transactions. Select from **Vendor Name** and **Vendor ID**.

6. Determine how account numbers are entered for an account search in the **Account Search Mask** frame. Select from **Automatic** and **Manual placeholder**.

7. After entering information on the Miscellaneous screen, select another tab, or **File, Exit** to close **Configuration**.

### System Preferences

System Preferences consist of **Duplicate Info** and **Budget Checking**. Select **Duplicate Info** to determine how duplicates are found when you search for duplicates or print a duplicate report. You can specify a field and length for each duplicate test. If you mark **Auto-check for duplicates on save**, the program checks for vendor duplicates when you save the record.

If you select the **Automatically Check for Duplicate Invoice Numbers** option, it applies only to invoice numbers for a single vendor. You can use the same invoice number twice, as long as it is for two separate vendors.
Select **Budget Checking** to designate what action the program takes for over-budgeting when checking account and project budgets. You can have the program **Issue warning only**, **Do not allow overbudget spending**, or **Allow overbudget spending**.

You must have Supervisor rights to change system preferences.

**Defining duplicate vendor and invoice information**

1. From the Preferences tab, mark **System preferences**.
2. In the **System Options** frame, mark **Duplicate Info**. The duplicate information appears on the tab.

3. In the **Duplicate Vendor Criteria** grid, enter the **Field Name** and **Length** of the items you want the program to check to determine if the record is a duplicate. The length determines the number of characters in the field you want the program to check.
4. If you mark the **Auto-check for duplicates on save** checkbox, the program checks for duplicates each time you save a record.
5. Mark the **Automatically Check for Duplicate Invoice Numbers** checkbox to select the action you want the program to take if a duplicate is found. Select from **Warn User** and **Do not allow duplicate numbers**.
6. After entering information on the Duplicate Info screen, select **Budget checking**, another tab, or **File, Exit** to close **Configuration**.
Setting budget checking options

Budget Checking allows you to designate the action taken when an invoice makes an account or project over-budget. You can have the program Issue warning only, Do not allow over-budget spending, or Allow over-budget spending.

1. From the Preferences tab, select System preferences.
2. In the System Options frame, select Budget Checking. The Budget Checking information appears.

3. In the Account Budget Checking frame, select how you want the program to handle account over-budget spending. Select from Issue a warning only, Do not allow over-budget spending, or Allow over-budget spending.
4. In the Project Budget Checking frame, select how you want the program to handle project over-budget spending. Select from Issue a warning only, Do not allow over-budget spending, or Allow over-budget spending.
5. After entering information on the Budget Checking screen, select another tab, or File, Exit to close Configuration.

Tables Tab

You can use tables throughout Accounts Payable to increase data entry speed and help ensure that field entries remain consistent from user to user. The Tables tab is where you add, edit, delete, sort, and print table entries.
Tables currently in the program are displayed alphabetically in the Tables box. When you highlight a table, the entries display in the **Table Entries** frame. You can display table entries using either the long or short description, depending on which option you mark.

You can only add tables as a user-defined attribute table from the Attributes tab.

- **Accessing tables**
  1. From *Configuration*, select the Tables tab.

- **Adding a table entry**
  1. From the Tables tab, highlight the table for which you are adding an entry.
  2. Click **Add**. The Add Table Entry screen appears.
3. Enter the **Description**.
4. Mark **Deactivated** to disable a table entry without deleting the entry. When you deactivate an entry, it displays in gray and cannot be selected.
5. Click **OK** to save. The new entry appears in the **Table Entries** frame.

- **Editing a table entry**
  1. From the Tables tab, highlight the table you want to change from the **Tables** box.
  2. In the **Table Entries** box, move the cursor to highlight the entry you want to change.
  3. Click **Edit**. The Edit Table Entry screen appears with the entry you selected in the **Description** field.
  4. Make the necessary changes to the entry.
  5. When you are finished, click **OK**. The changes are automatically saved and you return to the Tables tab.

- **Inserting a table entry**
  1. From the Tables tab, highlight the desired table in the **Tables** box.
  2. In the **Table Entries** box, highlight the entry below the point where you want insert the new entry.
  3. Click **Insert**. The Add Table Entry screen appears.
  4. Type in the **Description** for the new entry. If desired, mark the checkbox to deactivate the entry.
  5. Click **OK** to save.
Deleting a table entry
You cannot delete table entries if they are currently part of an existing database record.
1. From the Tables tab, highlight the desired table in the Tables box.
2. In the Table Entries box, highlight the entry you want to delete.
3. Click Delete. A confirmation message appears.
4. Click Yes to delete the table entry.

Moving an entry up or down in the table
Place table entries in the order you prefer by moving them up or down.
1. From the Tables tab, highlight the desired table.
2. In the Table Entries box, move your cursor to highlight the entry you want to move.
3. Click Up or Down to move the entry up one line. Repeat as needed.

Sorting a table
You can determine whether table entries are listed in ascending (A-Z) or descending order (Z-A). Sorting a table does not cause changes to existing data records.
1. From the Tables tab, highlight the table you want to sort.
2. Click Sort. The Sort Table Options screen appears.
3. This screen allows you to sort all table entries for the selected table.
4. Select a sort order. Mark Ascending if you want the table entries to appear in alphabetical order from A-Z. Mark Descending if you want the table entries to appear in reverse order from Z-A.
5. Select either Description or Short Description.

You cannot delete a table entry if it is in use by one or more records in the program. You can deactivate the entry to remove it from the list of available entries.

Tables with numbers are sorted by the first number (i.e., all 1s are together, all 2s, etc.) For example, 1, 11, 14, and 17 would be grouped before 2, 21, 27, and 29. Therefore, you may want to avoid sorting numeric tables. An alternative might be to enter numeric entries as 001, 002, 003...010, 011, 012, etc.
6. Click OK.

Printing a table

We suggest you print a hard copy of all tables for your records. You can print one or more tables from the Print Code Tables screen.

1. From the Tables tab, click Print. The Print Code Tables screen appears.

2. Mark the option to print All Code Tables or Selected Code Tables.

3. If you choose Selected Code Tables, use the arrow buttons to move the tables you want to print into the Print these code tables box.

4. If desired, mark the Include inactive table entries checkbox.

5. If desired, mark the Print one table per page checkbox.

6. Click OK.

Attributes Tab

Attributes are user-defined descriptions, fields, or codes that you can assign to a record. For example, you could use attributes to track the year in which you started doing business with a particular vendor, or track buyers or departments.

Attributes add flexibility by allowing you to define and store detailed information about vendors, invoices, credit memos, and purchase orders. You can also use attributes in reporting. Attributes are established by entering a Description and assigning the appropriate Data Type.

The Data Type column allows you to define each attribute as a Number, Yes/No, Text, Date, Currency, or Table. If you select Table, you must specify a table name.

If you establish an attribute as a table, you can create a new table or use an existing table for data entry. You create new tables on the Attributes tab.
Accessing the Attributes tab

1. From Configuration, select the Attributes tab.

Defining an attribute

1. From the Attributes tab, select an Attribute Type. Mark either Vendor, Invoice/Credit Memo, or Purchase Order.
2. Enter the Description of the attribute.
3. Enter the Data Type of the attribute. The Data Type column defines the format for the attribute field. Your choice indicates whether the attribute is a Table, Number, Date, Text, Currency, or Yes/No. To select a data type, click in the field to access the available choices. If the Data Type of the attribute is defined as Table, you can select an existing table or create a new table.
4. After defining the attributes, click OK.

Adding an attribute to a table

1. From the Attributes tab, click in the Table Name column for the desired attribute.
2. Click the down arrow to access the drop-down list. Select Add New Table. The Add New Table screen appears.
3. Enter the Table Name field. If desired, mark Use Short Description of and enter the number of characters. You are limited to six or less characters.

4. Click OK to save the table.

Deleting a table

You can delete tables created as the result of establishing an attribute. Make sure the attribute is not needed before deleting the table. You can only recover tables by restoring a backup. We strongly recommend performing a backup prior to deleting an attribute table.

1. From Configuration, select Edit, Delete User-Defined Tables. The Delete User-Defined Tables screen appears.

2. Highlight the attribute table you wish to delete. Click Delete. A confirmation message appears.

3. Click Yes to delete.

Products Tab

The Products tab is available only if you are using the optional Purchase Orders module. You can add, edit, and delete products routinely purchased from vendors. You can then select from these products when entering line items for purchase orders.

The grid displayed on the Products tab lists all products entered into the program for use when filling in line items on purchase orders. Select the appropriate button to Add, Edit, or Delete the highlighted entry.
Accessing the Products tab

1. From Configuration, select the Products tab.

Adding a product

The Products tab grid lists all products entered into the program. Add products that you routinely purchase from vendors.

1. From the Products tab, click Add. The Add Product screen appears.

2. Enter the desired information on the General Info tab. The Receiving Location is a code table for receiving purchase orders. The AP Unit Cost is the cost per unit.
3. Mark the **Product is inactive** checkbox if you do not want the product to appear as an available option when defining line items.

4. Click **OK** to add the product.

#### Editing a product

The Products tab grid lists all products entered into the program. You can edit any product highlighted on the grid.

1. From the Products tab, highlight the product you want to edit, and then click **Edit**. The Edit Product screen appears.

2. Make the necessary changes.

3. Click **OK**. The program saves the changes.

#### Deleting a product

1. From the Products tab, highlight the product you want to delete, and click **Delete**. A confirmation message appears.

2. Click **Yes** to delete.

### Addresses Tab

The Addresses tab is where you store multiple addresses for shipping and warehouse delivery, and other sites where your organization receives items. You can add, edit, and delete the Description, Location (city and state), and Contact (first and last name).

The Addresses tab is available only when the optional *Purchase Orders* module is present.
Accessing the Addresses tab

1. From Configuration, select the Addresses tab.

Adding an address

1. From the Addresses tab, click Add. The Add Address screen appears.

2. Enter the Description of the address.

3. In the Send to the Attention of frame, enter the Last name, First name, Title/Suffix, and Position of the contact person. If you want the contact's position to print on documents, such as reports, envelopes, and purchase orders, mark Print.

4. If this address is the Default shipping address, mark the checkbox.

5. Enter the desired address and phone information.

6. Click OK to save the address record.
 España

**Editing an address**

1. From the Addresses tab, highlight the address you want to edit and click **Edit**.
2. The Edit Address screen appears. Make the desired changes.
3. Click **OK** to return to the Addresses tab.

**Deleting an address**

1. From the Addresses tab, highlight the address you want to delete and click **Delete**. The Delete Address screen appears.
2. Click **OK** to return to the Addresses tab.

### Miscellaneous Line Items Tab

This tab is only available if the optional *Purchase Orders* module is present. Miscellaneous line items are used when adding line items to a purchase order in *Vendors*. Examples of miscellaneous line items are freight charges and sales tax. These line items differ from products in that they are entered on a purchase order under the code of miscellaneous item as opposed to a regular line item.

The grid displayed on the Misc. Line Items tab lists all miscellaneous line items entered into the program.

**Accessing the Misc. Line Items tab**

1. From *Configuration*, select the Misc. Line Items tab.
Adding a miscellaneous line item
1. From the Misc. Line Items tab, click Add. The Add Miscellaneous Line Item screen appears.

2. Enter the Misc. code ID.
3. Select Charge or Credit for the Line item type.
4. Mark Percent or Amount. If you mark Amount, enter the amount in the field.
5. Indicate if the charge or credit should apply to All line items or All regular line items.
6. Enter a Description for the miscellaneous line item.
7. Select the appropriate GL Account and GL Project.
8. Click OK.

Editing a miscellaneous line item
1. From the Misc. Line Items tab, highlight the miscellaneous line item you want to edit.
2. Click Edit. The Edit Miscellaneous Line Item screen appears.
3. Make the necessary changes.
4. Click OK. The program saves the changes.

Deleting a miscellaneous line item
1. From the Misc. Line Items tab, highlight the miscellaneous line item you want to delete.
2. Click Delete. A confirmation screen appears.
3. Click Yes to delete the record.

The GL Account lookup key is only available if you are using General Ledger. The GL Project field is only available if you are using the optional Project, Grants and Endowments Management module of General Ledger.
Distributions Tab

The Distributions tab is where you define account or project distributions for invoices and credit memos. You can enter these distributions on an invoice-by-invoice basis or standard distributions.

The **Account Distributions** and **Project Distributions** options determine what information displays in the grid. You must mark one of these options. Once on the desired screen, you can add, edit, or delete the highlighted entry.

The **Project Distributions** option is available only if you have Blackbaud’s optional **Projects, Grant, and Endowment Management** module. You can define an unlimited number of distributions in **Accounts Payable**.

- **Accessing the Distributions tab**
  1. From **Configuration**, select the Distributions tab.
Adding an account distribution

Adding an account distribution allows you to specify standard account distributions to use on invoices or credit memos.

1. From the Distributions tab, mark **Account Distributions**, and click **Add**. The Add Account Distribution screen appears.

2. Enter the **Distribution name** and fill in the desired information in the **Account Distribution** grid.

3. Click **Projects** to access a grid for project distributions.

4. Click **Distribute Evenly** to distribute the percentages evenly among the accounts entered. Percentages have to total 100 percent.

5. Click **Delete All** to delete all distribution information from the grid.

6. Click **OK**.

Adding a project distribution

1. From the Distributions tab, mark **Project Distributions**.

The **Account No.** column has a lookup into the **General Ledger** accounts table. If you do not have **General Ledger**, this field acts like a normal text entry box. The **Account Description** column fills in automatically when you specify a valid account number.
2. Click **Add**. The Add Project Distribution screen appears.

3. This screen allows you to specify standard project distributions used on invoices or credit memos. The Project ID field is a text field for entering projects from *General Ledger’s Projects*. You can press **F7** to locate *General Ledger* projects. The Project description field fills automatically when you specify a valid project.

4. Enter the **Distribution name** field.

5. Enter the **Project, Project Desc,** and **Percent** information.

6. Click **Load Distribution** to select from a list of previously defined project distributions.

7. Click **Distribute Evenly** to distribute the percentages evenly among the projects listed in the grid. Percentages have to total 100 percent.

8. Click **Delete All** to delete all distribution information from the grid.

9. Click **OK**.

► **Editing a distribution**

1. From the Distributions tab, mark **Account Distributions** or **Project Distributions** to indicate the type of distribution you want to edit.

2. Highlight the distribution you want to edit, and click **Edit**. The Edit Distribution screen appears. A different screen is available for each type of distribution.

3. Make the necessary changes.

4. Click **OK**. The changes save automatically.

► **Deleting a distribution**

1. From the Distributions tab, mark **Account Distributions** or **Project Distributions** to indicate the type of distribution you want to delete.

2. Highlight the distribution you want to delete, and click **Delete**. A confirmation message appears.

3. Click **Yes** to delete.
Aging Information Tab

The Aging Information tab is where you define four aging periods used for aging transactions. You can use aging periods to determine the number of days invoices are overdue. You have the choice of aging based on the transaction date or the due date.

Aging periods must not overlap and must be consecutive, with no days missing.

For example, if period one runs from 0 to 30 days, period two must start with day 31. The program displays an error message if you attempt to save this tab with invalid aging information.

- Accessing the Aging Information tab
  1. From Configuration, select the Aging Information tab.

    ![Aging Information Tab](image)

    The grid on the Aging Information tab allows you to define aging periods for transactions. For each row shown, enter the number of days for each period. The Start column automatically calculates based on your previous End entry. Note that Start and End are measured in days. You may also specify the default date to use when calculating aging.

- Establishing aging information
  1. From the Aging Information tab, mark whether to age by Transaction date or Due date.
  2. In the Aging periods grid, enter the End number of days, the Short description, and Description of the period. Short Description is a required field. The Start column is locked with the first Start value as 0. The following Start values are calculate automatically by adding one to the previous row’s End value.

    ![Aging Periods Grid](image)
3. When you are finished establishing your aging periods, you can select another tab, or File, Exit.

**General Ledger Tab**

This tab allows you to define options for interfacing with a general ledger program. If Blackbaud's *General Ledger* is present, the program validates the general ledger information.

- **Accessing the General Ledger tab**

  The General Ledger tab is where you define options for interfacing with a general ledger program.

  1. From *Configuration*, select the General Ledger tab.

  ![General Ledger Tab](image)

  2. If *General Ledger* is available, the tab displays the *Blackbaud General Ledger present* message. Options to note on the General Ledger tab are: *AP source*, source code that appears on each accounts payable transaction posted to *General Ledger*; *PO source*, source code that appears on each purchase order transaction posted to *General Ledger*; and Journal References, which designates which fields (and the length of the fields) are used as references when transactions are posted to *General Ledger*.

- **Establishing General Ledger settings**

  1. In the *AP source* and *PO source* boxes, click the down arrow to select from the list of available source codes previously defined in *General Ledger*. 
2. In the **Journal References** frame, you can select the fields used as a description when posting detailed transactions to **General Ledger**. In the **Reference Field** column, select the name of the field you want to send. In the **Length** column, specify the number of characters to send. You can set a maximum of 50 characters per transaction. Only use these settings when posting in detail.

3. You can define a journal reference for each of the following by marking the appropriate option: **Cash Account**, **Expense Account**, **Transfer**, **Receipt**, **AP Summary Account** and **Purchase Order**.

4. Click **Reset to System Defaults** to return the selected **Journal Reference** fields to the defaults. The **Sample** field displays how the journal reference appears according to the criteria you establish.

5. When you finish entering General Ledger tab information, select another tab, or **File**, **Exit** to close **Configuration**.

### International Tab

The International tab is where you add, edit, or delete countries from **Accounts Payable**.

In addition to defining countries, you can specify an address format to use for mailings. The country code automatically reformats a vendor record’s address block to match the format you define for the selected code.

- **Accessing the International tab**
  1. From **Configuration**, select the International tab.
Adding a country
A variety of formatting options are available to help you define the address block to meet each country’s specifications.

1. From the International tab, click Add. The Add Country screen appears.

2. Enter the country’s Name and Abbreviation. You can use the abbreviation in the address block for mailing purposes. For example, instead of using United States of America, you can use USA.

3. Define the address block. One advantage of the International tab is the ability to define the format of the address block for each country. The address block you build determines the way the address prints on reports and mailings.

4. Select from Available fields to build an address. You can establish the address by highlighting Address, City, State, and ZIP and clicking the right arrow button in the center of the Address Block format frame to place that information in the Address format box.

5. Additional options available on the Add Country screen are the colon, comma, dash, period, slash, Newline, and Space.

6. When you finish entering the country, click OK to save the information.

Editing a country’s settings
1. From the International tab, highlight the country you want to edit and click Edit. The Edit Country screen appears.

2. When you finish making changes to the country’s settings, click OK to save the information.
Deleting a country

1. From the International tab, highlight the country you want to delete and click Delete. A confirmation message appears.
2. Click Yes to delete the country.
In This Chapter

Security Groups ............................................................... 59
Security Users ............................................................... 64
Passwords ................................................................. 68
Security allows you to establish access rights for the users of Accounts Payable. Security is based on groups, except for General Ledger account security which is set on the user record. You can create an unlimited number of groups with various levels of access to the program and database. A user’s access rights are based on group assignment. You can assign a user to more than one group.

When a user enters Accounts Payable, the functions to which the user does not have access are disabled. Any changes made to the user’s rights take effect the next time the user logs in.

You can set security options for each module in the program. You can limit access to the entire module, certain areas of the module, or even certain actions within a module such as adding or deleting. Because Security is a module common to all Blackbaud programs, you can establish a group with access rights to one or more programs. For example, you can create a group and give its members access privileges to all areas of Accounts Payable, Student Billing, and Miscellaneous Cash Receipts.

Security arrives to you with the user name Supervisor, and the password admin. You should change Supervisor’s password to a unique password as soon as possible to ensure the highest level of security for your organization. This user belongs to a group named Supervisor. The Supervisor group bestows full access throughout all Blackbaud programs and is visible only in the member of/not a member of list boxes for individual users.

➢ Accessing Security
  1. From the Start menu, select Programs, Blackbaud Accounts Payable.
  2. From the Accounts Payable modules, select Security.
Security Groups

Use security groups to establish access privileges for the users assigned to the group. Each group record has tabs for group information, shared tables, and shared components, as well as a tab for each Blackbaud program present in the database.

Because Security is a module common to all Blackbaud programs, you can establish a group with access rights to one or more programs. For example, you can create a group and give its members access privileges to all areas of Accounts Payable, Student Billing, and Miscellaneous Cash Receipts.

You give users access privileges based on group membership. You must add a user to the program before adding to a group. Users can also be members of more than one group.

Adding a group

Security groups are used to establish access privileges for the members of the group. You can establish a group with access rights to one or more programs.


2. Enter the Group Name and Description.

3. In the Group Members frame, use the arrow buttons to move the desired user from the Not Members box to the Members box.
4. Select the Shared Tables tab.

5. Mark the checkbox for each table you want the members of this group to have rights to. If you unmark a checkbox, the user cannot add, edit, or delete entries from the table. All the checkboxes are marked by default.

6. Select the Shared Components tab.

7. Mark the checkbox for each option you want the users in this group to be able to access. If you clear a checkbox, users cannot open that option. All the checkboxes are marked by default.
8. For each option you give users access privileges to, click **Options**. The Security Options screen appears.

9. Mark the functions you want to give the user access rights to in the **Functions** box. For each option listed in the grid, mark the checkbox to allow users to view, add, edit, and delete. You cannot edit yellow cells. For some options, N/A appears instead of a checkbox to indicate the item is not available or applicable. Click **OK** to return to the Shared Components tab.

10. Select the Accounts Payable tab.

11. Mark the checkbox next to each item you want the users in this group to be able to open. Select from **Vendors**, **Configuration**, **Mail**, **Notes**, **Query**, **Reports**, **Utilities and Housekeeping**, **Global Change**, and **Import**. All the checkboxes are marked by default.

12. For each module you check, click **Options**. The Security Options screen for that module appears.
13. In the **Functions** box, mark those functions to which you want to give users access rights. With the function highlighted, the grid at right displays the items to which you can give users privileges to view, add, edit, and delete. Mark the appropriate checkboxes to give users privileges. Leave the checkbox blank if you want to restrict users from those actions.

14. After defining the security options for each function of **Accounts Payable**, click **OK** to return to the Accounts Payable tab.

15. Follow the same procedure for the remaining program tabs. You only have tabs for the programs you have loaded.

16. Click **OK** to save the group.

**Editing a group**

You can edit a group any time you need to add or delete a member or change access privileges. If you edit a group’s privileges while one or more of its members are logged in to a program, the changes take place when the user exits and logs back in to the program.

1. From **Security**, highlight the group you want to edit.

2. Select **File, Open**. The group’s record appears.

3. Make the necessary changes to the group.

4. Click **OK** to close the record. The changes save automatically.
Previewing and printing a Group Profile report

A Group Profile includes the name and description of the group, a list of group members, and a list of access privileges assigned to that group.

1. From the main Security screen, highlight the group for which you want to preview or print a profile.

2. Click the magnifying glass on the toolbar to preview the profile or click the printer on the toolbar to send the Group Profile to your default printer.

If you preview the report, a processing message appears, and then the report displays.

You can print the Group Profile from the preview screen by clicking the print icon.
3. Close the User/Group Profile screen to return to the main Security screen.

- **Deleting a group**
  1. From Security, highlight the group you want to delete.
  2. Select File, Delete. A confirmation message appears.
  3. Click Yes to delete.

### Security Users

The user record is where you establish the individual’s user name and password. You can assign the user Supervisor rights, which extends rights to access all areas of all programs, or selected access rights, by adding the user to a group or groups.

If you give the user selected rights, you select the groups to which the user is a member.

If Blackbaud’s General Ledger is present, you can enable account security for the users. With account security enabled, you can restrict the user from all accounts or allow access only to specified accounts.

- **Adding a user**

  Users are given access privileges based on group membership.


  ![Add a User Screen](image)

  2. On the User Information tab, enter the **User Name** and **Description**.

  3. In the **Password Options** frame, enter the user’s **Password**. In the **Confirm** field, type the password again to ensure the password was entered correctly. If you want to allow the user to change this password, mark **User May Change Password**.
4. In the **Group Assignments** frame, mark **Supervisor rights** to give the user access to all programs, or **Selected group rights** to give the user rights based on group membership. If you choose selected rights, highlight the group in the **Not a member of** box and use the arrow buttons to move the group to the **Member of** box. Repeat the process for each group you want to move or use the double arrows to move all the groups.

5. If **General Ledger** is present, select the General Ledger Accounts tab.

6. Mark **Account Security Enabled**.

7. Select **Allow Access only to the Accounts selected below** or **Prevent Access to the Accounts selected below**.

8. In the **Account** column, type the account number or click the search icon to open the Search for Account screen. When an account is entered, the **Description** displays automatically.

9. If the optional **Projects, Grant, and Endowment Management** module is present, select the Projects tab.

10. Mark **Project Security Enabled**.
11. Select **Allow Access only to the projects selected below** or **Prevent Access to the projects selected below**.

12. Click **Include**, and select **One project, Selected projects, All projects, or Range of projects.**

13. Click **OK** to save and close the user record.

➤ **Editing a user**

You can edit a user any time you need to change access privileges.

1. From **Security**, highlight the user you want to edit.

2. Select **File, Open**. The user’s record appears.

3. Make the necessary changes to the user record.

4. Click **OK** to close the record. The changes save automatically.
Previewing and printing a User Profile report

A User Profile includes the name and description of the user, a list of individual security settings, and a list of group access privileges the user can access.

1. From the main Security screen, highlight the user for which you want to preview or print a profile.

2. Click the magnifying glass on the toolbar to preview the profile or click the printer to send the User Profile to your default printer.
If you preview the report, a processing message appears, and then the report is displayed.

3. Close the User/Group Profile screen to return to the main Security screen.

➢ Deleting a user

1. From Security, highlight the user you want to delete.
2. Select File, Delete. A confirmation message appears.
3. Click Yes to delete.

Passwords

When you receive Accounts Payable, the Security module is shipped with a user named Supervisor whose password is admin. Change the Supervisor password to a unique password as soon as possible. Please keep the password in a secure location that is accessible to at least two users.

Passwords are established on a user basis, meaning each user has a password. You can establish and change the password from the user record.

You can also choose Edit, Change Password from any module, if the User May Change Password checkbox is marked on the user record. This option changes the password for the user logged into the program.
-changing user passwords

This option changes the password for the user logged into the program. For example, if you login as Supervisor, you can change the password admin. A password can contain any combination of letters, numerals, spaces, and symbols, and can be up to eight characters long. As you type a password, an asterisk (*) is displayed for each character you type. Passwords are not case sensitive.

1. From any Accounts Payable module, select Edit, Change Password. The Change Password screen appears.

2. On this screen, enter your current password.

3. Enter your desired New password, then enter it again for confirmation of the new password.

4. Click OK to change your password.
Utilities and Housekeeping

In This Chapter

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Posting Rules</td>
<td>72</td>
</tr>
<tr>
<td>General Posting Considerations</td>
<td>72</td>
</tr>
<tr>
<td>References</td>
<td>73</td>
</tr>
<tr>
<td>Posting Regular Invoices</td>
<td>73</td>
</tr>
<tr>
<td>Posting Regular Invoices with Interfund Entries</td>
<td>74</td>
</tr>
<tr>
<td>Regular Invoice Posting Examples</td>
<td>74</td>
</tr>
<tr>
<td>Posting Credit Memos</td>
<td>77</td>
</tr>
<tr>
<td>Credit Memo Posting Examples</td>
<td>78</td>
</tr>
<tr>
<td>Posting Direct Disbursements</td>
<td>79</td>
</tr>
<tr>
<td>Posting Checks</td>
<td>79</td>
</tr>
<tr>
<td>Posting Adjustments to Invoices and Credit Memos</td>
<td>80</td>
</tr>
<tr>
<td>Purging Activity</td>
<td>80</td>
</tr>
<tr>
<td>Posting and Purging Procedures</td>
<td>81</td>
</tr>
</tbody>
</table>
Accounts Payable’s Utilities and Housekeeping module is where you perform general database tasks such as viewing system statistics, purging data, running a duplicate vendor report, defining electronic signatures, validating the database, printing a pre-posting report, and posting to General Ledger.

You can access the utility procedures from the main screen of Utilities and Housekeeping. When attempting to access a utility that globally changes data, a “Users in system” message appears if other users are in the program.

You can run the Duplicate Vendor Report to determine if a vendor has been entered into the program twice. The Duplicate Vendor Report screen displays the duplicate vendor criteria. You must make changes to the criteria for identifying duplicate vendors in Configuration.

The System Statistics screen displays current statistics about your Accounts Payable program.

The Post to General Ledger option allows you to make selections regarding the output format and contents of the file used to post accounts payable transactions. Accounts Payable allows you to create a post file for Blackbaud’s General Ledger, or you can create an export file for use with other programs.

When running some options from Utilities and Housekeeping no other users can be logged in to Accounts Payable.

Posting Rules

The following are rules and requirements you must follow in Accounts Payable when posting information.

General Posting Considerations

When posting, you must take accounting periods into consideration, and post each transaction in the correct period.

Project distributions are required in the following situations:

• Income statement accounts in funds where projects are required.
• Balances sheet accounts in funds where projects are required on Balance sheet accounts.

In all other cases, projects are not required on Accounts Payable transactions.

Before you can post to General Ledger, the following conditions must be met:

• Debits and credits for each fiscal period must be equal.
• Debits and credits for each fund must be equal.
• Debits and credits for each project must be equal within any fund which required projects on balance sheet accounts.

If you post cash in summary, only one transaction per fiscal period is created for each accounts payable summary account and each accounts payable encumbrance account.

By default, the accounts payable expense information is posted in detail. This means if you use the same account on multiple invoices (even within the same fiscal period) during a single post run, a separate General Ledger transaction is created for each occurrence of the account.
Multiple *General Ledger* transactions are also created for multiple instances of the same account on a single invoice. If you post your expenses in summary, only one *General Ledger* transaction is created per expense account per fiscal period for the entire post run.

By default, the Accounts Payable Cash account transactions are posted in summary. This means that only one *General Ledger* transaction is created per Accounts Payable Cash account per fiscal period for the entire post run. If you post cash accounts in detail, a separate *General Ledger* transaction is created for each transaction that posts to the cash account. This can result in the creation of multiple *General Ledger* transactions per fiscal period for each Accounts Payable Cash account.

By default, the Accounts Payable Summary account transactions are posted in summary. This means that only one *General Ledger* transaction is created per Accounts Payable Summary account per fiscal period for the entire post run. If you post summary accounts in detail, a separate *General Ledger* transaction is created for each transaction that posts to the summary account. This can result in the creation of multiple *General Ledger* transactions per fiscal period for each Accounts Payable Summary account.

If the Accounts Payable Summary is printed in summary, one credit and one debit transaction is generated for each period and summary account should there be an amount.

**References**

If a check has more than one invoice associated with it, the Invoice Reference fields for the Cash Account is blank. If a check is a direct disbursement check, the Invoice Reference fields for the Cash Account is blank. If an invoice has not been paid, the Check Reference fields for the Expense Account are blank.

**Posting Regular Invoices**

If project distributions are defined, the transactions debit the appropriate expense accounts using the project distributions.

For any unpaid portion of the invoice amount, the transactions credit the appropriate Accounts Payable Summary account(s) based on the bank account record(s). If the expense accounts have project distributions, and if the Accounts Payable Summary account is an account for which projects are required, the Accounts Payable Summary account transactions have proportionate project distributions.

If the Accounts Payable Summary account is a balance sheet account in a fund where projects are not required on balance sheet accounts, the Accounts Payable Summary transactions do not have project distributions.

For any paid portion of the balance, transactions are created to credit the appropriate Accounts Payable Cash account(s) based on the bank account record(s). If the expense accounts have project distributions, and if the Accounts Payable Cash account is an account for which projects are required, the Accounts Payable Cash account transactions have proportionate project distributions. If the Accounts Payable Cash account is a balance sheet account in a fund where projects are not required on balance sheet accounts, the Accounts Payable Cash account transactions do not have project distributions.
Discounts are created when a check is created for an invoice. If an invoice and its
 corresponding check are both posted in the same post run, the information in this
 section applies. If an invoice is posted in one post run and the corresponding
 check is posted in another post run, any discount taken is posted when the check is
 posted. See the Posting Checks section.

If Distribute Discounts is not marked, the transactions credit the appropriate
 Accounts Payable Discount account(s) based on the bank account record(s). If the
 expense accounts have project distributions and if the Accounts Payable Discount
 account is an account for which projects are required, the Accounts Payable
 Discount account transactions have project proportionate distributions.

If the Accounts Payable Discount account is a balance sheet account in a fund
 where projects are not required on balance sheet accounts, the discount
 transactions do not have project distributions.

If Distribute Discounts is checked, the transactions credit the appropriate
 expense accounts (instead of debiting Accounts Payable discount accounts).
 These are contra entries. If the expense accounts have project distributions, the
 discount contra transactions have proportionate project distributions.

Posting Regular Invoices with Interfund
Entries

Define interfund entries on the bank account record. During posting, these entries
result in the automatic creation of the General Ledger transactions needed to
move money between funds. This allows you to distribute invoices over expense
accounts in multiple funds without having to create about interfund entries for
each invoice.

For each expense with an interfund entry, two additional transactions are created:

- A debit transaction for the interfund Source Account using the same amount
  as the corresponding expense account. Proportionate project distributions are
  included only when projects are required for the Source Account.

- A credit transaction for the interfund Destination Account using the same
  amount as the corresponding expense account. Proportionate project
  distributions are included only when projects are required for the Destination
  Account.

Regular Invoice Posting Examples

Unless otherwise stated, the following statements are true:

- Dates in different months are in different accounting periods.
- Projects are not required on balance sheet accounts.
- Each fund has a single set of Accounts Payable accounts.
- Expense accounts are posted in detail, and Accounts Payable Cash and
  Accounts Payable Summary accounts are posted in summary.
Post an unpaid invoice to a single expense account:

<table>
<thead>
<tr>
<th>Date</th>
<th>Account</th>
<th>Project</th>
<th>Debit</th>
<th>Credit</th>
</tr>
</thead>
<tbody>
<tr>
<td>08-01-01</td>
<td>Expense</td>
<td></td>
<td>100.00</td>
<td></td>
</tr>
<tr>
<td>08-01-01</td>
<td>AP Summary</td>
<td></td>
<td></td>
<td>100.00</td>
</tr>
<tr>
<td>Totals:</td>
<td></td>
<td></td>
<td>100.00</td>
<td>100.00</td>
</tr>
</tbody>
</table>

Post an unpaid invoice to two expense accounts with projects:

(Projects required on balance sheet accounts)

<table>
<thead>
<tr>
<th>Date</th>
<th>Account</th>
<th>Project</th>
<th>Debit</th>
<th>Credit</th>
</tr>
</thead>
<tbody>
<tr>
<td>08-01-01</td>
<td>Expense 1</td>
<td>A</td>
<td>25.00</td>
<td></td>
</tr>
<tr>
<td>08-01-01</td>
<td>Expense 2</td>
<td>B</td>
<td>75.00</td>
<td></td>
</tr>
<tr>
<td>08-01-01</td>
<td>AP Summary</td>
<td>A 25.00</td>
<td></td>
<td>100.00</td>
</tr>
<tr>
<td></td>
<td></td>
<td>B 75.00</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Post a fully paid invoice and corresponding check:

<table>
<thead>
<tr>
<th>Date</th>
<th>Account</th>
<th>Project</th>
<th>Debit</th>
<th>Credit</th>
</tr>
</thead>
<tbody>
<tr>
<td>08-01-01</td>
<td>Expense 1</td>
<td>A</td>
<td>25.00</td>
<td></td>
</tr>
<tr>
<td>08-01-01</td>
<td>Expense 2</td>
<td>B</td>
<td>75.00</td>
<td></td>
</tr>
<tr>
<td>08-01-01</td>
<td>AP Cash</td>
<td>A 25.00</td>
<td></td>
<td>100.00</td>
</tr>
<tr>
<td></td>
<td></td>
<td>B 75.00</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Post a partially paid invoice and corresponding check:

<table>
<thead>
<tr>
<th>Date</th>
<th>Account</th>
<th>Project</th>
<th>Debit</th>
<th>Credit</th>
</tr>
</thead>
<tbody>
<tr>
<td>08-01-01</td>
<td>Expense</td>
<td></td>
<td>100.00</td>
<td></td>
</tr>
<tr>
<td>08-01-01</td>
<td>AP Summary</td>
<td></td>
<td></td>
<td>25.00</td>
</tr>
<tr>
<td>08-01-01</td>
<td>AP Cash</td>
<td></td>
<td>75.00</td>
<td></td>
</tr>
</tbody>
</table>

Post invoice with post date of 08-01-01 and full payment by check on 09-01-01:

<table>
<thead>
<tr>
<th>Date</th>
<th>Account</th>
<th>Project</th>
<th>Debit</th>
<th>Credit</th>
</tr>
</thead>
<tbody>
<tr>
<td>08-01-01</td>
<td>Expense 1</td>
<td>A</td>
<td>25.00</td>
<td></td>
</tr>
<tr>
<td>08-01-01</td>
<td>Expense 2</td>
<td>B</td>
<td>75.00</td>
<td></td>
</tr>
<tr>
<td>08-01-01</td>
<td>AP Summary</td>
<td>A 25.00</td>
<td></td>
<td>100.00</td>
</tr>
<tr>
<td></td>
<td></td>
<td>B 75.00</td>
<td></td>
<td></td>
</tr>
<tr>
<td>09-01-01</td>
<td>AP Summary</td>
<td>A 25.00</td>
<td></td>
<td>100.00</td>
</tr>
<tr>
<td></td>
<td></td>
<td>B 75.00</td>
<td></td>
<td></td>
</tr>
<tr>
<td>09-01-01</td>
<td>AP Cash</td>
<td>A 25.00</td>
<td></td>
<td>100.00</td>
</tr>
<tr>
<td></td>
<td></td>
<td>B 75.00</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Post a $500.00 unposted invoice (paid in full on 08-01-01) and a $100.00 undistributed discount:

<table>
<thead>
<tr>
<th>Date</th>
<th>Account</th>
<th>Project</th>
<th>Debit</th>
<th>Credit</th>
</tr>
</thead>
<tbody>
<tr>
<td>08-01-01</td>
<td>Expense</td>
<td>A 500</td>
<td>500.00</td>
<td></td>
</tr>
<tr>
<td>08-01-01</td>
<td>AP Cash</td>
<td>A 400</td>
<td>400.00</td>
<td></td>
</tr>
<tr>
<td>08-01-01</td>
<td>AP Discount</td>
<td>A 100</td>
<td>100.00</td>
<td></td>
</tr>
</tbody>
</table>

(Projects required on balance sheet accounts)

Post a $500.00 unposted invoice (paid in full on 08-01-01) with a $100.00 distributed discount:

<table>
<thead>
<tr>
<th>Date</th>
<th>Account</th>
<th>Project</th>
<th>Debit</th>
<th>Credit</th>
</tr>
</thead>
<tbody>
<tr>
<td>08-01-01</td>
<td>Expense 1</td>
<td>A 200.00</td>
<td>200.00</td>
<td></td>
</tr>
<tr>
<td>08-01-01</td>
<td>Expense 2</td>
<td>B 300.00</td>
<td>300.00</td>
<td></td>
</tr>
<tr>
<td>08-01-01</td>
<td>Expense 1</td>
<td>A 40.00</td>
<td>40.00</td>
<td></td>
</tr>
<tr>
<td>08-01-01</td>
<td>Expense 2</td>
<td>B 60.00</td>
<td>60.00</td>
<td></td>
</tr>
<tr>
<td>08-01-01</td>
<td>AP Cash</td>
<td>A 40.00</td>
<td>400.00</td>
<td></td>
</tr>
</tbody>
</table>

Post a $100.00 partial payment check for a $500.00 invoice that had been previously posted:

<table>
<thead>
<tr>
<th>Date</th>
<th>Account</th>
<th>Project</th>
<th>Debit</th>
<th>Credit</th>
</tr>
</thead>
<tbody>
<tr>
<td>08-01-01</td>
<td>AP Cash</td>
<td></td>
<td>100.00</td>
<td></td>
</tr>
<tr>
<td>08-01-01</td>
<td>AP Summary</td>
<td></td>
<td>100.00</td>
<td></td>
</tr>
</tbody>
</table>

Post an unpaid invoice to accounts, each with an associated interfund entry: (All interfund accounts are income statement accounts)

<table>
<thead>
<tr>
<th>Date</th>
<th>Account</th>
<th>Project</th>
<th>Debit</th>
<th>Credit</th>
</tr>
</thead>
<tbody>
<tr>
<td>08-01-01</td>
<td>Expense1</td>
<td>A 75</td>
<td>100.00</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>B 25</td>
<td></td>
<td></td>
</tr>
<tr>
<td>08-01-01</td>
<td>Interfund1</td>
<td>A 75</td>
<td>100.00</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Source</td>
<td>B 25</td>
<td></td>
<td></td>
</tr>
<tr>
<td>08-01-01</td>
<td>Interfund1</td>
<td>A 75</td>
<td></td>
<td>100.00</td>
</tr>
<tr>
<td></td>
<td>Destin.</td>
<td>B 25</td>
<td></td>
<td></td>
</tr>
<tr>
<td>08-01-01</td>
<td>Expense2</td>
<td>B 10</td>
<td>50.00</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>C 40</td>
<td></td>
<td></td>
</tr>
<tr>
<td>08-01-01</td>
<td>Interfund2</td>
<td>B 10</td>
<td>50.00</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Source</td>
<td>C 40</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Post a partially paid invoice with an associated Interfund Entry:

<table>
<thead>
<tr>
<th>Date</th>
<th>Account</th>
<th>Project</th>
<th>Debit</th>
<th>Credit</th>
</tr>
</thead>
<tbody>
<tr>
<td>08-01-01</td>
<td>Interfund2 Destin.</td>
<td>B 10 C 40</td>
<td>50.00</td>
<td></td>
</tr>
<tr>
<td>08-01-01</td>
<td>AP Summary</td>
<td></td>
<td></td>
<td>150.00</td>
</tr>
</tbody>
</table>

For any unapplied portion of the credit memo, the transactions debit the appropriate Accounts Payable Summary account(s) based on the bank account record(s). Proportionate project distributions are included only if the Accounts Payable Summary account requires projects.
For any portion of the credit memo that is applied to a previously posted invoice or an unpaid invoice, the transactions debit the appropriate Accounts Payable Summary account(s) based on the bank account record(s). Proportionate project distributions are included only if the Accounts Payable Summary account requires projects.

For any portion of the credit memo applied to an invoice that is posted and paid in the same post run, create transactions to debit the appropriate cash account. This is the only case where the Accounts Payable Cash Account is used instead of the Accounts Payable Summary account for posting a credit memo.

### Credit Memo Posting Examples

Unless otherwise stated, the following statements are true:

- Dates in different months are in different accounting periods.
- Projects are not required on balance sheet accounts.
- Each fund has a single set of Accounts Payable accounts.
- Expense accounts are posted in detail, and Accounts Payable Cash and Accounts Payable Summary accounts are posted in summary.

Post an unapplied $100.00 credit memo to a single expense account:

<table>
<thead>
<tr>
<th>Date</th>
<th>Account</th>
<th>Project</th>
<th>Debit</th>
<th>Credit</th>
</tr>
</thead>
<tbody>
<tr>
<td>08-01-01</td>
<td>Expense</td>
<td></td>
<td></td>
<td>100.00</td>
</tr>
<tr>
<td>08-01-01</td>
<td>AP Summary</td>
<td></td>
<td>100.00</td>
<td></td>
</tr>
<tr>
<td>Totals:</td>
<td></td>
<td></td>
<td>100.00</td>
<td>100.00</td>
</tr>
</tbody>
</table>

Post a $100.00 credit memo (fully applied to an unposted, unpaid $300 invoice):

<table>
<thead>
<tr>
<th>Date</th>
<th>Account</th>
<th>Project</th>
<th>Debit</th>
<th>Credit</th>
</tr>
</thead>
<tbody>
<tr>
<td>08-01-01</td>
<td>Credit Expense 1</td>
<td></td>
<td>50.00</td>
<td></td>
</tr>
<tr>
<td>08-01-01</td>
<td>Credit Expense 2</td>
<td></td>
<td>50.00</td>
<td></td>
</tr>
<tr>
<td>08-01-01</td>
<td>Invoice Expense 1</td>
<td></td>
<td>125.00</td>
<td></td>
</tr>
<tr>
<td>08-01-01</td>
<td>Invoice Expense 2</td>
<td></td>
<td>175.00</td>
<td></td>
</tr>
<tr>
<td>08-01-01</td>
<td>AP Summary</td>
<td></td>
<td></td>
<td>200.00</td>
</tr>
<tr>
<td>Totals:</td>
<td></td>
<td></td>
<td>300.00</td>
<td>300.00</td>
</tr>
</tbody>
</table>

Post a $100.00 partial payment check for a $500.00 invoice that had been previously posted:

<table>
<thead>
<tr>
<th>Date</th>
<th>Account</th>
<th>Project</th>
<th>Debit</th>
<th>Credit</th>
</tr>
</thead>
<tbody>
<tr>
<td>08-01-01</td>
<td>AP Cash</td>
<td></td>
<td>100.00</td>
<td></td>
</tr>
<tr>
<td>08-01-01</td>
<td>AP Summary</td>
<td></td>
<td>100.00</td>
<td></td>
</tr>
</tbody>
</table>

Post a previously unposted $5.00 credit memo fully applied to a $50.00 invoice that is fully paid and posted in the same post session:

<table>
<thead>
<tr>
<th>Date</th>
<th>Account</th>
<th>Project</th>
<th>Debit</th>
<th>Credit</th>
</tr>
</thead>
<tbody>
<tr>
<td>08-01-01</td>
<td>Invoice Expense</td>
<td></td>
<td>50.00</td>
<td></td>
</tr>
<tr>
<td>08-01-01</td>
<td>Credit Expense</td>
<td></td>
<td>5.00</td>
<td></td>
</tr>
</tbody>
</table>
Post a previously unposted $35.00 credit memo fully applied to two invoices that are both fully paid and posted in the same post session:

<table>
<thead>
<tr>
<th>Date</th>
<th>Account</th>
<th>Project</th>
<th>Debit</th>
<th>Credit</th>
</tr>
</thead>
<tbody>
<tr>
<td>08-01-01</td>
<td>Invoice Expense 1</td>
<td></td>
<td>25.00</td>
<td></td>
</tr>
<tr>
<td>08-01-01</td>
<td>Invoice Expense 2</td>
<td></td>
<td>30.00</td>
<td></td>
</tr>
<tr>
<td>08-01-01</td>
<td>Credit Expense</td>
<td></td>
<td></td>
<td>35.00</td>
</tr>
<tr>
<td>08-01-01</td>
<td>AP Cash</td>
<td></td>
<td></td>
<td>20.00</td>
</tr>
<tr>
<td>Totals:</td>
<td></td>
<td></td>
<td>55.00</td>
<td>55.00</td>
</tr>
</tbody>
</table>

### Posting Direct Disbursements

You can mark direct disbursements as Do Not Post. Those direct disbursements do not affect *General Ledger*. Neither the expenses nor the cash are posted.

You can enter and save direct disbursements without printing, allowing you to print batches of direct disbursement checks. However, you cannot post direct disbursements in this “waiting to be printed” status.

For direct disbursements with a Not Yet Posted status, the default posting date is the check date. While the direct disbursement has a Not Yet Posted status, you can modify the post status and the post date at any time.

After a direct disbursement is posted, you cannot modify the post status or the post date.

When posting a direct disbursement:

- Transactions are created to debit the appropriate expense account(s), including project distributions, as specified on the GL Distribution tab.
- Transactions are created to credit the appropriate Accounts Payable Cash account(s). Proportionate project distributions are included only if the Accounts Payable Cash account requires projects.
- All transactions use the post date specified on the direct disbursement record. If this differs from the check date, then the check date is ignored.

### Posting Checks

The post status field is editable only for direct disbursement checks. For regular checks (i.e. all checks used to pay invoices), the post status of the check is inherited from the invoice(s) paid with the check.

Transactions are created to debit the appropriate Accounts Payable Summary account(s) using project distributions, if defined.
Transactions are created to credit the appropriate Accounts Payable Cash account(s) based on bank account record(s). If the expense accounts have project distributions, and if the Accounts Payable Cash account is an account for which projects are required, the Accounts Payable Cash account transactions have proportionate project distributions. If the Accounts Payable Cash account is a balance sheet account in a fund where projects are not required on balance sheet accounts, the Accounts Payable Cash transactions do not have project distributions.

If an invoice was posted previously, posting a check affects one or more Accounts Payable Summary accounts and one or more Accounts Payable Cash accounts.

If a discount has been taken and the related invoice was posted in a previous post run, then discount information must be posted when the check is posted.

If Distribute Discounts is not marked, you can create transactions to credit the appropriate Accounts Payable Discount account(s) based on the bank account record(s). If the expense accounts have project distributions, and if the Accounts Payable Discount account is an account for which projects are required, the Accounts Payable Discount account transactions have project proportionate distributions.

If the Accounts Payable Discount account is a balance sheet account in a fund where projects are not required on balance sheet accounts, the discount transactions do not have project distributions.

If Distribute Discounts is marked, create transactions to credit the appropriate expense accounts (instead of debiting Accounts Payable discount accounts). These are contra entries. If the expense accounts have project distributions, the discount contra transactions have proportionate project distributions.

**Posting Adjustments to Invoices and Credit Memos**

It is possible to create adjustment transactions for invoices and credit memos that have previously been posted.

Once an adjustment transaction has been posted, it cannot be modified or deleted. Additional changes can only be made if you create additional adjustments.

When posting an adjustment:

- Transactions are created to completely reverse the transactions that were previously posted to **General Ledger**.
- Additional transactions are created to post the revised **General Ledger** information. It is possible for amounts to be adjusted as well as **General Ledger** distributions.
- The status of the adjustment transaction is changed from Not Yet Posted to Posted.
- All rules described in the invoice and credit memo sections apply when posting adjustments.

**Purging Activity**

The transaction date must be on or before the cutoff date specified on the parameter form.
The transaction must be marked as **Posted** or **Do Not Post**.

The transaction must be fully resolved. For example:

- Invoices must be completely paid.
- Credit memos must be completely used.
- Checks must be cleared or voided.
- For fixed recurring invoices, all invoices must be generated.
- Open-ended recurring invoices must be marked “inactive”.
- Purchase orders must be closed.
- For receipts, all items must be fully receipted.

The transaction cannot be linked to any transaction that cannot be purged.

The 1099 summary records created for each fiscal period are not purged.

Deleted invoices, credit memos, and purchase order whose transaction date occurs on or before the cutoff date are purged.

## Posting and Purging Procedures

- **Accessing Utilities and Housekeeping**

  *Accounts Payable’s* **Utilities and Housekeeping** module is where you perform general database tasks such as viewing system statistics, purging data, running a Duplicate Vendor Report, defining electronic signatures, validating the database, printing a pre-posting report, and posting to *General Ledger*.

  1. From the Start menu, select **Programs, Blackbaud Accounts Payable**.
  2. Select **Utilities and Housekeeping** from the *Accounts Payable* modules.
Posting to Blackbaud’s General Ledger

The posting option allows you to post each transaction type from Accounts Payable to General Ledger.

1. From Utilities and Housekeeping, select File, Post to General Ledger. The Post to General Ledger screen appears.

2. Indicate which transactions you are posting by marking the Post Accounts Payable with source code and/or the Post Purchase Orders with source code checkbox. Select the source code from the drop-down list.

3. Mark Post directly to Blackbaud’s General Ledger or Create an export file in this format. If you choose to create an export file, select a file format from the drop-down list and enter the file name and location where you want to save the file (i.e. C:\BO\NL\APPOST.EXP) in the Export file name field. If you are unsure of the location, click to browse for the correct directory.

4. Select the Posting Details tab.
5. Make changes to the grid by clicking the cell you want to change. You cannot edit fields with a yellow background.

6. For Post Method, select either Detail or Summary. If you print in detail, each transaction appears in the post file and on the report. If you print in summary, transactions are grouped to show the total debit and total credit activity as the account summary.

7. For Reference Type, select the default reference established on the General Ledger tab in Configuration or a custom reference. If you select <Default>, the Reference column fills in automatically. If you select Custom, you must type in the reference.

8. In the Summarize transactions by field, select either Post Date or Fiscal Period to organize the report.

9. Select the Format tab.

10. Mark either Preview report after posting or Print report after posting.

11. In the Display report in field, use the drop-down list to select Landscape or Portrait format.

12. Enter the Print report on field. Use the drop-down list to select a printer.

13. In the Sort report by grid, select a filter from the drop-down list.

14. Select Ascending or Descending in the Order column.

15. Mark the Print control report on checkbox to print a control report of all posted transactions. If this checkbox is marked, use the drop-down list to select a printer.
16. Click **Post Now**. The program processes and validates the batch before creating the posted batch and printing/previewing the posting report. After processing, the following message appears.

![Image of Accounts Payable batch processing complete]

17. Click **OK**.

**Printing/previewing a pre-posting report**

You can choose the format for printing a pre-posting report for *Accounts Payable* transactions, optional *Purchases Orders* module transactions, or both.

1. From *Utilities and Housekeeping*, select **File, Post to General Ledger**. The Post to General Ledger screen appears.

![Image of Post to General Ledger screen]

2. Indicate which transactions you want to print or preview by marking the **Post Accounts Payable with source code** and/or the **Post Purchase Orders with source code** checkbox. Select the source code from the drop-down list.
3. Select the Posting Details tab.

4. Make changes to the grid by clicking the cell you want to change. You cannot edit fields with a yellow background.

5. For Post Method, select either Detail or Summary. If you print in detail, each transaction appears in the post file and on the report. If you print in summary, transactions are grouped to show the total debit and total credit activity as the account summary.

6. For Reference Type, select the default reference established on the General Ledger tab in Configuration or a custom reference. If you select <Default>, the Reference column fills in automatically. If you select Custom, you must enter the reference.

7. In the Summarize transactions by field, select either Post Date or Fiscal Period to organize the report.

8. Select the Format tab.

9. In the Display report in field, use the drop-down list to select Landscape or Portrait format.
10. In the Sort report by grid, select a filter from the drop-down list.

11. Select Ascending or Descending in the Order column.

12. Mark Print report after posting to send the report to the printer or mark Preview report after posting to display the report on the screen.

13. Click Pre-Posting Report. The program processes and validates the batch before previewing the report.

14. Click OK.

➤ Viewing system statistics

System Statistics provide you with current totals of all transactions and the dates when each major program procedure was last run.


2. The System Statistics screen displays current statistics about your Accounts Payable program. Number fields in this display are calculated totals, as opposed to Last Run fields which are dates stored in the program.

3. Once you view the statistics, click Refresh if you want the program to update and recalculate the statistics.

4. Click Close to exit.
Validating the database

This utility checks the validity of your Accounts Payable database indexes. Server crashes and network interference can corrupt your database; therefore, we recommend validating it weekly. Before validating the database, we recommend creating a backup of the database.

1. From Utilities and Housekeeping, select File, Validate Database.

2. This screen warns you that other users must be logged out of the system and that a backup must be completed before continuing with this procedure.

3. Click Proceed.

4. Begin the procedure by clicking Continue. A status screen shows you the progress of the database validation.
5. Once the procedure is complete, a confirmation message appears.

![Accounts Payable](image)

6. Click **OK**.

**Adding an electronic signature**

You can print an electronic signature on checks or purchase orders. You must scan all electronic signatures.

1. From the **Utilities and Housekeeping File** menu, select **Electronic Signatures**.
2. Click **Add**. The Add an Electronic Signature screen appears.

3. Type the signature in the **Description** field.

4. The **Status** field defaults to **Active**. Access the drop-down list if you want to select **Inactive**.

5. Use the browse button to select the proper signature file.

6. In the Available for frame, specify how you want to use the signature. You can mark **Accounts Payable Checks**, **Account Payable Purchase Order**, and/or **Payroll Checks**.

7. Click **OK**.

**Editing an electronic signature**

1. From the **Utilities and Housekeeping File** menu, select **Electronic Signatures**.

2. Highlight the desired signature, and click **Edit**. The Edit an Electronic Signature screen appears.

3. Edit the necessary information.
Deleting an electronic signature

1. From the Utilities and Housekeeping File menu, select Electronic Signatures.
2. Highlight the signature you want to delete.
3. Click Delete.
4. Click Yes.

Purging vendor activity

Purging vendor activity helps reduce the size of the database, and is an important part of the general upkeep of Accounts Payable. Before purging vendor activity, it must meet certain requirements. See Rules for Purging Activity in the Rules section of this chapter.

1. From the Utilities and Housekeeping File menu, select Purge Vendor Activity.
2. All other users must exit the system before purging. If there are no other users logged into the system, click Proceed. The Purge Vendor Activity screen appears.

3. Click Purge. A secondary menu appears, select from All Records, Selected Records, or One Record. The default is All Records.

4. Mark the desired checkboxes. You can select to Create output [only available for report], Print control report, and Create exception query.

5. Enter the desired date in the Exclude transactions after this date field.

6. Click Pre-Purge Report if you want to view a report listing the vendor name, transaction number, transaction date, transaction type, transaction description, and transaction amount.

7. Click Purge Now to begin the process. A warning screen appears, which asks if you want to continue.

8. If you want to continue with the purge, click Yes.
Purging inactive vendors

1. From the Utilities and Housekeeping File menu, select Purge Inactive Vendors.

2. All other users must exit the system before purging. If there are no other users logged into the system, click Proceed. The Inactive Vendor Purge screen appears with the General tab displayed.

3. Click Purge. A secondary menu appears. Select from All vendors, Selected vendors, or One vendor. The default is All vendors.

4. Mark the checkbox if you want to Exclude vendors with open-ended recurring invoices or to Exclude vendors with 1099 information for the current year.

5. Enter the desired date in the Exclude transactions after this date field.
6. Mark the checkbox if you want to **Print control report** or **Create output query from Inactive Vendor report**.

7. Click **Next**. The Attributes tab appears.

![Inactive Vendor Purge](image)

8. Mark the **Include/Exclude Vendors With these Attributes** checkbox if you want to filter vendors based on attributes.

9. Enter the **Filter**, **Category**, and **Description** columns.

10. Click **Pre-Purge Report** if you want to view a report listing information regarding the vendor(s) selected for purging.

11. Click **Purge Now** to begin the process. A warning screen appears which asks if you want to continue.

12. Click **OK**.

13. When the purge completes, you receive the following message.

![Inactive Vendor Purge Complete](image)

14. Click **Preview Report** if you want to view a report of the purge.

15. Click **OK**.
Running a duplicate vendor report

Running a duplicate vendor report identifies vendors with matching duplicate criteria. You establish duplicate criteria in Configuration. The criteria on the Duplicate Vendor Report parameter screen are display only and cannot be edited. You can also create an output query of duplicate records.

1. From Utilities and Housekeeping, select File, Duplicate Vendor Report. The Duplicate Vendor Report screen appears.

2. From this screen, you can create an output query of duplicate records. You can use this query later in other areas of the programs such as purging records.

3. Mark Create output query of duplicate records if you want to create a query of the report results. A query is created from all of the records found to meet the duplicate vendor criteria displayed in the grid. If you mark this checkbox, the Save Static Query screen appears when you click OK.

4. Enter a Query name and Description for this output query.

5. Use the drop-down list in the Include in field to select from Query Lists, Export Lists, or Both.

6. If desired, mark Other users may execute this query.

7. If desired, mark Other users may modify this query.

8. Click OK to run the report.
In This Chapter

Accessing Vendors ................................................. 96
Setting Vendor Preferences ................................. 97
New Records ......................................................... 99
Creating a New Record ................................. 99
Working with Vendor Records ....................... 100
Vendors is where you establish individual records for your vendors. From the main menu, as well as the vendor records, you can create regular invoices, recurring invoices, and credit memos.

If you are using the optional Purchase Orders module, you can also create purchase orders and receipts. For more information see the Purchase Orders User’s Guide.

From Vendors, you can:

- add, edit, and delete a vendor
- open a query
- define and edit 1099 amounts
- view general information
- set vendor preferences
- add, edit, and delete attributes
- add, edit, and delete notes
- define search options
- load vendor defaults
- add, edit, and delete a default set
- view activity summary
- search for a duplicate vendor
- search for a vendor record
- create a new vendor record

## Accessing Vendors

From the vendor record, you can track activity and 1099 information, and store information such as the vendor’s addresses, contact persons, Tax ID number, and credit limit. You can also select and write checks for individual invoices.

### Accessing Vendors

1. From the Start menu, select Programs, Blackbaud Accounts Payable.
2. Select Vendors from the Accounts Payable modules.

---

Although Accounts Payable allows you to have as many vendor records as you want open at once, you can be limited to the number of open vendor records by your hardware resources.
Setting Vendor Preferences

In *Accounts Payable*, you set preferences to use when establishing records for your vendors.

- **Setting vendor preferences**
  1. From *Vendors*, select *Edit, Preferences*. The Preferences screen appears.

2. In the **Default Dates** frame, use the drop-down lists to specify a default **Invoice date**, **Invoice due date**, **Purchase order date**, and **Credit date**. These dates are entered automatically when you create an invoice, purchase order, or credit memo.

3. Select from the **Toolbar new action** drop-down list which action you want the program to take when you click New. Select from *Ask for type*, *New Vendor*, *New Invoice*, *New Credit Memo*, *New Recurring Invoice*, *New Purchase Order*, and *New Receipt*.

4. Mark **Show save information dialog** if you want a dialog box to appear each time you save, verifying the record has been saved.

5. Mark **Show deleted records** if you want deleted transactions to appear on the Activity tab when you select *All* as a filter.

6. Mark **Show recently opened records** if you want the program to maintain a list of recent entries on the *File* menu to allow for easy access. If marked, use the scroll buttons to enter the number of records, up to a maximum of nine, you want to appear in the list.

7. Mark **Prompt before saving records** if you want the program to present a dialog box prompting you to save the record prior to closing it or opening a new record.
8. Mark **Display warning if invoice description is blank** to have the program warn when you save an invoice without a description.

9. Mark **Prompt to create invoice for un invoiced items** if you want to create an invoice when items are received that were not previously invoiced.

10. In the **Defaults for Credit Memos/Invoices** frame, use the drop-down lists to specify a default **Post status** and **Post date**.

11. In the **Default for PO Line Items** frame, use the drop-down lists to specify a default **Post status** and **Post date**.

12. In the **Defaults for Checks** frame, use the drop-down lists to specify the **Post status** and **Post date**.

13. Select the **Defaults/Tab Settings** tab.

14. Select the record type for which you want to establish tab preferences. Select from **Vendor**, **Invoice**, **Recurring invoice**, **Credit memo**, and **Purchase order**.

15. In the **Default tab** field, select the tab you want to appear first when creating or opening a record.

16. In the **Check these tabs for data** box, mark the checkboxes of the tabs you want to appear with a check mark when information is stored on them. You can do this for each record type by marking the record type option.

17. Click **Vendor Profile** to select or add the parameter file you want the program to use when printing the Vendor Profile report.
18. Select the Blank Paper Check Defaults tab if you have the optional Business Office Forms module.

The Blank Paper Check Defaults tab only appears if you have the optional Business Office Forms module.

19. If desired, mark the **Include an address** checkbox and select an address from the drop-down list.

20. If desired, mark the **Include a logo on the check stub from file** checkbox and enter the filename path, or click the browse icon to locate the logo file.

21. If desired, mark the **Include a logo on the check from file** checkbox and enter the filename path, or click the browse icon to locate the logo file.

22. Click **OK**.

**New Records**

In *Vendors*, when you add a new record you can choose to create one of four record types (six if you are using the optional module *Purchase Orders*). You can also choose to load defaults into the new record based on a default file that you select.

**Creating a New Record**

The following procedure addresses the initial steps to creating a record. The procedures for adding a specific record type are found later in this manual.
Creating a new record

1. From Vendors, select File, New. The Create a New Record screen appears.

2. Select the type of record you want to add. Choose from Vendor, Invoice, Purchase Order, Recurring Invoice, Credit Memo, or Receipt.

3. If desired, select the default set from which you want to load defaults and mark Load all defaults. You can create custom default setting for new records. Then, if you select the default set when you add a new record, the information is automatically entered in the new record, reducing your data entry time.

4. Click OK. A blank record opens. Enter the required information for the record.

5. Select File, Save, Save and New, or Save and Close. Save and New closes the current record and automatically opens a new blank record.

Working with Vendor Records

Vendor biographical information and activity are stored on the vendor record. From the vendor record, you can create regular invoices, recurring invoices, and credit memos. You can track activity and 1099 information, and store information such as the vendor’s addresses, contact persons, Tax ID number, and credit limit. You can also select and write checks for individual invoices.

Adding a new vendor

1. From Vendors, select File, New. The Create a New Record screen appears.
2. Select **Vendor** for the record type.

3. If desired, select the default set from which you want to load defaults and mark **Load all defaults**.

4. Click **OK**. A new vendor record opens.

➤ **Entering vendor biographical information**

1. From the Add a Vendor screen, select the Vendor tab.

   ![Vendor Tab](image)

2. Enter the **Name** of the vendor. Type in the name as you want it to appear on invoices and other documents. The **Vendor ID** automatically generates if you mark the appropriate option on the General tab in **Configuration**. If you do not want the ID to generate automatically, enter the ID.

3. Mark **One Check per invoice** if you want the program to print one check for each invoice for this vendor.

4. If desired, enter the **Tax ID #**. This number prints on the vendor’s 1099 form (if a form is required).

5. Mark the **Vendor on Hold** checkbox if you want the program to prevent you from creating new regular invoices, recurring invoices, or purchase orders for this vendor. This option is useful if you have a question about a payment.

6. Mark the **Credit limit** checkbox and enter an amount if you want the program to warn you during invoice entry and purchase order line item entry when you exceed the credit limit.

7. Enter the number of days in which the invoice is due in the **Due days** field. The program adds this number to the invoice date to determine the default invoice due date.

8. Enter the **Discount days** field. When adding a new invoice, the discount expiration date automatically fills in based on this field and the invoice date.

9. Enter the **Percent** field to calculate the default discount amount.

---

**You can also access a new vendor by accessing the submenu of the New record icon and selecting Vendor.**

**The Purchase Order tab only appears if you have the optional Purchase Order module.**

**For names such as The ABC Company, where you want to search for the company name by sorting on “A” and not on “The,” place a backslash (\) before the first letter of the name you want to sort (e.g. The \ABC Company). The program sorts on the character directly to the right of the backslash. The backslash does not appear on any reports or documents.**
10. If desired, enter an **Alias** for the vendor. The alias does not print on any documents.

11. Enter the address and contact information for this vendor. Each vendor has a primary address entered on the Vendor tab and can have an unlimited number of secondary addresses added on the Addresses tab. Each secondary address also stores the corresponding contact name and phone information.

12. If you mark the **Print** checkbox, the contact’s position is printed on reports, invoices, etc.

### Completing the 1099 Information tab

1. If the vendor is a 1099 Vendor, select the 1099 Information tab.

2. Mark the **1099 Vendor** checkbox if you want the program to track the vendor as a 1099 vendor.

3. Select the **Default box #**. This is the default 1099 box number used when adding new GL Distributions for the vendor.

4. In the **1099 Name** field, enter the name you want to appear as the Recipient on the 1099 form. This is an optional field.

   Please be aware that what you enter in this field is pulled into the magnetic media file to serve as the name control value, and therefore, must be formatted correctly. You must enter a person’s last name first. For organization names, the first four characters you enter will be used.

   We recommend you review the rules in the Business Name Control matrix provided by the IRS to verify your name control prior to e-filing.

5. The **1099 Name 2** field is optional. If you enter a name, it appears on the 1099 form under the **1099 Name** field.

6. Enter the vendor’s address in the appropriate fields.

7. Click **Copy from Vendor** if you want to copy the vendor name and address information from the Vendor tab.
8. In the **Show 1099 activity** frame, select the years for which you want to display 1099 activity. The drop-down list contains all calendar years with vendor activity.

9. Verify the **1099 Summary** grid information is correct. This grid displays the summary information for the selected calendar years.

### Completing the GL Distribution tab

The GL Distribution tab is where you define the default expense distribution for the vendor.

1. From the vendor, select the GL Distribution tab.

2. Select the **Bank Account** from the drop-down list.

3. In the **Account No.** column, you can type in the account number. If **General Ledger** is present you can perform an account search for the correct account number.

4. If **General Ledger** is present, the **Account Description** displays once the account number is entered. If not present, this column is not available.

5. In the **Amount** column, enter the amount or percentage of invoice amount applied to the specified account.

6. In the **1099 Box** column, select from the available 1099 box numbers.

7. In the **1099 State Income** column, you can assign a state income designation that will total into Box 18.

8. In the **Project** column, you can access the Open screen and select a project.

9. In the **Transfer** column, select a transfer. The transfer allows you to track activity across funds.

10. In the **Comment** column, enter any notes you want associated with the specified account entry. This is a free-form, text field.
11. Click **Load Distribution** to select a distribution from an existing table or from the vendor record. You can also **Distribute Evenly** or **Delete All distributions**.

12. If you have the optional *Project, Grant, and Endowment Management* module, you can distribute by **Projects**.

13. Mark the checkbox if you want to **Distribute discounts**.

➤ **Completing the Attributes tab**

You can use attributes added to the vendor in Mail, Query and Export, and Reports. For example, you can add a vendor to a query, or filter a vendor from a mailing based on an attribute.

1. From the vendor, select the Attributes tab.

2. Enter the **Category** field. Use the drop-down list to make a selection.

3. In the attributes grid, click the first blank **Category** field and select an entry from the drop-down list of available attributes.

4. Enter the attribute **Description**. If the attribute is defined as a table with a short description, you must select a **Short Description** and the **Description** fills in automatically. If the attribute is a table without a short description, select from the drop-down list of available descriptions.

5. If the attribute is a table with a short description, select the desired **Short Description** from the drop-down list.

6. Enter the **Date**.

7. Enter any **Comment** you want associated with the attribute.
Completing the Summary tab

1. From the vendor, select the Summary tab.

2. With General information marked, enter a date in the Balance as of field. You can use this date as a cutoff to view summary information up to the specified date. This field defaults to the current system date.

3. Specify whether the program should calculate the balance using the Due date or Invoice date. If you mark Due date, aging information is calculated by the due date. This field initially defaults to Due date, but the program remembers the setting for each user. If you mark Invoice date, aging information is calculated by invoice date.

4. After making changes to the Balance as of or date fields, click Recalculate to recalculate aging information.

5. View the Overall Vendor Statistics and Most Recent Activity grids.

6. Select Activity.
7. Select from the **Show activity for** drop-down list the time period for which you want to display activity. This field defaults to **Calendar Years** if **General Ledger** is not present. If **General Ledger** is present, select from **Fiscal Years**, **Fiscal Periods**, **Calendar Years**, and **Any Dates**.

8. After making any changes to the criteria, click **Recalculate** to have the program recalculate the information in the grid.

9. Click the down arrow in the **Year 1** and **Year 2** fields to select from the list of available years. Fiscal years are defined in the **General Ledger** program.

10. View the **Activity** grid. The grid consists of **Item**, **Count**, and **Amount** columns. Activity items can be Invoices, Payments, Credit Memos, Discount taken, Discount lost, and Ave. days to pay. The **Count** column is the total number of items entered into the system. The **Amount** column is the total amount of the item entered into the program.

### Completing the Bank Information tab

If you are using the optional **Electronic Funds Transfer** module, you can establish your bank and routing information on the Bank Information tab. This tab is necessary only if you have the optional **Electronic Funds Transfer** module. Please refer to the **Electronic Funds Transfer User’s Guide** for more information.
Filtering the Activity tab

From the Activity tab you can add, edit, and delete activity for invoices and credit memos. You can also filter the tab to display specific activity.

1. From the vendor, select the Activity tab.

2. Select the activity you want to view in the **Show** field.

3. Select the Status for the activity you want to view.

4. Select the **Date** of the activity you want to view. The grid displays all activity associated with the vendor that meets the criteria you selected. For information and procedures regarding invoices and credit memos, please see Chapter 8, *Invoices and Credit Memos*. 
Completing the Recurring tab

You can add, edit, and delete recurring invoices from the Recurring tab. For more information on recurring invoices, please see Chapter 8, Invoices and Credit Memos.

Completing the Notes tab

1. Select the Notes tab.
2. Click **Add**. The Add a Note screen appears.

![Add Note for AlphaGraphics](image)

3. Enter the **Date** associated with the note.
4. Select a note **Type** from the drop-down list.
5. Enter a brief **Description** of the note. This description is displayed in the grid on the Notes tab to identify the note.
6. Enter the note **Title**. Select the **Author** from the drop-down list of user names.
7. Enter the desired note information and click **OK**.

➢ **Editing a vendor record**

If vendor information changes, you can edit the vendor record.

1. Using the search option, locate and open the desired vendor record.
2. Make the necessary changes.
3. Select **File**, **Save**.

➢ **Deleting a vendor record**

You can only delete a vendor record if no activity exists for the vendor.

1. From the vendor record you want to delete, select **File**, **Delete**. A confirmation message appears.
2. Click **Yes**.
Editing 1099 amounts

1. From the Vendor menu of an open vendor, select **1099 Amounts**. The 1099 Amounts screen for that record appears.

2. In the **Effective Date** column, click the calendar to enter a date.

3. Enter the 1099 **Box #**.

4. In the **1099 State Income** column, select “Include” to include state income.

5. Enter the **Amount**.

6. Click **OK**.

Adding a default

1. From Vendors, select **File, Defaults**. The Defaults screen appears.

2. From the **Defaults For** frame, select the desired record type.
3. Click **New**. The Default Information for a New Default Set screen appears.

![Default Information for a New Default Set](image)

4. Enter the name of the default set in the **Name** field.
5. Enter the **Default Value** for any available fields.
6. Click **OK**. Add additional default sets as needed.
7. When you finish adding default sets, click **Close** to close the Defaults screen.

➢ **Editing a default**
1. From the Defaults screen, select the desired record type.
2. Highlight the default set you want to edit.
3. Click **Edit**. The default information for the set appears.
4. Make the necessary changes and click **OK**.

➢ **Deleting a default**
1. From the Defaults screen, select the desired record type.
2. Highlight the default set you want to delete.
3. Click **Delete**. A dialog box appears asking if you want to delete the default set.
4. Click **Yes**.
Loading vendor defaults

Using vendor defaults makes data entry more efficient. Default sets are created from the File menu by clicking Defaults.

1. From the Vendor menu of an open vendor, select Load Defaults From.
   The Load Vendor Defaults from screen appears.

2. Use the drop-down list in the Default set field to select a previously created default set.

3. Click Load All Defaults Now.

4. Click OK.

Deleting an attribute

1. From the record for which you want to delete an attribute, select the Attributes tab.

2. Click the gray box to the left of the attribute entry in the attributes grid. This highlights the entire attribute row.

3. Press Delete. A dialog box appears asking if you want to delete the selected row.

4. Click Yes.

Editing a note

1. From the Notes tab, highlight the desired note.
2. Click **Edit**. The Note screen appears.

![Note screen](image)

3. Make the necessary changes.
4. Click **OK**.

➢ **Deleting a note**

1. From the Notes tab, highlight the desired note.
2. Click **Delete**. A dialog box appears and asks if you are sure you want to delete the note.
3. Click **Yes**.
Searching for a record

From the search screen, specify criteria to search for a record. All records matching the selected criteria are listed in the search results grid.

1. From Vendors, select File, Open. A search screen appears.

2. In the Find field, click the down arrow and select the desired record type.

3. Enter the appropriate filters, if any, such as Vendor Name, Vendor ID, Contact name, Phone number, Invoice No., Credit Memo No., PO No., Receipt No., City, State, Last modified by, and Last modified on, then click Find Now. The criteria fields change depending on the record type selected. All records matching the selected criteria are listed in the search results grid.

4. Once listed, highlight the desired record and click Open.

Defining search options

1. From Vendors, select File, Open. The search screen appears.

2. Click Options. The Miscellaneous Search Options screen appears.
3. Mark **Load the search results window automatically** if you want the search results windows to load automatically when you open the search screen.

4. Mark **Refresh the search results window automatically** if you want the search results window updated each time the criteria fields are changed.

5. Mark **Load the record automatically** if you want the program to open the record automatically when only one record is found.

6. Mark **Display the record in the search results window** if you want the program to display the record in the search results window when only one record is found.

7. Click **OK**.

### Opening a query

1. From **Vendors**, select **Query, Open as List** from the menu bar. The Available Queries screen appears.

2. Enter the type of query you are searching for in the **Query type** field.

3. Enter the **Format** field. Choose from **Dynamic**, **Static**, or **<All formats>**.

4. In the fields below the search results box, enter the search criteria.

5. Click **Find Now**. The program lists all queries matching the criteria in the search results window. If you need to change the scope of your search, click **New Search** to clear the criteria fields.

6. When the desired query appears in the search results window, highlight the query and click **Open**.
Chapter 7

Invoices and Credit Memos

In This Chapter

Working with Invoices ................................................................. 118
Accessing Vendor Records ......................................................... 118
Adding Invoices ................................................................. 118
  Invoice Tab ................................................................. 119
  GL Distribution Tab ............................................................. 120
  Payments/Credits Tab .......................................................... 122
  Attributes/Notes Tab ........................................................... 122
Editing Invoices .................................................................. 123
  Invoice Fields ................................................................. 123
Adjusting Invoices .............................................................. 124
Deleting an Invoice ............................................................... 125
Creating an Invoice Payment Schedule .................................. 126
Paying an Invoice ................................................................. 126

Working with Recurring Invoices .............................................. 128
Adding Recurring Invoices ........................................................ 128
  Recurring Info Tab ............................................................. 128
  GL Distribution Tab ............................................................. 130
  Attributes/Notes Tab ........................................................... 131
Generating a Recurring Invoice ................................................ 131
Generating Recurring Invoices ................................................. 132
Selecting Vendors ................................................................. 133

Working with Credit Memos ..................................................... 133
Adding Credit Memos ............................................................. 133
  Credit Memo Tab ............................................................... 134
  GL Distribution Tab ............................................................. 135
  Attributes/Notes Tab ........................................................... 136
Editing Credit Memos .............................................................. 136
Deleting Credit Memos ............................................................ 136
Applying a Credit Memo to an Invoice ...................................... 137
  Manually Applying a Credit Memo to an Invoice ..................... 137
  Automatically Applying a Credit Memo to an Invoice ............. 137
Editing the Application of a Credit Memo ................................. 138
Unapplying a Credit Memo ....................................................... 138
Invoices and credit memos are created through Vendors. You can create both regular and recurring invoices. You can add and access invoices, credit memos, and recurring invoices from the vendor record.

**Working with Invoices**

For each vendor, you can:

- add, edit, and delete invoices
- pay an invoice
- edit, change, and create a payment schedule on an invoice
- apply a credit memo to an invoice
- add recurring invoices
- generate recurring invoices

**Accessing Vendor Records**

You can access a vendor record and add an invoice from the Activity tab or select File, New.

- Accessing a vendor record
  1. From Vendors, select File, Open. The search screen appears.

  ![Vendor Search Screen](image)

  2. In the Find field, select Vendor from the drop-down list.
  3. Locate the desired vendor and click Open. If the Load the search results window automatically option is not marked on the Miscellaneous Search Options screen, you must click Find Now to display all vendors in the search results.

**Adding Invoices**

The following procedures walk you through the process of adding invoices with step-by-step instructions for completing information on each tab.
Completing the Invoice tab

1. From the vendor record, select the Activity tab. Click Add, Invoice.

2. The Vendor name field is accompanied by the Vendor ID label. The Vendor name defaults to the previously selected vendor.

3. Enter the Invoice # field, or leave it blank.

4. Mark the Hold payment checkbox if you want the program to prevent users from paying the invoice.

5. Click the calendar icon to select an Invoice date, or type in the desired date. You can also set up a default invoice date in preferences.

6. Enter a Description of the item being invoiced.

7. In the Remit to field, click the down arrow and select either the Primary Address or a secondary address. Click the magnifying glass icon to verify address information entered on the vendor. The address is read-only.

8. Type in the Amount due or click calculator icon to enter the amount. Click Paste to enter the total from the calculator into the Amount due field.

9. The Date Due is calculated automatically from the invoice date and the Due days field on the vendor record. The Date due days field is blank if you select Blank as a preference. You can manually enter the due date.

10. The Discount amount calculates automatically from the Discount% information on the vendor, or you can enter the amount. The Discount expires on date is calculated automatically from the invoice date using the Discount days field from the vendor record, if the information has been previously saved.
11. Enter the **Post status**. This field defaults based on your preferences. If you are entering invoices that you do not want to carry over to *General Ledger*, a historical invoice for example, select **Do Not Post**. Any invoice with the status **Not Yet Posted** impacts *General Ledger*. Once posted from *Accounts Payable*, the status of the invoice changes to **Posted**.

12. Enter payment information. Select the **Payment method** from the drop-down list. For partial payments, the method must be the same for all payments. For example, if the first payment is by check, then all payments must be by check. Mark the **Separate check for this invoice** checkbox, if you want an individual check to be printed for this invoice.

**GL Distribution Tab**

- **Completing the GL Distribution tab**

1. Select the GL Distribution tab.

2. Select the desired bank from the **Bank Account** drop-down list. Only banks established for use in *Accounts Payable* are listed.

3. In the **Account No.** column, you can type in the account number. If *General Ledger* is present you can perform an account search for the correct account number. This field cannot be changed after the invoice is posted.

4. If *General Ledger* is present, the Account Description displays once the account number is entered. If not present, this column is not available.

5. In the **Amount** column, enter the amount or percentage of invoice amount applied to the specified account.

6. In the **1099 Box** column, select from the available 1099 box numbers.

7. In the **1099 State Income** column, you can assign a state income designation that will total into Box 18.

8. In the **Project** column, you can access the Open screen and select a project.
9. In the **Transfer** column, select a transfer. The transfer allows you to track activity across funds.

10. In the **Comment** column, enter any notes you want associated with the specified account entry. This is a free-form, text field.

11. Click **Load Distribution** to pull distribution information from a **Table** or from the **Vendor** record. You can also **Distribute Evenly** or **Delete All** distributions. If you have the optional **Project, Grant, and Endowment Management** module, click **Projects** to distribute according to a predefined project distribution.

12. If desired, mark the checkbox to **Distribute by percentage** or to **Distribute discount** amounts. If you have the optional **Budget Management** module, click **Budget** to view the General Ledger Budget Verification screen.

13. Check your current spending against the **General Ledger** budget information. You can check **Account Budgets** or **Project Budgets**.

---

The amounts on the General Ledger Budget Verification screen only include posted General Ledger activity. Any activity not yet posted is not included when calculating current spending.
Payments/Credits Tab

➢ Completing the Payments/Credits tab

1. Select the Payments/Credits tab.

2. Highlight the desired transaction and click **Pay Now** to pay an invoice. You must save the record before paying.

3. Click **Schedule** to schedule payments for the invoice.

Attributes/Notes Tab

➢ Entering Attributes/Notes for an invoice

1. From the invoice select the Attributes/Notes tab.

2. To add an attribute, select the **Category**.
3. Enter the **Description** column. The **Description** column fills in automatically if you select an attribute from a table and enter the **Short Description**.

4. Enter the **Date** column.

5. Enter the **Comments** column.

6. To add notes, type the text into the **Notes** box.

7. Select **File, Save**.

## Editing Invoices

Use the following table and procedure for editing invoices.

### Invoice Fields

In the table below, invoices are either paid or unpaid and posted or unposted. Fields are either editable (E) or locked (L).

<table>
<thead>
<tr>
<th>Field</th>
<th>Unposted, Unpaid</th>
<th>Unposted, Paid</th>
<th>Posted, Unpaid</th>
<th>Posted, Paid</th>
</tr>
</thead>
<tbody>
<tr>
<td>Invoice #</td>
<td>E</td>
<td>E</td>
<td>E</td>
<td>E</td>
</tr>
<tr>
<td>Hold payment</td>
<td>E</td>
<td>L</td>
<td>E</td>
<td>L</td>
</tr>
<tr>
<td>PO #</td>
<td>E</td>
<td>L</td>
<td>E</td>
<td>L</td>
</tr>
<tr>
<td>Description</td>
<td>E</td>
<td>E</td>
<td>E</td>
<td>E</td>
</tr>
<tr>
<td>Remit to</td>
<td>E</td>
<td>L</td>
<td>E</td>
<td>L</td>
</tr>
<tr>
<td>Amount due</td>
<td>E</td>
<td>L</td>
<td>L</td>
<td>L</td>
</tr>
<tr>
<td>Date due</td>
<td>E</td>
<td>L</td>
<td>E</td>
<td>L</td>
</tr>
<tr>
<td>Discount %</td>
<td>E</td>
<td>L</td>
<td>L</td>
<td>L</td>
</tr>
<tr>
<td>Discount amount</td>
<td>E</td>
<td>L</td>
<td>L</td>
<td>L</td>
</tr>
<tr>
<td>Discount expires on</td>
<td>E</td>
<td>L</td>
<td>L</td>
<td>L</td>
</tr>
<tr>
<td>Post status</td>
<td>E</td>
<td>E</td>
<td>L</td>
<td>L</td>
</tr>
<tr>
<td>Post date</td>
<td>E</td>
<td>L</td>
<td>L</td>
<td>L</td>
</tr>
<tr>
<td>Payment method</td>
<td>E</td>
<td>L</td>
<td>E</td>
<td>L</td>
</tr>
<tr>
<td>Separate check</td>
<td>E</td>
<td>L</td>
<td>E</td>
<td>L</td>
</tr>
<tr>
<td>GL distributions</td>
<td>E</td>
<td>L</td>
<td>L</td>
<td>L</td>
</tr>
<tr>
<td>1099 box number</td>
<td>E</td>
<td>L</td>
<td>L</td>
<td>L</td>
</tr>
</tbody>
</table>

#### Editing an invoice

1. From **Vendors**, select **File, Open**. Using the search screen, locate the invoice you want to edit.

2. Make the desired changes to the invoice record.

3. Select **File, Save, Close** to close the record.
Adjusting Invoices

The following procedure walks you through the process of adjusting invoices.

- **Adjusting an invoice**
  1. From *Vendors*, open the invoice you want to adjust.
  2. From the open invoice, select *Invoice, Adjust*. The Add an adjustment screen appears.

3. In the **Adjustment date** field, enter the date you make the adjustment. The field defaults to the current date.

4. The **New transaction amount** field defaults from the invoice. You can edit this field only if the invoice has not been paid.

5. In the **Adjustment post date** field, select a post date.

6. In the **Reason** field, enter the reason for the adjustment.

7. In the **Notes** field, enter any notes you want associated with the adjustment.
8. Select the Adjusted GL Distribution tab. The following screen appears.

9. You can adjust the GL Distribution and add project information on this tab.

10. To view the previous GL distribution, select the Previous GL Distribution tab. The fields on this tab are for viewing only.

11. Click OK to return to the invoice record.

### Deleting an Invoice

Once an invoice is deleted it cannot be recovered. Before deleting, the program prompts you for confirmation of the action. If an invoice has payments, you cannot delete it without voiding all associated checks.

If a deleted invoice has credit memos that are fully applied to the deleted invoice, the program prompts you to unapply all credit before deleting the invoice, or to void all checks if invoice has been paid. If you do not delete a credit memo, or if a credit memo is partially unapplied or applied to other invoices, the program automatically unapplies the credit, instead of giving you the option to delete the credit memo.

#### Deleting an invoice

1. From the Activity tab of the selected vendor record, highlight the invoice you want to delete.

2. Click Delete. A confirmation message appears asking if you want to delete the record.

3. Click Yes.
Creating an Invoice Payment Schedule

You can create a payment schedule for an invoice that best accommodates your organization. The Payment Schedule screen is where you schedule payments for the invoice. You can set the frequency of the payments (e.g., annually, monthly, weekly, irregular), the number of payments, and then set specific payment times and amounts based on the frequency and number of payment selections.

Creating a payment schedule for an invoice

1. From the invoice, select the Payments/Credits tab. Click Schedule. The Edit Payment Schedule screen appears.

2. In the Frequency field, select the invoice payment frequency from the drop-down list. Choose from Annually, Monthly, Weekly, and Irregular. If you choose any frequency other than Irregular, the program automatically selects the payment dates and amounts according to the day, week and month information you enter in the fields under Frequency.

3. Enter the number of payments in the # Payments field.

4. Enter a Starting on date when payments begin. The schedule grid displays the date and amount of the scheduled payments. If you choose Irregular for the frequency, you can manually enter the dates and amounts or distribute the amounts equally among payments by clicking Distribute Evenly.

5. Click OK to save the payment schedule and return to the Payments/Credits tab.

Paying an Invoice

Any invoice not fully paid on or before the due date is considered past due.
Paying an invoice

1. From the selected invoice record, select the Payments/Credits tab. Click **Pay Now**. The Write a Check for Invoice screen appears.

![Write a Check for Invoice 24324](image)

2. Select Show data entry form to enter the information. **Check format**, **Computer Check no.**, **Date**, **Notes**, and **Cleared on** are the only editable fields. All other information is pulled from the invoice record.

![Write a Check for Invoice 24324](image)

3. Select the desired **Check format**.

4. Enter the **Computer Check no.**, **Date**, and any **Notes** you want to print on the check.

5. Click **Record Check** to place the check in the check register without printing.

6. Click **Print Check Now** to send the check to the printer.
Working with Recurring Invoices

A recurring invoice is a template from which regular invoices are created according to a schedule. A recurring invoice is never posted or included in any balance calculation.

Adding Recurring Invoices

You add recurring invoices in Vendors. You can also designate the frequency and number of recurrences to generate this invoice.

Recurring Info Tab

The Recurring Info tab displays basic invoice information for a recurring invoice such as amount due, discount information, payment information, and monthly maintenance fees.

Completing the Recurring Info tab

1. From the vendor record, select the Recurring tab. Click Add.

2. Enter the Invoice #. The invoice number can be up to 16 characters, with an additional four characters reserved for regular invoices generated from the recurring invoice. The regular invoices are numbered -001, -002, etc. If you leave this field blank, generated invoices will also have a blank Invoice #.

3. Mark the Inactive checkbox if you want the program to prevent you from generating invoices from this template.

4. Enter a Description of the invoice.
5. In the Remit to field, click the down arrow and select either the Primary Address or a secondary address. To verify address information, click the magnifying glass icon.

6. Type in the Amount due or click the calculator icon to enter the amount. Click Paste to enter the total from the calculator into the Amount due field.

7. Enter the number of days before the invoice is due in the Due days field.

8. The Discount amount automatically calculates from the Discount % information. Enter the number of days in which the invoice is eligible for a discount in the Discount days field.

9. Enter the payment information. Select the Payment method from the drop-down list. For partial payments, the method must be the same for all payments.

10. Mark the Separate check for each invoice checkbox if you want to print a separate check for each generated invoice.

11. Enter the Default post status for each generated invoice. Select from Not Yet Posted or Do Not Post. Invoices with the status Do Not Post reflect only in your Accounts Payable activity. Any invoice with the status Not Yet Posted posts to the General Ledger based on the selected post date.

12. Enter the Recurring Invoice Parameters field. Select from an Unlimited number of invoices or Fixed. If you select Fixed, enter the number of invoices you want to generate.

13. To change the frequency, click Change Frequency.

14. Select a Frequency from the drop-down list. Your choices are Annually, Monthly, and Weekly.

15. Select the day and month or, if generating monthly or weekly, the number of months and weeks.

16. Enter the Starting on date, and the program automatically generates the Next invoice date. The program also tracks the number of payments and provides you with the date and status of the payments in the grid.

17. Once the frequency information is entered, click OK to return to the Recurring Info tab.
GL Distribution Tab

- Completing the GL Distribution tab

1. Select the GL Distribution tab.

2. In the Account No. column, you can type in the account number. If General Ledger is present you can perform an account search for the correct account number. This field cannot be changed after the invoice is posted.

3. If General Ledger is present, the Account Description displays once the account number is entered. If not present, this column is not available.

4. In the Amount column, enter the amount or percentage of invoice amount applied to the specified account.

5. In the 1099 Box column, select from the available 1099 box numbers.

6. In the 1099 State Income column, you can assign a state income designation that will total into Box 18.

7. In the Project column, you can access the Open screen and select a project.

8. In the Transfer column, select a transfer. The transfer allows you to track activity across funds.

9. In the Comment column, enter any notes you want associated with the specified account entry. This is a free-form, text field.

10. You can Load Distribution information from an existing distribution Table or from the Vendor record. You can also Distribute Evenly or Delete All distributions. If you have the optional Project, Grant, and Endowment Management module, you can distribute by Projects.

11. Mark the checkbox if you want to Distribute by percentage and to Distribute discount amounts.
Attributes/Notes Tab

- Completing the Attributes/Notes tab
  1. Select the Attributes/Notes tab.
  2. Enter any attributes or notes you want associated with the recurring invoice.
  3. Select File, Save to save the recurring invoice.

Generating a Recurring Invoice

When generating from the Recurring tab of a vendor you are generating only for a specific recurring invoice.
Generating Recurring Invoices

Generating a recurring invoice

1. Select the Invoice Schedule tab of the desired recurring invoice record.

2. Click Generate. The Generate Invoices screen appears.

3. In the Invoices to Generate frame, specify if you want to generate all invoices through a specified date, generate a specified number of invoices, or generate all invoices by selecting the desired option.

4. The Post status defaults to Not Yet Posted, or you can select Do Not Post if you do not want the activity to affect the general ledger.

5. Select a Post date. The post date determines which period the activity posts in General Ledger. You can use the invoice date, due date, or specify a date.

6. Click OK.
Selecting Vendors

You can choose to generate invoices for all, selected, or one vendor when generating recurring invoices.

Selecting vendors for recurring invoices

1. From Vendors, select File, Generate Recurring Invoices. The Generate Recurring Invoices screen appears.

2. Click Generate for to select the vendors for which you are generating invoices. Access the drop-down list and select from All Vendors, Selected Vendors, or One Vendor.

3. You can Generate invoices due on or before a specified date. Enter the cut-off date, or click the calendar icon to select a date.

4. Select a Post status and Post date. The post status determines if the activity posts to General Ledger. Select from Not Yet Posted or Do Not Post.

5. The post date determines which period in General Ledger the activity posts. Select Use the regular invoice date or specify a date.

6. Mark the checkbox if you want to View results before creating invoices.

7. Mark the checkbox if you want to Print control report.

8. Click OK.

Working with Credit Memos

For each vendor, you can:

- add, edit, and delete credit memos
- apply a credit memo to an invoice
- unapply a credit memo
- auto apply a credit memo
- edit the application of a credit memo

Adding Credit Memos

You create credit memos in Vendors.
Credit Memo Tab

The Credit Memo tab displays basic credit memo information including number, date, description, post information, and a display of invoices paid with this credit memo.

- Completing the Credit Memo tab
  1. From the selected vendor record, select the Activity tab.
  2. Click Add and select Credit Memo from the drop-down list. The Credit Memo screen appears.
  3. Enter the Credit memo # field.
  4. Enter the Credit date field. The Credit date determines the date the credit memo is added.
  5. Enter the amount of credit in the Credit amount field.
  6. Enter the Post status and Post date fields. The Post status determines if the activity posts to General Ledger. Select from Not Posted Yet or Do Not Post. The Post date determines the period to which the activity posts in General Ledger.
GL Distribution Tab

- Completing the GL Distribution tab
  1. Select the GL Distribution tab.

2. Select the Bank account from the drop-down list.
3. In the Account No. column, you can type in the account number. If General Ledger is present you can perform an account search for the correct account number. This field cannot be changed after the credit memo is posted.
4. If General Ledger is present, the Account Description displays once the account number is entered. If not present, this column is not available.
5. In the Amount column, enter the amount or percentage of invoice amount applied to the specified account.
6. In the 1099 Box column, select from the available 1099 box numbers.
7. In the 1099 State Income column, you can assign a state income designation that will total into Box 18.
8. In the Project column, you can access the Open screen and select a project.
9. In the Transfer column, select a transfer. The transfer allows you to track activity across funds.
10. In the Comment column, enter any notes you want associated with the specified account entry. This is a free-form, text field.
11. Click Load Distribution to select a distribution from an existing table or from the vendor record. You can also Distribute Evenly or Delete All distributions.
12. If you have the optional Project, Grant, and Endowment Management module, you can distribute by Projects.
13. Mark the checkbox if you want to Distribute by percentage.

Attributes/Notes Tab

- Completing the Attributes/Notes tab
  1. Select the Attributes/Notes tab.

  2. Enter any attributes or notes you want associated with the credit memo.

  3. Select File, Save to save the credit memo.

Editing Credit Memos

To edit a credit memo, use the following procedure.

- Editing a credit memo
  1. From the selected vendor record, select the Activity tab and highlight the credit memo you want to edit.

  2. Click Edit. The Credit Memo screen appears.

  3. Make the desired changes.

  4. Select File, Save to save your changes.

Deleting Credit Memos

The program always asks for confirmation before deleting a credit memo. Once a credit memo is deleted, it cannot be recovered. Unposted, unapplied credit memos can be deleted at any time.
Deleting a credit memo

1. From the selected vendor record, select the Activity tab and highlight the desired credit memo.
2. Click **Delete**. A confirmation message appears asking if you want to delete the credit memo.
3. Click **Yes** to delete.

## Applying a Credit Memo to an Invoice

To apply a credit memo to an invoice manually or automatically, use one of the following procedures.

### Manually Applying a Credit Memo to an Invoice

1. From the Credit Memo tab of the selected Credit Memo, click **Apply**. The **Apply Credit Memo** screen appears.

   ![Apply Credit Memo Screen]

   These invoices have not been fully paid. You can apply this credit memo to one or more of these invoices.

<table>
<thead>
<tr>
<th>Date</th>
<th>Invoice</th>
<th>Description</th>
<th>Amount</th>
<th>Balance</th>
<th>Amount to Apply</th>
</tr>
</thead>
<tbody>
<tr>
<td>08/05/57</td>
<td>839898</td>
<td>Paper</td>
<td>$54.00</td>
<td>$54.00</td>
<td></td>
</tr>
<tr>
<td>09/20/57</td>
<td>791</td>
<td>Mockups</td>
<td>$968.00</td>
<td>$968.00</td>
<td></td>
</tr>
<tr>
<td>09/21/57</td>
<td>679887</td>
<td>Graphics</td>
<td>$584.00</td>
<td>$584.00</td>
<td></td>
</tr>
<tr>
<td>10/02/57</td>
<td>839588</td>
<td>Paper copies</td>
<td>$584.00</td>
<td>$584.00</td>
<td></td>
</tr>
<tr>
<td>10/03/57</td>
<td>102384</td>
<td>Photo copies</td>
<td>$765.00</td>
<td>$765.00</td>
<td></td>
</tr>
<tr>
<td>10/14/57</td>
<td>10239</td>
<td>Sample 1</td>
<td>$565.00</td>
<td>$565.00</td>
<td></td>
</tr>
<tr>
<td>10/15/57</td>
<td>10239</td>
<td>Sample 2</td>
<td>$765.00</td>
<td>$765.00</td>
<td></td>
</tr>
</tbody>
</table>

2. All unpaid invoices for the vendor are listed from the oldest to the most recent in ascending order. The listing includes the original invoice amount and the remaining balance. Only the **Amount to Apply** column is editable.

3. Enter the amount you want to apply for each invoice you want to pay. If you click **Auto Apply**, the amounts are entered automatically beginning with the oldest invoice and continuing until all invoices are paid or the credit memo is fully applied.

4. Click **OK** to save the information and return to the credit memo record.

### Automatically Applying a Credit Memo to an Invoice

The **Auto Apply** button applies the credit memo until no credit remains or the entire balance of the invoice is paid. This button is only available when an unapplied credit exists and there are invoices not fully paid.
Auto applying a credit memo to an invoice

1. From the Credit Memo tab of the selected credit memo, click Auto Apply. The program applies the credit memo to the invoices, starting with the oldest, until all invoices are paid or the Credit left equals zero.
2. Close the credit memo record to save the information.

Editing the Application of a Credit Memo

Once the applied portion of a credit memo has been listed on a check for the invoice, the credit memo application cannot be edited, unapplied, or deleted without voiding the related check.

Editing the application of a credit memo

1. Open the credit memo.
2. From the Credit Memo tab, in the Invoices Paid with this Credit Memo frame, highlight the invoice and click Edit. The following screen appears.

3. The only editable field on the above screen is New amount to apply. All other information is pulled from the invoice and credit memo records. Enter the new amount.
4. Click OK to save.

Unapplying a Credit Memo

Once the applied portion of a credit memo has been listed on a check for an invoice, the credit memo application cannot be edited, unapplied, or deleted without voiding the related check.

Unapplying a credit memo

1. From the Credit Memo tab of the credit memo, highlight the invoice paid line item you want to unapply.
2. Click Unapply. The program automatically removes the credit memo application, and the invoice is removed from the Invoices Paid with this Credit Memo grid.
Bank Accounts

In This Chapter

Bank Account Preferences ................................................. 140
Managing Bank Accounts .................................................. 143
**Bank Accounts** module is where you add, edit, delete bank account information, view the bank register, and reconcile. You must have the optional Bank Reconciliation module to reconcile.

**Bank Accounts** is also the central location for printing checks, writing direct disbursements, recording manual checks, printing the bank register, clearing checks, and voiding checks. These procedures are discussed in the next chapter.

You can define parameters for electronic funds transfers, if the optional Electronic Funds Transfer module is available, and establish interfund transfer entries to use when posting to **General Ledger**.

Because **Bank Accounts** is a shared Blackbaud component, you can use it to store bank account information for all of your integrated Blackbaud programs.

From **Bank Accounts**, you can:
- view and edit account information
- add an account
- delete an account
- make an account inactive
- set preferences
- add a note
- edit a note
- delete a note
- allow electronic funds transfers and set up electronic funds transfer files for an account (see **Electronic Funds Transfer User’s Guide**)

**Accessing Bank Accounts**

1. From the Start menu, select **Programs, Blackbaud Accounts Payable**.
2. Select **Bank Accounts** from the **Accounts Payable** modules.

---

**Bank Account Preferences**

You can define a variety of user preferences to customize your screens. Enter or edit the desired preference information on the preference tabs.
Setting preferences

1. From Bank Accounts, click Preferences on the toolbar at the top of the Bank Register screen. The Preferences screen appears.

2. Designate how the bank register displays by selecting check and background colors. To change the color, click in the checkbox. Select a color from the menu, and click OK.

3. Specify the default check format. Select from Show check form and Show "data entry" form.

4. Enter the bank register print options. Select from Portrait or Landscape.

5. Mark the Show General Ledger distributions checkbox if you want distributions to appear when printing the bank register.

6. Mark the Show vertical lines checkbox if you want vertical lines to appear in the bank register grid.

7. Mark the Show horizontal lines checkbox if you want horizontal lines to appear in the bank register grid.

8. Mark the Show clear date dialog checkbox if you want a dialog to appear when you change the status of a check to cleared.
9. Select the Check Position tab.

10. Enter the **Select the printer to adjust** field. Use the drop-down list to select from a list of available printers.

11. If required, you can adjust the top margin to correct the alignment for preprinted forms on the Check Position Tab. To adjust the margin, click **Up** or **Down** and then enter the **Units to Adjust**. A unit is approximately equal to 1/100th of an inch or 0.254 millimeters.

12. If you have **General Ledger**, select the General Ledger tab.

13. Enter the **Bank Accounts source** field. Use the drop-down list to select from a list of sources.

14. Enter the **Reference Field Name** and **Length** columns. Click **Fields** if you need to define additional Journal fields. Click **Restore Defaults** to reset the original fields.

15. Click **OK**.
Establishing the bank register legend

You can establish the bank register legend from the legend screen. Use colors to differentiate between check formats and the status of payments.

1. From Bank Accounts, click **Legend** on the toolbar at the top of **Bank Accounts** main screen. The Bank Register Legend screen appears.

2. If desired, change the colors for the different record type and statuses. To change a color, click the desired box. The Color palette appears. Select the desired color and click **OK**.

3. If you want to return all colors to the default setting, click **Reset to System Defaults**.

4. Click **OK**.

Managing Bank Accounts

**Bank Accounts** module is where you add, edit, delete bank account information, view the bank register, and reconcile. (You must have the optional **Bank Reconciliation** module to reconcile.)

Adding an account


2. Enter a unique, alphanumeric identification in the **Account ID** field.

3. Enter a **Description** of the bank account and the **Account type**.

4. In the **Account no.** field, enter the bank assigned account number.

5. In the **Routing no.** field, enter a numeric routing number for direct deposits and electronic funds transfers. You need to enter only the first eight digits provided by your bank. The program creates the ninth digit.
6. Enter the Bank name. All other fields on the Bank Account tab are optional.

7. Select the Blackbaud Systems tab.

8. A list of all currently installed Blackbaud products for which bank accounts are applicable appears in the Use this account with these Blackbaud systems box. To make the current account available to a product, mark the corresponding checkbox. As you mark the checkboxes, the right side of the screen changes to display the options for the corresponding program.

9. Enter the desired information for the Accounts Payable Options and the options for any other Blackbaud product for which this account is available. If you have purchased the optional Electronic Funds Transfer module, you can click Electronic Funds Transfer to access the Modify EFT Parameters for screen.

10. If you are using Blackbaud’s General Ledger, enter the General Ledger Account Numbers frame. Select either Single set of accounts or Multiple sets of accounts (one set per fund), then enter the Cash, AP Summary, Discount, and Encumbrance account numbers.

If allowing bank drafts, enter the beginning transaction number. If left blank, the series starts at one. Bank draft transactions always use a numbering system independent of checks and electronic funds transfer transactions.
11. Select the Adjustment Types tab.

12. Enter the Adjustment Type, Default Debit Acct, Default Credit Acct, and Default Post Status fields.

13. To have the program automatically create the transactions required to move money between funds in General Ledger, select the Interfund Entries tab.
The function of this tab replaces the Due To/Due From and Transfer function of the Accounts Payable for DOS program. Typically, the descriptions of the General Ledger accounts involved in these transaction include the words Transfer or Due to/Due from. However, it is best to consult your auditor for this decision.

14. Enter the desired account information in the available columns. You cannot edit the Account Description columns.

15. Select the Notes tab.

16. Enter any miscellaneous information you want associated with this bank account. You can refer to the Adding a note procedure for assistance.

17. Click OK.

Viewing/editing account information

1. From Bank Accounts, select File, Bank Information.
2. The bank account record appears. Select the tab(s) you want to view or edit. Make the necessary changes.
3. Click OK to close the record. The changes save automatically.

Deleting an account

You can only delete bank accounts that are not in use. If the account is in use, you receive a message stating the bank account cannot be deleted.

1. From Bank Accounts, select Bank Account List from the File menu. Highlight the bank account you want to delete.
2. Click Delete Bank Acct. A confirmation message appears.
3. Click Yes to delete the bank account record.
Making an account inactive

Marking a bank account inactive prevents the use of the account for future transactions.
1. From Bank Accounts, select File, Bank Information.
2. On the Bank Account tab, mark the Account is inactive checkbox.
3. Click OK.

Adding a note

From the Notes tab you can add, edit, or delete notes from the Bank Account record. You can also preview or print.
1. From Bank Accounts, select File, Bank Information.
2. Select the Notes tab.
3. Click New Note.

![Add Note dialog box]

4. Enter the Date, Type, Description, Title, and Author fields.

5. Enter the note you want associated with this bank account.

**Editing a note**

1. From Bank Accounts, select File, Bank Information.
2. Select the Notes tab.
3. Highlight the desired record and double click.
4. The Note record opens. Make the desired changes to the record.
5. Click Save to save changes and close the record.

**Deleting a note**

1. From Bank Accounts, select File, Bank Information.
2. Select the Notes tab.
3. Highlight the desired record.
4. Click Delete. A confirmation message appears asking if you are sure you want to delete the record.
5. Click Yes to delete, or No to maintain the record and return to the Notes tab.

**Print previewing a bank account profile**

Print preview a bank account profile to view the document before printing.

1. From Bank Accounts, select File, Print Preview.
2. The Bank Account Profile appears in a preview screen.
3. Click the printer on the toolbar to print the report after viewing it on the screen.
Checks

In This Chapter

- Printing Checks .................................................. 151
- Managing Direct Disbursements ............................... 158
- Recording Manual Checks ...................................... 161
- Recording Bank Drafts .......................................... 162
- Clearing Checks .................................................. 163
- Renumbering Checks ............................................. 164
- Voiding Checks ................................................... 164
- Purging Checks .................................................... 165
- Viewing Transaction Details .................................... 166
Bank Accounts is the central location for printing checks, writing direct disbursements, recording manual checks, printing the bank register, clearing checks, and voiding checks.

In Bank Accounts, you can print checks for several invoices at one time. When printing checks, you must first select the bank account for which you want to print checks. You can print all the checks for invoices associated with that bank, or elect to print based upon a series of filters. For example, you can select invoices for payment based on a due date or a discount expiration date. You can also print checks for one vendor record or all vendor records.

Additionally, you can base the selection on a query that you have created or on a series of attributes.

Once you choose the invoices you want to print, they are displayed on the Invoices tab. If desired, you can deselect one or more invoices by double clicking the selected invoices.

Direct Disbursement checks are recorded and printed from Bank Accounts. Direct Disbursements are not made to existing vendors but rather to an individual or company that you do not want to maintain in the Accounts Payable vendor database.

Several other activities can take place within Bank Accounts. It is here that checks are voided and purged. You can have the program perform a budget verification while in Bank Accounts by displaying a screen that allows you to check your current spending against General Ledger budget information by account number.

All of Blackbaud’s financial products share this module. If you have configured a particular bank account for use with multiple systems, the program prompts you to select from a drop-down list the module for which you want to print checks. In Accounts Payable, you can pay invoices by printing checks or by electronic funds transfers. From Bank Accounts you can also export the bank register to Excel.

From Bank Accounts, you can:

- record a manual check
- print checks
- write a direct disbursement check
- test check alignment
- run the pre-check report
- create a prenote authorization file (Only if you have the optional Electronic Funds Transfer module)
- record bank drafts
- clear checks
- renumber checks
- view transaction details
- void selected checks
- void an unwritten check
- purge voided checks

Accessing Bank Accounts screen

Bank Accounts is the central location for printing checks, writing direct disbursements, recording manual checks, printing the bank register, clearing checks, and voiding checks.

1. From the Start menu, select Programs, Blackbaud Accounts Payable.
2. Select Bank Accounts from the Accounts Payable modules.

Printing Checks

You can print checks for all records, selected records, or one record. The Print Checks button displays a pre-print verification message.

- Completing the Criteria tab

1. From Bank Accounts, select the Bank Account from which you want to print checks.

2. Select File, Checks, Print Checks. The Print Checks screen appears with the Criteria tab selected.
3. Select the records to include in the check run. The program defaults to include All records. If required, click Include to narrow the records in the print run. You can limit the check run to Selected Records, One Record, or Direct Disbursements Only.

4. Select either Check or Electronic Funds Transfer in the Approve Invoices to be Paid by frame. If you have the optional Electronic Funds Transfer module, you can opt to pay the invoices by electronic funds transfer.

5. Enter the Approve invoices with due dates on or before field with the desired date.

6. Enter the date you want to appear on the check in the Print check date as field.

7. Enter the date you want to begin taking discounts in the Take discounts starting on field.

8. If desired, mark the Include invoices with discounts expiration dates on or before checkbox and enter a date.

9. Select Check format, Invoice format, or Check and Invoice format from the Pre-Check Report Format frame.

10. If paying by check, you can enter an electronic signature in the Print signature field. Use the drop-down list to select a signature.

➤ Completing the Attributes tab

1. Select the Attributes tab.

2. Enter any attributes you want to use as filters to narrow the group of invoices included in the check run.

3. Enter any attributes you want to add, update, or delete during the check run.
Completing the Invoices tab

1. Select the Invoices tab.

2. Indicate which invoices to pay on the invoices grid. You can **Approve All**, **Unapprove All**, or **Partially Pay** the invoices.

3. You can also view **Credit Memos** associated with these invoices. To individually select or deselect an invoice click the **Pay** checkbox. A check mark in the box indicates the invoice is selected for payment.

Completing the Direct Disbursement tab

1. Select the Direct Disbursements tab.
The Direct Disbursements tab only appears if unprinted direct disbursements exist.

2. Mark the Pay checkbox to print the direct disbursement.

- Completing the Format tab

1. Select the Format tab.

2. Enter the Starting check # and Check Format.

3. Mark the Show application of each credit memo checkbox if you want the application of each credit memo to print on the check stub.

4. Indicate if you want a note to print on the checks included in the run by marking the checkbox. Once marked, select the desired vendor field or enter the note you want to print.

5. Determine the order in which the check prints by marking the desired sort parameter options.

6. If you have the optional Electronic Funds Transfer module and marked the Electronic Funds Transfer checkbox on the Criteria tab, enter the desired parameters. If you do not have the optional Electronic Funds Transfer module, this frame is disabled.
Completing the Check Format tab

1. Select the Check Format tab.

2. Enter the **Transit ABA number** field.

3. If desired, mark the **Include an address** checkbox and select an address from the drop-down list.

4. If desired, mark the **Include a logo on the check stub from file** checkbox and click the browse icon to locate the logo file.

5. If desired, mark the **Include a logo on the check from file** checkbox and click the browse icon to locate the logo file.

6. Click **Custom MICR Line** to customize the MICR number on all blank paper check formats.
Completing the Print Format tab

1. Select the Print Format tab.

2. Enter the Print run format field. Use the drop-down list to select a format.

3. Click Print Checks to continue.

4. The Verify Check Information screen appears.

5. Examine this information for accuracy.

6. Click Print to send the check run to the printer.
7. Once the checks have printed, the post-print verification screen appears.

8. Examine your printed checks for accuracy and ensure all necessary checks were printed. If the checks did not print successfully, select the **Checks did not print successfully** option and enter the check numbers which need to be voided.

9. Click **OK**.

### Testing check alignment

Test check alignment to ensure checks are properly aligned in the printer.

1. From the Print Checks screen in *Bank Accounts*, click **Test Alignment**.
   
The Testing Form Alignment screen appears.

2. You can print to paper using sample data to test the alignment or use a check. If you use a check, the program defaults to the starting check number on the Format tab. You can mark the **Increment starting check number** to checkbox to have the program automatically update the starting check number.

3. Click **Print** to print the test for alignment.
Running the Pre-Check Report

When you run the Pre-Check Report you can preview or print a check report prior to printing the checks.

1. From the Print Checks screen, click Pre-Check Report. The report processes and appears on the Preview screen.

2. From the Preview screen you can review the report for accuracy and ensure the checks listed are those you want to print.

3. Click the printer on the toolbar to print the report.

Managing Direct Disbursements

Direct disbursement checks are written only for the bank account whose bank register is currently displayed. Although you cannot edit bank account information on this form, all other fields are editable.
Writing a direct disbursement check

1. From Bank Accounts, select File, Checks, Write Direct Disbursement Checks. The Add a Direct Disbursement screen appears.

2. Select the Show data entry form option to enter the Payee, Amount, and Check Format fields. If you select a Blank paper option in the Check Format field, the Blank Paper Check Defaults tab appears. The other fields are optional. You can also enter this information from the Show Check screen.
3. Select the GL Distribution tab.

4. Enter the **Account No.**, **Amount**, and **Project** fields. The **Account Description** and **Project Description** field information defaults. If necessary use the **Projects** and **Load Distribution** buttons to help you locate the desired information.

5. Click **Budget** if you need to access the General Ledger Budget Verification screen.

6. Enter the **Transfer** column if you are using interfund transfers. Use the drop-down list to select a transfer.

7. Enter any comments in the **Comments** column. You are limited to 13 characters.

8. Select Transaction Notes tab.

9. Enter any notes you want associated with this transaction.
10. If you selected a Blank Paper option for the Check format, select the Blank Paper Check Defaults tab.

11. Enter the *Transit ABA number* field.

12. If desired, mark the *Include an address* checkbox and select an address from the drop-down list.

13. If desired, mark the *Include a logo on the check stub from file* checkbox and click the browse icon to locate the logo file.

14. If desired, mark the *Include a logo on the check from file* checkbox and click the browse icon to locate the logo file.

15. Click *Custom MICR Line* to customize the MICR number on all blank paper check formats.

16. Click *Record Check* to have the disbursement recorded, *Print Check Now* to send the check to the printer immediately, or *Print Check Later* to wait and have the option of printing the check later.

### Recording Manual Checks

The Manual Check form is available through *Bank Accounts* and through the Invoice menu of *Vendors*. Use manual checks to record payments you have already made.
➢ Recording a manual check


2. Click the binocular icon to search for the correct vendor, or type it in the field.

3. Enter an invoice due date. The *Invoice due date* field acts as a filter for the list of invoices. Discounts are based on the check date.

4. The *Check #* defaults. Verify that it is an unused regular check in the current bank account.

5. Enter the amount in the *Amount* field.

6. Select a *Post status* and date.

7. Enter the date the check was written in the *Check Date* field.

8. To clear the check, mark the *Cleared on* checkbox and enter the date the check cleared. The post information defaults to *Not Yet Posted* and the current date.

9. Mark the *Pay* checkbox to indicate the invoice(s) is to be paid with this manual check. You can *Approve All, Unapprove All, Partially Pay*, and apply *Credit Memos*.

10. Once you enter the correct information, click *OK* to record the manual check.

**Recording Bank Drafts**

If you do not record bank drafts automatically, you can use the Record Bank Drafts screen to do so for bank accounts that allow bank draft transactions.
Recording bank drafts

1. From *Bank Accounts*, select the desired bank account.
2. Select **File, Check, Record Bank Drafts**. The Record Bank Drafts screen appears.

   ![Record Bank Drafts for AP And SB Bank](image)

3. Click **Include** to select which records are recorded. You can include all records or limit the process to one record or only those records in a specified query.
4. Enter the **Starting check number**. This number is the starting check number in the bank draft run. This field defaults from the bank record, but you can edit this screen at any time.
5. Enter a date in the **Record bank draft payments for invoices due on or before** field. This date acts as a cutoff date in determining which invoices are included in the bank draft run. Only those invoices due on or before the specified date are included.
6. If desired, mark the checkbox to view the results on screen before recording payments or printing a control report. If you opt to view the results on screen, a list of invoices appears on screen.
7. From the Record Bank Drafts for screen, select or deselect the invoices you want to record bank drafts for and click **Create Now**.
8. Click **OK**.

Clearing Checks

Clearing checks

1. From *Bank Accounts*, select the desired bank account.
2. Highlight the check or checks you want to clear.
3. Select **File, Change Status to, Cleared**. The Clear Check screen appears.
4. Enter the desired **Clear date**.
5. If you want to use this date when clearing other checks, mark the **Use this date when clearing other checks** checkbox.
6. Click **OK**.
Renumbering Checks

Renumber checks to modify the numbering system and starting number for checks, electronic funds transfers, and bank drafts.

- **Renumbering checks**
  1. From *Bank Accounts*, select **File, Renumber Checks** from the menu. The Renumber Checks screen appears.

  ![Renumber Checks Screen]

  2. Select the desired transaction type and enter the start, end and new starting numbers.

  3. Click **OK**.

Voiding Checks

You can void selected written or unwritten checks, electronic funds transfers or bank drafts.

- **Voiding a selected check**
  1. From *Bank Accounts*, select the desired bank account.

  2. Highlight the check or checks you want to void.

  3. Select **File, Void, Selected Checks** from the menu. The Void Selected Checks screen appears.

  ![Void Selected Checks Screen]
4. Mark the **Delete** checkbox to delete the invoice or invoices associated with the voided check.

5. Click **Void** to void the displayed check, or **Void All** to void all of the highlighted checks. **Skip** maintains the displayed check and moves to the next highlighted check.

#### Voiding an unwritten check

1. From *Bank Accounts*, select the desired bank account.

2. Selected **File, Void, Unwritten Checks**. The Void Unwritten Check screen appears.

3. Click the calendar to select a date.

4. Enter the **Transaction type** field. Use the drop-down list to select **Checks**, **Electronic Funds Transfers**, or **Bank Drafts**.

5. If voiding one check, enter the same check number in the **Start #** and **End #** fields.

6. Click **OK**. A confirmation message appears that asks if you are sure you want to void the specified unwritten checks.

7. Click **Yes** to void.

### Purging Checks

We strongly recommend that you perform a backup of your database before purging any voided checks from the system. You can only recover purged checks by restoring them from a backup.
Purging voided checks

1. From Bank Accounts, select Utilities, Purge Voided Checks. The Purge Voided Checks screen appears.

2. Use the drop-down list to select the transaction type.

3. Enter the Starting check # and Ending check # fields. If you are purging one voided check, enter the check number in both the starting and ending check number fields.

4. Click OK. You receive a confirmation message asking if you are sure you want to purge the specified voided check.

5. Click Yes to purge.

Viewing Transaction Details

You can view transaction details by highlighting the transaction you want to view and selecting View, Transaction Details.

Viewing transaction details

1. From Bank Accounts, select the desired bank account.

2. Locate the transaction you want to view.

3. Right click the transaction and select Transaction Details from the shortcut menu.
Query and Export

In This Chapter

Query Types ................................................................. 168
Understanding Query Criteria Operators ................................. 168
Criteria Operators ............................................................ 169
Combining Operators ....................................................... 170
Using Wildcard Characters in Query .................................... 170
Merging Operators ........................................................... 170
Accessing Query and Export ............................................... 171
Establishing General Query Preferences .............................. 171
Refreshing a Static Query .................................................. 191
Exporting Queries ........................................................... 191
Favorites ................................................................. 192
Query and Export is where you establish a group of records to use when running reports, printing checks, or sending letters. This group of records is called a query. To create a query you establish criteria, and the program then locates specific records based on the criteria you defined.

You can use queries throughout Accounts Payable to limit the scope of a function to selected records.

Queries give you a quick view of your data by selecting records that meet certain conditions. You define the criteria that the records must meet for selection, and the program identifies selected records and produces a set of records that you can use for other functions (e.g., Reports, Mail). When you define a query, you are designing a set of filters or requirements that a record must meet in order to be selected. Each filter is defined by selecting a field and defining a condition the record must meet.

There are seven query types from which to choose: Vendor, Invoice, Credit Memo, Recurring Invoice, Purchase Order, Receipt, and Bank. Selecting a specific type limits the record type included in the query. For example, only vendor records are included in a vendor query.

You can also export the information on the Results tab to a word processing program, spreadsheet program, or another type of program.

From Query and Export, you can:

- establish preferences for a selected query
- add a new query
- edit an existing query
- view/print query properties
- edit query options
- add a query to list of favorites
- delete a query
- print a query’s results
- preview the query list
- print the query list
- refresh a static query
- export
- run a query
- merge two queries

Query Types

Selecting a specific record type limits the number of records in the query. For example, only vendor records are included in a Vendor query.

There are seven query types from which to choose: Vendor, Invoice, Credit Memo, Recurring Invoice, Purchase Order, Receipt, and Bank.

Understanding Query Criteria Operators

When you define a query, you are establishing a set of filters or requirements that a record must meet for selection. You define each filter by selecting a field and defining a condition the record must meet.

Accounts Payable uses criteria operators to more precisely define conditions, allowing you to narrow the search to only the records of interest. There are several criteria operators from which to choose, but not all criteria operators are appropriate for every field.
Criteria Operators

**Equals:** The Equals operator selects records for the query which have the exact entry you define. For example, if you choose City Equals Charleston, only records with the exact city entry “Charleston” are selected.

**Does Not Equal:** The Does Not Equal operator selects only the records that have entries that do not match the defined criteria. For example, if you choose City Does Not Equal Charleston, the program selects every record that does not have “Charleston” entered as the city.

**Greater Than:** The Greater Than operator indicates that records selected must have a value greater than the one you define. For example, if you select Invoice Amount Greater Than $50, only invoice records with a total amount of $50.01 and higher are selected. An amount of $50 is not included.

**Greater Than or Equal To:** The Greater Than or Equal To operator limits the records selected to those that have a value greater than or equal to the one you define. For example, if you select Invoice Amount Greater Than or Equal To $50, only invoice records with a total amount of $50 and higher are selected. This operator includes the value you select when extracting records.

**Less Than:** The Less Than operator limits records selected to ones that have an entry less than the value you define. For example, if you select Invoice Amount Less Than $50, only invoice records with a total amount of $49.99 and lower are selected. An amount of $50 is not included.

**Less Than or Equal To:** The Less Than or Equal To operator selects records which have an entry either equal to or less than the value you define. For example, if you select Invoice Amount Less Than or Equal to $50, only invoice records with a total amount of $50 and lower are selected.

**One Of:** The One Of operator selects records which have one of the entries you define. The One Of operator acts as an Or between the entries you select. For example, if you select City is One Of Charleston, Summerville, or Goose Creek, records selected must have one of the three cities to be chosen.

**Not One Of:** The Not One Of operator selects records which do not have one of the entries you define. For example, if you select City is Not One Of Charleston, Summerville, or Goose Creek, records selected can not have one of the entries you define.

**Between:** The Between operator allows you to select a range of entries that records could have in order to be selected. For example, if you select Amount is Between $50 and $100, records of invoices that fall within this amount range are selected.

**Not Between:** The Not Between operator allows you to select a range of entries that records must not have in order to be included in the query. For example, if you select Amount is Not Between $50 and $100, records of invoices who fall within this amount range are not selected.

**Begins With:** The Begins With operator selects records which have an entry that begins with the value you define. For example, if you choose Vendor Name Begins With Bel, vendors whose Vendor Name has “Bel” at the beginning (Bell, Bellingham, Bellmont, etc.) are selected. You can use wildcard characters with this operator.

**Does Not Begin With:** The Does Not Begin With operator selects records which do not begin with the entry you define. For example, if you choose Vendor Name Does Not Begin With Bel, vendors whose Vendor Name does not have “Bel” at the beginning are selected. You can use wildcard characters with this operator.
**Contains:** The Contains operator selects records that have the entry you define anywhere in the field. For example, if you define criteria for Vendor Name Contains Z, records with the letter “Z” anywhere in the vendor name field are selected. You can use wildcard characters with this operator.

**Does Not Contain:** The Does Not Contain operator selects records that do not have the entry you define anywhere in the field. For example, if you define criteria for Vendor Name Does Not Contain Z, only records without a “Z” anywhere in the vendor name field are selected. You can use wildcard characters with this operator.

**Like:** The Like operator allows you to use wildcards (special characters) to replace a character or set of characters in a field. These wildcards are particularly useful when you are not sure of the spelling of a name or you suspect something might be spelled incorrectly on a record.

**Not Like:** The Not Like operator selects records that do not have the entry you define. You can use wildcard characters with this operator.

**Blank:** The Blank operator selects any record with a blank field you define. For example, if you choose the criteria Alias is Blank, the program selects all records with an empty Alias field.

**Is Not Blank:** The Is Not Blank operator selects any record with anything in the entry you define. For example, if you select the criteria Alias Is Not Blank, the program selects records that have an entry in the Alias field.

### Combining Operators

**And** is used between fields to indicate the records selected must meet both criteria in order to be selected.

**Or** is used between fields to indicate the records selected can meet either of the criteria in order to be selected.

**Parenthesis ( )** are used to segregate a portion of the criteria formula.

### Using Wildcard Characters in Query

Some criteria operators allow you to use special character to define conditions a record must meet in order to be selected.

**Asterisk (*):** Use the asterisk to replace a series of characters. For example, if you are looking for any vendors with the Name ending in “son,” you can use the criteria Name Like *son and the program selects records with a last name ending in “son” (e.g., Henderson, Jackson, Allison, Wilson, etc.).

### Merging Operators

Merging queries combines two queries to make a third. The records included in the final query are determined by the merge operator. The following merge operators are available:

**AND:** When the merge operator AND is chosen, only records that are in both queries are in the resulting query.

**OR:** When the combining operator OR is chosen, the two queries are added together to make one query, but do not duplicate records that appear in both queries.
XOR: When the combining operator XOR is chosen, the final query contains only those records that are in either query, but not in both. If a record exists in both, it is eliminated.

SUB: The order of the queries is important when using SUB to merge queries because the output query contains records that are only in the first (primary) query. All records that appear in the second (secondary) query and records that are in both are eliminated from the final query.

# Accessing Query and Export

You can access *Query and Export* through the *Accounts Payable*.

- **Accessing Query and Export**
  1. From the Start menu, select Programs, Blackbaud Accounts Payable.
  2. Select Query and Export from the Accounts Payable modules.

![Query and Export](image)

# Establishing General Query Preferences

You can establish general preferences for *Query and Export*. For example, you can determine the toolbar settings and default types and formats for queries. The procedures for setting preferences for a specific query are covered later in this chapter.

The preference settings are saved on each workstation’s hard drive. If you enter *Query and Export* on another computer using your user name and password, your preferences are not carried over to that computer.
Completing the General tab

1. From *Query and Export*, select **Edit, Preferences**. The Preferences screen appears.

2. Mark the **Display selection fields alphabetically** checkbox to display selection fields alphabetically.

3. Mark the **Display number of records found** checkbox to display the number of records found when you run a query.

4. In the **Sort table entry order** field, use the drop-down list to select **Always Prompt**, **Alphabetically**, or **Table Order**.

5. In the **Show this tab first** field, use the drop-down list to select **Criteria**, **Sort**, **Output**, or **Results**.

6. In the **New Queries** frame, enter the **Default type** field. Use the drop-down list to select **Vendor**, **Invoice**, **Credit Memo**, **Recurring Invoice**, **Purchase Order**, **Receipt**, **Bank**, or **Ask**.

7. In the **Query format** field, use the drop-down list to select **Dynamic** or **Static**.

8. In the **Include in** field, use the drop-down list to select **Query Lists**, **Export Lists** or **Both**.

9. Mark the **Round adjusted amounts to** checkbox and enter the desired number in the decimal places field if you want to round adjusted amounts to a certain number of decimal places.

10. Mark the **Recently opened query list** checkbox to maintain a record of recently opened queries. If you mark this option, enter the number of records you want to include in the list. You can also include queries which have a history of specific actions performed. Select from **New**, **Open**, **Run**, **Export**, and **Print**. You can make more than one selection.

11. Designate what action occurs when you double click a saved query from the main query screen in the **Double Click Options** frame. Select from **Open**, **Run**, **Export**, or **Print**.
Completing the Advanced tab

1. Select the Advanced tab.

2. In the Automatic Output frame, mark the Automatic output for criteria fields and/or Automatic for sort fields checkboxes if you want the program to automatically enter the selected criteria fields and the selected sort fields as output fields. These options eliminate having to select from the list of criteria and sort fields again when you need to select your output fields.

3. In the Summary Fields frame, indicate if you want the program to automatically Apply criteria, Do not apply criteria, or Prompt you to select how criteria should be applied.
 Completing the Currency tab

1. Select the Currency tab.

2. Mark Use Windows default format if you want to use the currency format already established in Windows. To set your own currency format, unmark this option to enable the Currency Format Options frame.

3. In the Currency Format Options frame, mark Show currency character, Show 1000’s separator, and/or Show decimals.

4. In the Negative amount format field, use the drop-down list to specify whether you want to display negative amounts in parentheses or with a minus sign.
Completing the Number tab

1. Select the Number tab.

2. Mark **Use Windows default format** if you want to use the number format already established in *Windows*. To set your own number format, unmark this option to enable the **Number Format Options** frame.

3. In the **Number Format Options** frame, mark **Show 1000’s separator**, **Show decimals**, and/or **Show percent sign**.

4. In the **Negative amount format** field, use the drop-down list to specify whether you want to display negative amounts in parentheses or with a minus sign.
Completing the Dates tab

1. Select the Date tab.

2. Mark Use Windows default format to use the date format already established in Windows. To set your own date format, unmark this option to enable the Date Format Options frame.

3. Mark MDY for month, day, year; DMY for day, month, year; or YDM for year, day, month.

4. Select the appropriate format for the Month, Day, and Year by clicking the down arrow in the corresponding fields and selecting the desired format. For the dividing fields, type in either a dash or a slash.
Completing the Tables tab

1. Select the Tables tab.

2. Indicate whether you want tables to appear using the Short Description or Long description by selecting an option.

Completing the Yes/No tab

1. Select the Yes/No tab.

2. Use the drop-down list to select True/False, True/(Blank), T/F, Yes/No, Yes/Blank, or Y/N in the Yes/No field. This field determines how yes/no fields appear throughout Query and Export.

3. Click OK to save your preferences and return to the main screen of Query and Export.
Setting specific query preferences

In addition to general preferences for all queries, you can define and edit preferences for the individual queries you create. To set preferences specific to a particular query, you must access preferences from the open query.

1. From Query and Export, open the query for which you want to set specific preferences.

2. Select Edit, Preferences. The Preferences screen appears.

3. Mark the checkbox if you want Accounts Payable to use the Windows default format. If not marked, you can show the currency character, 1000’s separator, and/or decimals.

4. Enter the Negative amount format field. Select from a minus sign or parentheses.
5. Select the Number tab.

6. Mark the checkbox if you want *Accounts Payable* to use the Windows default format. If not marked, you can opt to show the 1000’s separator, decimals, and/or the percent sign.

7. Enter the *Negative amount format* field. Select either a minus sign or parentheses.

8. Select the Date tab.

9. If you want to use the Windows default format, mark the checkbox. If you do not want to use the default, select the order in which you want the day, month, and year to appear. Select from month, day, year (MDY); day, month, year (DMY); and year, day, month (YDM).

10. Select the desired format for the *Month*, *Day*, and *Year* fields from the drop-down list. For the dividing fields, type in either a dash or a slash.
11. Select the Tables tab.

12. Indicate if you want tables to appear using the **Short description** or **Long description**.

13. Select the Yes/No tab.

14. Select the appropriate **Yes/No field** format from the drop-down list. This determines how a yes/no field appears for the query.
15. Select the Optimizations tab.

16. Mark the **Use attribute functions in select clause** and/or the **Use code table functions instead of joins** checkboxes if you have a large database and typically run complex queries. This prompts the program to always use the most efficient method to generate the list of records.

17. Click **OK** to save the preferences you have set for the open query.

### Adding a new query

To create a query, you establish criteria and the program then locates specific records based on the criteria you have defined.

1. From *Query and Export*, select **File, New**. The New Query screen appears.

2. Enter the **Query type**. Select from **Vendor**, **Invoice**, **Credit Memo**, **Recurring Invoice**, **Purchase Order**, **Receipt**, or **Bank**.

3. Enter the **Query format**. A Dynamic query is one that includes new records each time the query is utilized. Each time it is used, the query is automatically updated to include any new records that meet the defined criteria. A Static query maintains only the records selected at the time the query was created.

---

When generating the list of records matching your query criteria, *Accounts Payable* follows a specific process. For a small percentage of queries, this process is not always the most efficient.

Any records added to the database after a Static query is created can be added to the query through the **File, Refresh** option.
4. Indicate if you want the query **Included in** Query Lists, Export Lists, or Both. If you create the query solely for viewing data in the database, select **Query Lists**. If you create the query for export only, select **Export Lists**. If you create the query for both, select **Both**. You can change this option at any time by opening the query and selecting **File, Options**.

5. Click **OK**. The New <Query Type> screen appears.

6. The **Available Fields** column lists the fields in summary form. Each category field has a plus sign (+). When you click the plus sign, the category field expands to list every field that falls under that category. The **Show** field allows you to limit the list to a specified category.

7. Select the fields you want to use as filters to determine which records are included in the query. You can select a field by highlighting it and clicking **Select**. The Edit Field Criteria screen appears.
8. Select an **Operator** for the selected field and define the **Value**. For example, for Vendor Name you can enter **begins with** as the operator and **A** as the value. Only vendors whose name begins with A are listed in the query.

9. Click **OK**.

10. Once you have finished defining the criteria for the query, click **Next** to continue to the Output tab.

11. Select the output fields for the query.
12. Click **Next** to continue to the Sort tab.

![Screenshot of the Sort tab in a query window](image)

13. From the Sort tab of the appropriate query, highlight the field you want to sort by from the **Available Fields** column.

14. Click **Select**.

15. The highlighted field defaults to ascending order. If you decide not to use the sort criteria you define, highlight the entry and click **Remove**. To move the field higher or lower in the sort order, click the up or down arrow keys.
16. Click **Next** to continue to the Results tab to view the results of your query.

![Query and Export screenshot]

17. Click **Run** to run the query or select **File, Save** to save the query.

- **Printing a query’s results**
  You can print a query’s results from the main screen of *Query and Export*.
  1. From *Query and Export*, locate and highlight the query you want to print. Select **File, Print, Results**. The program runs the query, then sends the results to the printer. The query record opens with the Results tab selected.

- **Running a query**
  1. From *Query and Export*, highlight the query you want to run.
  2. Select **File, Run Query**.
  3. The query executes and the Results tab of the query displays. From here you can print, export, view properties, or find field values. You can also edit the visual format of the display grid, and refresh each record in the query, which updates each record in the query.

- **Editing an existing query**
  1. From *Query and Export*, select the query you want to edit from the list of queries. You can enter **Query Type**, **Format**, and **Include in** information to filter the list of queries. If you want, mark the **Only show my queries** checkbox.
  2. Select **File, Open**.
3. The query record opens with the Criteria tab selected, unless you specified otherwise in the **Show this tab first** field in Preferences. Make the necessary changes. To change a selection, highlight the field you want to change and click **Change**.

4. To delete a selection, highlight the field you want to delete and click **Remove**.

► **Editing query options**

You can edit the description of a query, allow access/edit rights to other users, pull selected records from other queries, and limit the output of a query for special purposes. This can often save time when you want to use an existing query, but need to modify some of its features.

1. From **Query and Export**, open the query for which you want to set options.

2. Select **File, Options**. The Options screen appears.

![Options screen](image)

3. If necessary, edit the **Description** of the query. The **Description** is a free-form text field you can use to describe the associated query in detail.

4. If desired, mark **Other users may execute this query** and **Other users may modify this query**.

5. Mark **Suppress duplicate rows** if you want rows containing duplicate information to appear only once. For example, if ABC Enterprises appears in two rows, you can eliminate the duplicate row.

6. Mark **Select from query** if you want the query to select from records in another query but not from the entire database.

7. Select the query by clicking the binoculars button. This is a convenient way to create a new query by editing the existing query. You can, for example, choose to edit a query containing both credit memo and receipt records because you need to create a report showing a combination of these transactions. You can select records from a query containing only credit memos records for the query you are editing.
8. If you want, you can change the **Query type**, **Query format**, and the **Include in** options. You can also limit the output results to a random sampling or top number of rows in the query. This is useful if you need to perform a lottery choosing, for example. This creates an unbiased selection process.

9. Click **OK** to save the options you have chosen for the query.

### Viewing/printing query properties

The Query Properties screen displays general information about the query such as the last run date, who created the query, or when the query was last modified. You can also view a listing of the selected fields.

1. From an open query, select **File**, **Properties**. The Query Properties screen appears.

2. Select the Selected Fields tab.
3. When finished viewing, click **Print** to send the information to the printer or **OK** to return to the main screen of *Query and Export*.

➤ **Deleting a query**

Before deleting, we strongly recommend that you perform a backup. Once you delete a query, you can only recover it by using a backup database.

1. From *Query and Export*, select **File, Delete**. The Delete Queries screen appears.

2. In the **Queries** box, highlight the query or queries you want to delete. Using the arrow buttons, move the query or queries you want to delete to the **Queries to Delete** box.

3. Click **OK** to delete. A confirmation message appears.

4. Click **Yes** to delete.
**Previewing the query list**

1. To preview the query list on screen, select **File, Preview, Query List**. The Preview Query List screen appears.

2. Highlight the query or queries you want to list and preview on screen. Using the arrow buttons move the query or queries to the **Queries to Preview** box.

3. Click **OK**. The Query List previews on screen. From the Preview screen, you can print, export, and send as mail.

**Printing the query list**

1. To print the query list on screen, select **File, Print, Query List**. The Print Query List screen appears.
2. Highlight the query or queries you want to include in the printed list. Using the arrow buttons move the query or queries to the **Queries to Print** box.

3. Click **OK**. The Query List is sent to the printer.

**Merging two queries**

Select the primary and secondary queries you want to merge, using the lookup button if necessary. Also select the merge operator to determine which records from each query should be included in the merged query.

1. From **Query and Export**, select **File, Merge**. The Merge Queries screen appears.

2. Enter the **Primary** and **Secondary** queries. Click the binoculars to search for the desired queries.

3. Use the drop-down list to select a **Merge Operator**. The merge operator determines the records selected for the output query.

4. Click **OK**. The Save Static Query screen appears.

5. Enter the **Query name** field.

6. Click **OK**.
Refreshing a Static Query

One way of looking at a static query is to view the query as a snapshot of your database. For example, if you create a static query of all vendors with activity in the month of December, and in February you use that query to print a report of all active vendors, only those records that existed in the program in December and were selected when the query was created are included.

It is referred to as static because it does not include data entered after the query was created. Static queries can be refreshed manually. Dynamic queries are refreshed automatically.

- Refreshing a static query

When you create a static query, only the records selected when the query was created and ran are included when the query is used in the future. However, if you create a static query and re-run it at a later time using the Refresh option in Query and Export, you update the query and include new records that meet the criteria.

1. From Query and Export, select File, Refresh, Selected Query. The Refresh Queries screen appears.

2. Highlight the query you want to refresh and move it to the Queries to Refresh box.

3. Click OK.

Exporting Queries

You can export information on the Results tab of any query to a word processing program, spreadsheet, or reports program.

- Exporting a query

1. From Query and Export, highlight the query you want to export.
2. Click **File, Export**. The Export Parameters screen appears.

![Export Parameters screen](image)

3. Select the **Data format** you want to use from the drop-down list of available formats (e.g., Comma-Separated Values, Crystal Reports Database (MDB), dBase III).

4. Enter the file path and name for the export file. Use the browse button to locate the file path you want.

5. Click **OK** to export the query.

6. When the query has finished exporting, a message appears informing you that your export file has been created.

### Favorites

If you need to access a particular query often, you can add this query to a list of Favorites.

- **Adding a query to the list of favorites**
  1. From **Query and Export**, highlight the query you want to add to the list of favorites.
  2. Click **Favorites, Add to Favorites**. The query is added to the list of favorites.
Organizing the list of favorites

1. From *Query and Export*, select **Favorites, Organize Favorites**. The Organize Favorites screen appears.

2. Organize the list of favorites. To remove unwanted queries from this list, highlight the query and click **Remove**. You can also change the order of the queries in the list by using the up and down arrow keys.

3. Click **OK** to save the changes.
Mail

In This Chapter

Mail Basics ................................................................. 197
Labels ................................................................. 200
Envelopes ............................................................. 207
Rolodex/Index Cards ............................................. 209
Letters ................................................................. 212
1099 Forms ............................................................ 214
Mail allows you to use the information stored in your Accounts Payable database to create labels, envelopes, letters, and Rolodex/index cards. You can also create 1099 forms for printing or electronic transmission.

Specify the mail parameters you want on the four tabs within Mail: General tab, Attributes tab, Fields to Include tab, and Format tab.

Mail preferences include basic options such as font and display information. You can set preferences for default document fields such as the signature and preparer text boxes for letters. You can also set salutation preferences designating what happens when a record has no contact and therefore needs no salutation, a general Dear Sir/Madam salutation, or a salutation that includes the organization’s name.

If you have installed Blackbaud’s optional Purchase Orders module, Mail gives you the option of printing purchase orders.

From Mail, you can:

- set preferences
- change your password
- include selected/one/all vendors for mailing functions
- include vendors based on attributes for mailing functions
- create an output query from a mailing function
- print labels
- select fields to include on labels
- print a label truncation report before printing labels
- run a label truncation report without printing labels
- print envelopes
- print 1099 forms
- create a vendor letter
- select fields to include on envelopes
- set card format
- print Rolodex/index cards
- set envelope format
- select fields to include on Rolodex/index cards
- set label format

**Accessing Mail**

Mail allows you to use the information stored in your Accounts Payable database to create labels, envelopes, letters, and Rolodex/index cards.

1. From the Start menu, select Programs, Blackbaud Accounts Payable.
2. Select Mail from the Accounts Payable modules.

Mail Basics

- Setting preferences
  1. From Mail, select Edit, Preferences. The Preferences screen appears.

  2. Mark the Automatically save mailing parameters checkbox if you want to have the program save the mailing parameters you set up on the tabs.

  3. Mark the Show only my mailings checkbox to have the main mail window to display only those functions that you created.

  4. Enter the Double click preference field to designate what the program does when you double click a mail function. Select from Open, Export, Print, Mail, or Preview.

  5. In the Font Options frame, enter the Name and Size of the font to use for mail functions. A sample of the selected font and size displays in the adjacent box.

  6. Click OK to save.
Including vendors for mailing functions

1. From *Mail*, open the mailing function you want to perform.

![Mail interface](image)

2. From the General tab, click **Include**. Select **One vendor**, **Selected vendors**, or **All vendors** from the submenu. If you select **All vendors**, the General tab has “All vendors” next to **Include**, designating that all vendors in the program are included in this mailing function. The standard query Open screen appears if you select **One vendor** or **Selected vendors**.

![Open dialog box](image)

3. Search for and highlight the one vendor you want to include. Click **Select**.

4. You are now back to the General tab. Notice the name of the vendor you selected to include appears beside **Include**.

Including vendors with changed addresses

1. From *Mail*, open the mailing function you want to perform.
2. From the General tab, click **Include, Vendors with changed addresses.**

   ![Changed Addresses As Of](image)

   Only vendors with addresses that have changed since this date will have an envelope created.

   - **As of date:**
   - **OK**
   - **Cancel**

3. Enter the **As of date** field. You can click the calendar icon to select a date.

4. Click **OK**.

   ➢ **Including vendors based on attributes for mailing functions**

   1. From *Mail*, open the mailing function you want to perform.

   ![New Labels](image)

   2. Mark the **Include or Exclude Vendors With these Attributes** checkbox for the first grid. This activates the grid and allows you to select attributes on which vendors are included or excluded from this mailing function.

   3. In the **Filter** column, select either **Include** or **Exclude** from the drop-down list.

   4. In the **Category** column, select the attribute category from the drop-down list. Only valid attribute categories in your program are available.

   5. Enter the **Description** column with the description you want.

   6. Click **Next** to proceed to the next tab.
Creating an output query from a mailing function

1. From Mail, open the mailing function you want to perform.
2. Mark the Create Output Query checkbox.
3. Set the parameters you want and complete your mail function (e.g., print the envelopes).
4. While it prepares to print, you are prompted to name your new output query.
5. Enter a Name and Description for the new query.
6. Mark the Other users can execute this mailing checkbox if desired.
7. Click OK.

Labels

You can specify how you want the labels to print on the series of parameter tabs. Each of these tabs is discussed in the following section.
Printing labels

1. From Mail, open the Labels, Envelopes, and Cards folder.

2. Highlight Labels.

Completing the General tab

1. Double click the New icon on the right side of the screen. The New Labels screen appears.

2. Click Include to access a drop-down list.

3. Select All vendors, Selected vendors, Vendors with changed addresses or One Vendor.

4. In the Create labels for frame, mark Preferred address, Default invoice address, or Default PO address.
5. Select a label type by highlighting the desired type on the grid.
6. Select a label font and font size.
7. Use the arrow buttons to enter the **Start printing in Row** ___ and **Column** ___ fields.
8. Mark the **Create output query** checkbox if desired.

 ➢ **Completing the Attributes tab**
1. Select the Attributes tab.

2. Mark the **Include or Exclude Vendors With these Attributes** checkbox to activate the frame. Select specific attributes used to determine which records are included or excluded in this mail function.

3. Mark the **Add, Update or Delete these Attributes for each Vendor** checkbox to activate the frame. Select specific attributes to be modified on each record included in this mail function.
Completing the Fields to Include tab

1. Select the Fields to Include tab.

2. Use the **Field Name** drop-down list to select the fields you want to include on the label.

3. Use the **Options** drop-down list to select from options that may accompany the selected field, if any are available for the selected field.

4. Use the **Insert**, **Delete**, **Up**, and **Down** buttons to organize the grid.
Completing the Format tab

1. Select the Format tab.

2. If desired, mark the **Print Truncation Reports before Label Run** checkbox. The other options in the frame are now enabled.

3. Mark the checkboxes if you want to check for horizontal truncations and vertical truncations.

4. If truncations are found using font Times New Roman at size 10, indicate if you want to **Create exception query** or **Exclude vendor from this label run**.

5. Select **Alphabetical** or **ZIP Code** in the **Label Sort Order** frame and mark the desired formatting checkboxes.

6. Click **Print**.

7. You are prompted to save these label parameters, but you can click **Print without Saving** to bypass this.

8. Several screens may appear briefly, such as a status bar, as the labels print. When the labels have printed, a screen appears to verify that the labels have printed correctly. Confirm that the labels printed. If they did not print correctly, you are prompted to have designated labels print again.
Selecting fields to include on labels

On the Fields to Include tab, you can specify the fields you want printed on labels.

1. From the label parameters of the labels you want to print, select the Fields to Include tab.

2. Select the fields you want from the drop-down list of available fields in the Field Name column of the grid. Certain fields may have options that you can select from the corresponding Options column. Once fields have been selected, you can edit or adjust their position using the buttons to the right of the grid.
Setting label format

You can format a label based on output options, name formats, and truncation reports.

1. From the label parameters of the labels you want to print, select the Format tab.

2. If desired, mark the Print Truncation Reports before Label Run checkbox. The other options in the frame are now enabled.

3. Mark the checkboxes if you want to Check for horizontal truncations and/or Check for vertical truncations.

4. If truncations are found using font Times New Roman at size 10, indicate if you want to Create exception query or Exclude vendor from this label run.

5. Select Alphabetical or ZIP Code in the Label Sort Order frame and mark the desired formatting checkboxes.

Printing a label truncation report before printing labels

A label truncation report lets you know which labels have information that does not fit on the label. You can have a label truncation report printed while printing labels.

1. From the label parameters of the labels you want to print, select the Format tab.

2. Mark the options you want for a label truncation report.

Running a label truncation report without printing labels

1. From Mail, open the Labels, Envelopes, and Cards folder.

2. Highlight Label Truncation Reports.
3. Double click the New icon on the right side of the screen.

4. The New Label Truncation Reports screen appears. Mark the parameters you want on the series of tabs, as you would if you were actually preparing to print the labels.

5. Click Print.

Envelopes

You can specify how you want envelopes to print on the series of parameter tabs. You can print a variety of envelope formats for all vendors in your database.

Printing envelopes

1. From Mail, open the Labels, Envelopes, and Cards folder.

2. Highlight Envelopes.

3. Double click the New icon on the right side of the screen. The New Envelopes screen appears.

4. Designate the desired parameters on the series of tabs.
5. Click **Print**. You are prompted to enter a description and save the envelope parameters, but you may click **Print without Saving** to bypass this.

6. Continue with printing. Several screens may appear briefly, such as a status bar, as the envelopes print.

- **Selecting fields to include on envelopes**

  On the Fields to Include tab, you can specify the fields you want printed on envelopes.

  1. From the envelope parameters of the envelopes you want to print, select the Fields to Include tab.

  2. Select the fields you want from the drop-down list of available fields in the **Field Name** column of the grid. Certain fields may have options that you can select from the corresponding **Options** column. Once you have selected the fields you want to use, you can edit or adjust their position using the buttons to the right of the grid.
Setting envelope format

You can format an envelope based on output options, name formats, and return address.

1. From the envelope parameters of the envelopes you want to print, select the Format tab.

2. Mark the options you want for the envelopes you are printing. You can also mark options for having a return address print on the envelopes.

Rolodex/Index Cards

You can specify the parameters for printing New Rolodex and Index Cards on the series of parameter tabs.

Printing Rolodex/index cards

1. From Mail, open the Labels, Envelopes, and Cards folder on the left side of the screen.

2. Highlight Rolodex and Index Cards.
3. Double click the **New** icon on the right side of the screen. The New Rolodex and Index Cards screen appears.

![New Rolodex and Index Cards screen](image)

4. Designate the parameters you want on the series of tabs.

5. Click **Print**. You are prompted to enter a description and save the card parameters, but you may click **Print without Saving** to bypass this.

![Save Mailing As](image)

6. Continue with printing. Several screens may appear briefly, such as a status bar, as the cards print.
Selecting fields to include on Rolodex/index cards

On the Fields to Include tab, you can specify the fields printed on Rolodex and index cards.

1. From the Rolodex/index card parameters of the cards you want to print, select the Fields to Include tab.

2. Select the fields you want from list of available fields in the Field Name column of the grid. Certain fields may have options that you can select from the corresponding Options column.
Setting card format

Formatting options on Rolodex/index cards include margin settings, card sort order, printing in all caps, omitting punctuation and including total number of cards.

1. From the card parameters of the cards you want to print, select the Format tab.

2. Mark the options you want for the cards you are printing.

Letters

You can create and store vendor correspondence. Mail merge options are available, allowing you to quickly generate mass mailings for vendors.

Creating a vendor letter

1. From Mail, open the Letters folder.

3. Double click the **New** icon on the right side of the screen. The New Vendor Letters screen appears.

![New Vendor Letters screen](image)

4. Specify the parameters you want on the series of tabs.

5. Click **Export**.

![Save Mailing As](image)

6. You are prompted to save these merge files for letter parameters, but you may click **Export without Saving** to bypass.

![Export Format](image)

7. Select a data format.
8. If necessary, you can select the **Include header record** checkbox.

9. Verify the export file name is correct and click **OK**.

# 1099 Forms

You can specify the parameters for printing 1099 Forms on the parameter tabs. You can print 1099 forms, generate a diskette or electronic file to send the 1099 data to the IRS electronically, or do both simultaneously.

> **Printing 1099 forms**

1. From *Mail*, open the Forms folder on the left side of the screen.

2. Highlight **1099 Forms**.

3. Double click the **New** icon on the right side of the screen. The New 1099 Forms screen appears.

4. Specify the parameters you want on the series of tabs.
5. Click **Print/Create**. You are prompted to save these 1099 form parameters, but you may click **Print without Saving** to bypass this.

![Save Mailing As dialog box]

6. Continue with printing. Several screens may appear briefly, such as a status bar, as the forms print.
Reports

In This Chapter

Accounts Payable Reports ............................................. 218
Invoice Reports ................................................................. 218
Vendor Reports .................................................................. 219
Reconciliation Reports ...................................................... 219
Creating Reports ............................................................... 221
Reference ...................................................................... 238
Reports Main Screen ......................................................... 238
Report Parameter Tabs ....................................................... 239
   General Tab ................................................................. 239
   Funds Tab .................................................................. 255
   Accounts Tab ................................................................ 255
   Dates Tab .................................................................. 256
   Banks Tab .................................................................. 257
   Aging Tab .................................................................. 258
   Attributes Tab .............................................................. 258
   Projects Tab ................................................................. 259
   Format Tab ................................................................ 259
   Export Screen ............................................................... 264
Preferences .......................................................... 264
   All Reports Tab ........................................................... 264
   General Ledger Tab .................................................. 265
Reports allows you to use the information stored in your Accounts Payable database to print standard reports. You are given options in sorting, selecting, filtering, and processing different database information and printing the information in convenient reports.

The main screen of Reports displays the available report choices grouped by report type. The left side of this screen shows the report groups, such as invoice reports, with all of the predefined reports listed below each folder. The right side of the screen displays any report parameter files you create and save, including a parameter file for new reports based on the highlighted predefined report on the left.

You can customize the report parameter files using advanced report formatting tools and save them for future use. Any report you create has a series of tabs on which you specify the desired parameters. These tabs can include the General tab, Funds tab, Accounts tab, Banks tab, Attributes tab, Format tab, Dates tab, Aging tab, Projects tab, and Line Items tab.

Reports preferences include save and display options, as well as font options and paper orientation.

From Reports, you can:

- create reports
- define Reports preferences
- include records based on attributes on a report
- create an output query from a reporting function
- include select/one/all records for reporting functions
- print or preview a report

## Accounts Payable Reports

Accounts Payable reports consist of Invoice, Purchase Order, Vendor, and Reconciliation reports. Purchase Order reports are only available if you have the optional Purchase Orders module. Please refer to the Purchase Order User’s Guide for detailed explanations of Purchase Order reports.

A brief description of Invoice, Vendor, and Reconciliation reports follows.

## Invoice Reports

The Account Distribution Report provides distribution details for transactions contained in or produced by Accounts Payable.

The Aged Accounts Payable Report provides a timeline representation of the age of each invoice in your system.

The Cash Requirements Report calculates and displays the amount of cash required to satisfy the obligations of your organization on a specified date.

The Credit Memo Report provides a detailed list of vendors’ credit memo activity.

The Hold Payment Report lists all invoices that have been marked as “hold payment” on the invoice record in Vendors.

The Invoice Expense Allocation Report provides the general ledger expense account distribution of your invoices.
The **Invoice Generation Report** provides a list of generated invoices, invoices scheduled to be generated, or both.

The **Invoice Payment History** lists invoices with at least one payment made or one credit applied.

The **Open Invoice Report** lists invoices that are open on a specified date.

The **Project Distribution Report** provides credit and debit information for selected vendors.

The **Purchase Journal** lists all invoices in the *Accounts Payable* system for a specified date range.

The **Recurring Invoice Report** lists all recurring invoices whose next scheduled invoice date falls within the specified date range.

The **Transaction Register** provides a summary of *Accounts Payable* transactions during a specified date range.

### Vendor Reports

The **1099 Activity Report** provides information necessary for completion of Form 1099, as required by the Internal Revenue Service.

The **Cash Disbursement Journals** lists, by vendor, the cash debits and credits for each *General Ledger* account.

The **Vendor Activity** report lists vendor activity for a specified date range.

The **Vendor Profile** provides a detailed biographical profile for selected vendors.

The **Vendor Year to Date Analysis Report** provides a summary, by vendor, of all purchases, payments, credit memos, and discounts.

### Reconciliation Reports

The Batch Reconciliation Report allows the client to match journal entries from posted batches in General Ledger with the individual transactions (invoice, credit memo, etc.) from other Blackbaud programs. These individual transactions can be identified whether batches were posted in Detail or Summary.

- **Accessing Reports**

  *Reports* allows you to use the information stored in your *Accounts Payable* database to create reports.

  1. From the **Start** menu, select **Programs, Blackbaud Accounts Payable**.
2. Select Reports from the list of Accounts Payable modules.

Defining preferences

Report preferences include save and display options, as well as font options and paper orientation.

1. From Reports, click Edit, Preferences. The Preferences screen appears.

2. Mark the Automatically save report parameters checkbox if you want the program to automatically save report parameters when you print the report.

3. Mark the Show only my reports checkbox if you want to see only the parameter files you created on the right side of the screen.

4. Enter the Double click preferences field. Select from, Export, Mail, Open, Preview, and Print.

5. Enter the desired preferences in the Font Options frame.

6. Click OK to save.
Creating Reports

The procedures in this section explain how to complete all of the tabs involved in creating reports. Depending on the type of report you are creating, different parameter tabs can appear. For example, you set up a Vendor Profile Report on the General, Attributes, and Format tabs; whereas on an Account Distribution Report, you use the General, Funds, Accounts, Banks, Attributes, and Format tabs.

You also might encounter a few variations in available fields, depending in the report you are creating. When this occurs, please refer to the Reference section of this chapter for an explanation of the field.

Completing the General tab

We will use the Account Distribution Report as the example for completing the General tab.

1. From the Reports main screen, open the Accounts Payable folder and double click Invoice Reports.
2. Double click the Account Distribution Report.
3. Click Include to select the records you want to include in the report. Select from All Records, Selected Records, or One Record. If you choose One Record or Selected Records, a search screen appears which allows you to locate the desired record(s). If necessary, you can refer to the procedures for including records in reports.
4. Enter the Date field in the Include Invoices with these Dates frame. This field filters invoices included in the report by date range. Use the drop-down list to select a time frame.
5. Enter the Date field in the Include Invoices with these Posting Dates frame. Use the drop-down list to select a time frame.

6. Mark the desired checkboxes in the Include invoices marked as field. Select from Posted, Not posted, and Do not post.

7. Mark the Include adjustment transactions checkbox to include adjustment transactions for invoices and credit memos in the report.

8. Mark the Create output query checkbox to create a query of the records included in the report.

> Completing the Funds tab

We will use the Account Distribution Report as the example for completing the Funds tab.

1. Select the Funds tab.

2. Mark the Include Only these Funds checkbox to determine which accounts to include based on the fund.

3. Use the arrow buttons to move the desired funds from the Funds box to the Funds to include box.
Completing the Accounts tab

We will use the Account Distribution Report as the example for completing the Accounts tab.

1. Select the Accounts tab.

2. Mark the **Include Only These Accounts** checkbox to filter specific accounts for the report.

3. Choose **Selected** to enter account numbers in the grid.

4. Choose **Range** to enter a range or multiple ranges of account numbers in the grid.
Completing the Banks tab

We will use the Account Distribution Report as the example for completing the Banks tab.

1. Select the Banks tab.

2. Mark the Include Only Invoices Paid from these Bank Accounts checkbox to establish which invoices to include in the report based on the bank account.

3. Use the arrow buttons to move the bank accounts from the Bank accounts box to the Bank accounts to include box.
Completing the Attributes tab

We will use the Account Distribution Report as the example for completing the Attributes tab.

1. Select the Attributes tab.

2. Mark the Include Invoices Having these Attributes checkbox to enable the Include grid. Once you enable the grid, you can include invoices based on attributes you specify in the Category, and Description columns.

3. In the Category column, select the attribute category from the drop-down list; only attribute categories predefined in Configuration are available.

4. In the Description column, enter the desired description. The Short Description column is not editable.

5. Mark the Exclude Invoices Having these Attributes checkbox to enable the Exclude grid. Once you enable the grid, you can exclude invoices based on attributes you specify in the Category, and Description columns.

6. In the Category column, select the attribute category from the drop-down list; only attribute categories predefined in Configuration are available.

7. In the Description column, enter the desired description. The Short Description column is not editable.
Completing the Headings options on the Format tab

We will use the Account Distribution Report as the example for completing the Format tab.

1. Select the **Headings** option on the Format tab.

2. Enter the report title in the **Title** field.

3. Enter the report subtitle in the **Subtitle** field.

4. Enter the **Align** field. Use the drop-down list to select from **Center**, **Right**, and **Left**.

5. If desired, mark the **Print organization name in header** checkbox.

6. If desired, mark the **Print Page # in Heading** checkbox. If marked, enter the **Format** and **Align** fields in this frame. You can use the drop-down lists to make a selection.

7. If desired, mark the **Print Report Date in Heading** checkbox. If marked, enter the **Format** and **Align** fields in this frame. You can use the drop-down lists to make a selection.

8. You can **Print report heading on each page** by marking the checkbox.
Completing the Criteria options on the Format tab

We will use the Account Distribution Report as the example for completing the Format tab.

1. Select the Criteria option on the Format tab.

2. Mark the Print Report Criteria checkbox and select where you want the report criteria to print. Select either On the first page or On a separate page.

3. Select which criteria you want to print by marking the checkboxes in the Criteria to print box.
Completing the Detail options on the Format tab

We will use the Account Distribution Report as the example for completing the Format tab.

1. Select the **Detail** option on the Format tab.

2. Specify how you want the report to print. Select either **Detail** or **Summary**.

3. Mark the **Break Down Report by Bank Account** checkbox to enable the frame. This checkbox indicates that all transactions associated with a given bank account are listed together.

4. Select **Define Break Header** or **Define Break footer**.

5. Enter the text you want to appear before and after the bank account. You can verify the text in the sample frame.

6. Select **ID**, **Description**, or **ID and Description** in the **Print bank account** field.
Completing the Page footer options on the Format tab

We will use the Account Distribution Report as the example for completing the Format tab.

1. Select the **Page footer** option on the Format tab.

2. Enter the text you want to appear in the page footer in the **Text** field.

3. Specify the alignment in the **Align** field. Select from **Right**, **Center**, and **Left**.

4. Mark the **Print Page # in Footer** checkbox if desired. If marked, enter the **Format** and **Align** fields in this frame. You can use the drop-down lists to make a selection.

5. Mark the **Print Report Date in Footer** checkbox if desired. If marked, enter the **Format** and **Align** fields in this frame. You can use the drop-down lists to make a selection.
Completing the Report footer options on the Format tab

1. Select the **Report footer** option on the Format tab.

2. Enter the **Report footer text** field.

3. Enter the **Align** field. Select from **Right**, **Center**, and **Left**.
Completing the Miscellaneous options on the Format tab

We will use the Account Distribution Report as the example for completing the Format tab.

1. Select the **Miscellaneous** option on the Format tab.

2. Mark the desired checkboxes in the **Amount Display Options** frame.
   You can verify your selections with the **Sample Display** frame.
Completing the Dates tab

We will use the Aged Accounts Payable Report as the example for completing the Dates tab.

1. Select the Dates tab.

2. Enter the Include Transactions with these Transaction Dates frame with the desired dates.

3. Enter the Include Invoices with these Due Dates frame with the desired dates.

4. Mark the Include invoices whose discounts will expire in this range checkbox to further filter the invoices included in the report.

5. Enter the Include Invoices with these Posing Dates frame with the desired dates.

6. In the Include invoices marked as field, mark Posted, Not Posted, and/or Do not post to further filter the invoices included in the report.
Completing the Aging tab

We will use the Aged Accounts Payable Report as the example for completing the Aging tab.

1. Select the Aging tab.

2. Specify the aging periods to use as filters for the records in this report. You cannot edit yellow fields.
Completing the Projects tab

We will use the Project Distribution Report as the example for completing the Projects tab.

1. Select the Projects tab.

2. Mark the Include Only these Funds checkbox to determine which projects to include in the report.

3. Use the arrow buttons to move the desired projects from the Projects box to the Projects to include box.

Printing or previewing a report

1. From Reports, double click the Accounts Payable folder on the left side of the screen to display the available report categories.
2. Double click the desired category folder to display the specific report types.

3. Highlight the appropriate report type to display any saved report parameter files on the right side of the screen.

4. Open the report you want to print or preview. Using Account Distribution Report as the example, the report parameters screen appears.

5. Click Print, or Preview, on the lower right hand corner of any tab. The program begins to process and print the report and displays a status screen. If necessary, you can cancel the report from this screen.
Including select records on a report

You can include select records, one record, all records, or records based on attributes for each report.

1. From Reports, open the report you want to print.
2. On the General tab, click Include and click selected records.
3. The standard query Open screen appears. Highlight the query containing the records you want to include and click Open.
4. Now the General tab has “Selected records from <query name>” next to Include, designating your specific selection of records.
5. Continue selecting the desired parameters and then print, save, or preview the report.

Including one record for reporting functions

1. From Reports, open the report.
2. On the General tab, click Include and select one record.
3. The standard Open screen appears. Search for and highlight the record you want to include and click Select.
4. You are now back to the General tab. Notice the name of the record you selected to include appears beside Include.
5. Continue the process of printing a report.

Including all records for reporting functions

1. From Reports, open the report.
2. On the General tab, click Include and choose to print for all records.
3. The General tab now has “All records” next to Include, designating that all records in the program are included in this reporting function.
4. Continue the process of printing the report.

Creating an output query from a reporting function

You can create an output query of those records included in the report. You can then use this query to print other reports.

1. From Reports, open the report parameter file you want to print.
2. On the General tab, mark the Create Output Query checkbox.
3. Specify all other desired parameters and print or preview the report.
4. Before the report prints, you are prompted to name the output query.

![Image of a Save Static Query window]

5. Enter a **Report name** and **Description** for the new query.

6. If desired, mark the **Other users can execute this report** and/or the **Other users can modify this report** checkbox.

7. Click **Save and Preview** or **Preview without Saving**.
Reference

The reference section provides detailed, field-by-field information of individual screens within the module. Tables are displayed below each screen that give the **Field Name** and **Description**. The **Type** of field (shown in parentheses) indicates if the field is **Required**, **Optional**, **Display**, or a **Button**.

**Reports Main Screen**

The left side of the main *Reports* screen displays the available report choices. The right side of the screen displays any report parameter files you have defined and saved.

For example, when a Reports folder is opened on the left side of the screen, all of the saved report parameter files, including a standard new report parameter file, appear on the right side of the screen.
Report Parameter Tabs

Use the standard parameters on each screen to manipulate the information displayed, or to move you from screen to screen. Any report you choose to run has a series of tabs on which you specify the desired report parameters. Several of these tabs are common and appear for most reports you select, although the specific information on the tabs can vary slightly.

General Tab

The General tab is the tab on which you specify which records are included (e.g., all records, selected records, one record). This tab usually has a checkbox to designate whether an output query is created from the records selected for the report. The General tab also allows you to enter specific date ranges or additional report options.

General Tab for 1099 Activity Reports

This report is a summary listing, by vendor, of all 1099 activity for a given period. Each 1099 box includes the vendor total of all invoices and credit memos associated with that box. The 1099 box association is determined by the account distribution on the invoice/credit memo record. Grand totals for each box are provided as well. If a vendor is not marked as a 1099 vendor but appears in the report, an asterisk appears to the left of the vendor name.

<table>
<thead>
<tr>
<th>Name (Type*)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Include (B)</td>
<td>Click this button to display a menu with options regarding the specific records to include. You can select from All, Selected, and One.</td>
</tr>
<tr>
<td>Calculate 1099 Activity for these Dates (O)</td>
<td>This frame determines the date or date range for the calculation of 1099 activity. The program determines the 1099 amounts for those records within the data range.</td>
</tr>
<tr>
<td>Date (R)</td>
<td>Enter the date you want to calculate 1099 activity for. You can select Include all dates, Today, Yesterday, Tomorrow, This week, Last week, Next week, This month, Last month, Next month, Month to date, This quarter, Last quarter, Next quarter, Quarter to date, Last calendar yr, This calendar yr, Next calendar yr, Calendar YTD, Last fiscal yr, This fiscal yr, Next fiscal yr, and Fiscal YTD. If &lt;Specific range&gt; is selected, the start and end date boxes are visible. If you cannot select an option because the year has not been defined, you are prompted to select another option.</td>
</tr>
<tr>
<td>Start/End (O)</td>
<td>Enter the start and end dates of the &lt;Specific range&gt;. If these fields are left blank, the program reports for all dates.</td>
</tr>
</tbody>
</table>
CHAPTER 12

General Tab for Cash Disbursement Journals

This report is a listing of all payments made in the specified time frame. Included are the accounts affected by the payment and the associated debit/credit amount, as well as the invoice detail. You can also receive an account summary of all debits and credits at the end of the report.

<table>
<thead>
<tr>
<th>Name (Type*)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Include vendors with 1099 activity who are not marked as 1099 vendors <strong>(O)</strong></td>
<td>Mark this checkbox to include vendors who are not flagged as 1099 vendors but who do have 1099 activity.</td>
</tr>
<tr>
<td>Include vendors with activity below 1099 box minimums <strong>(O)</strong></td>
<td>Mark this checkbox to include vendors with activity below the 1099 minimums set by the government and stored in Accounts Payable.</td>
</tr>
<tr>
<td>Include vendors with zero activity <strong>(O)</strong></td>
<td>Mark this checkbox to include 1099 vendors who have no activity.</td>
</tr>
<tr>
<td>Create output query <strong>(O)</strong></td>
<td>Mark this checkbox to create a query of the records included in the report. Before you preview, print, or export the report, the standard Save Query screen displays for entry of the new query name.</td>
</tr>
</tbody>
</table>

New Cash Disbursement Journals

Include Payments with these Dates **(O)**

- Date (R)
  - Enter the date payments must have to be included in the report. Select an entry from the drop-down list. If you select <Specific range>, the associated date text boxes are visible. If you cannot select a particular option because the year has not been defined, you are prompted to select another option.

- Start/End **(O)**
  - Enter the start and end dates of the <Specific range>. If you do not enter a start or end date, the program reports for all dates.

Payment Types to Include **(O)**

- Check **(O)**
- Electronic funds transfers **(O)**
- Bank Drafts **(O)**

Print invoice detail for each payment **(O)**

- Mark this checkbox to have each invoice associated with a payment display with the amount of the invoice and the amount paid on the invoice.
General Tab for Vendor Activity Report

This report is a listing of all activity for a given period. Invoices and credit memos appear on this report with the full original amount of the invoice/credit memo. Also included in the report are discount amounts; whether the discount was taken; the amount of credit that has been applied; any payments made on invoices; and the net transaction balances.

If you increase the font size beyond the recommended 8 pt. for the Vendor Activity Report, there can be overlapping of data in certain columns.
General Tab for Vendor Profile

This report provides you with a comprehensive profile of the selected vendors. Each vendor record is listed on a separate page and includes address and phone numbers associated with the vendor, a GL distribution section, a 1099 section (if option is selected), and a note section which prints all or selected notes from the vendor record.

Name (Type*) | Description
---|---
Include (B) | Click this button to display a menu with options regarding the specific records to include in the report function.
Print Vendor Notes (O) | Mark this checkbox to print vendor notes in the report. If selected, choose to print All notes or Selected notes. If you choose Selected notes, specify at least one note type to print by using the standard buttons to move from Types frame to Type to include frame.
Show 1099 activity (O) | Mark this checkbox to print the 1099 activity section of the report.
Create output query (O) | Mark this checkbox to create a query of the records included in the report.

General Tab for Vendor Year-To-Date Analysis

This report is a summary of all purchases, payments, credit memos, and discounts from 1/1 of the current year up to and including the cutoff date specified on the General tab. The report is listed by vendor and also includes last payment type, last payment date, prior year balance, and current balance.
The detail report lists all transactions and their associated debit and credit amounts. The summary report lists each account and the summary of all debits and credits to the account.

### General Tab for Account Distribution Report

The detail report lists all transactions and their associated debit and credit amounts. The summary report lists each account and the summary of all debits and credits to the account.

<table>
<thead>
<tr>
<th>Name (Type*)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Include (B)</td>
<td>Click this button to display a menu with options regarding the specific records to include in the report function.</td>
</tr>
<tr>
<td>Include Invoices with these Dates (O)</td>
<td>This frame determines the date or date range for the inclusion of invoices.</td>
</tr>
<tr>
<td>Date (R)</td>
<td>Enter the date of invoices to be included in the report. If you select &lt;Specific range&gt;, the associated date text boxes are visible.</td>
</tr>
<tr>
<td>Start/End (O)</td>
<td>Enter the start and end dates of the &lt;Specific range&gt;. If you do not enter a start or end date, the program reports for all dates.</td>
</tr>
<tr>
<td>Include Invoices with these Posting Dates (O)</td>
<td>This frame determines the date or date range for the inclusion of payment activity.</td>
</tr>
<tr>
<td>Date (R)</td>
<td>Enter the posting date of invoices to be included in the report. Select an entry from the drop-down list. If you select &lt;Specific range&gt;, the associated date text boxes are visible.</td>
</tr>
<tr>
<td>Start/End (O)</td>
<td>Enter the start and end dates of the &lt;Specific range&gt;. If you do not enter a start or end date, the program reports for all dates.</td>
</tr>
</tbody>
</table>
General Tab for Aged Accounts Payable

The detail report is a listing, by vendor, of all open invoices and credit memos and the defined aging period for each, along with any credit and the net due. The summary report is the total of all open invoices/credit memos in each aging period, any credits or credit memos, and the net amount due for each vendor.

<table>
<thead>
<tr>
<th>Name (Type*)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Include invoices marked as (R)</td>
<td>Mark this checkbox to filter invoices. Select from Posted, Not posted, and Do not post. Mark at least one of these options.</td>
</tr>
<tr>
<td>Include adjustment transactions (O)</td>
<td>Mark this checkbox to include adjustment transactions for invoices and credit memos in the report. These transactions are flagged, and the debit/credit amounts appear in the appropriate columns.</td>
</tr>
<tr>
<td>Create output query (O)</td>
<td>Mark this checkbox to create a query of the records included in the report.</td>
</tr>
</tbody>
</table>

Name (Type*)                  | Description                                                                                                                                 |
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Include (B)</td>
<td>Click this button to display a menu with options regarding the specific records to include in the report function.</td>
</tr>
<tr>
<td>Calculate Invoice Aging as of (R)</td>
<td>This frame determines the date or date range for the inclusion of invoice aging. Select desired entry from the drop-down list. If you select &lt;Specific range&gt;, enter the appropriate date in the associated date text box.</td>
</tr>
<tr>
<td>Base aging on (R)</td>
<td>Choose to age the transaction based on the invoice date or the due date.</td>
</tr>
<tr>
<td>Create output query (O)</td>
<td>Mark this checkbox to create a query of the records included in the report.</td>
</tr>
</tbody>
</table>
General Tab for Cash Requirements Report

This report produces a listing, by invoice due date, of all open invoices and credit memos that meet the specified criteria. The summary report is the total of all open invoices/credit memos, discounts, and the net amount due for each due date. Both reports give a running total of invoices.

<table>
<thead>
<tr>
<th>Name (Type*)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Include (B)</td>
<td>This button displays a menu with options regarding the specific records to include in the report function.</td>
</tr>
<tr>
<td>Calculate Discount as of (R)</td>
<td>This frame determines the date or date range for the calculation of the discount. Select appropriate entry from the drop-down list. If you select &lt;Specific range&gt;, enter the appropriate date in the associated date text box.</td>
</tr>
<tr>
<td>Include invoices to be generated before (R)</td>
<td>Mark this checkbox to enter a date before which invoices are generated to be included in the report.</td>
</tr>
<tr>
<td>Create output query (O)</td>
<td>Mark this checkbox to create a query of the records included in the report.</td>
</tr>
</tbody>
</table>

General Tab for Credit Memo Report

This report consists of a listing of all credit memos, the amount used for each, and the amount remaining for each. The report is broken down and sorted by vendor and credit memo date. You may also include account and project distributions in the report.
General Tab for Hold Payment Report

This report consists of all invoices marked as “hold payment” on the Invoice record in Vendors and all standard invoice information including the balance due.
General Tab for Invoice Expense Allocation Report

This report details the debits and credits to the expense accounts associated with each invoice and credit memo. The report can be sorted by vendor, date, or query. You can also elect to view an account summary and/or a project summary.

<table>
<thead>
<tr>
<th>Name (Type*)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Include (B)</td>
<td>Click this button to display a menu with options regarding the specific records to include in the report function.</td>
</tr>
<tr>
<td>Include Invoices with these Dates (O)</td>
<td>This frame determines the date or date range for the inclusion of invoices.</td>
</tr>
<tr>
<td>Date (R)</td>
<td>Enter the invoice date to include in the report. Select an entry from the drop-down list. If you select &lt;Specific range&gt;, the associated date text boxes are visible.</td>
</tr>
<tr>
<td>Start/End (O)</td>
<td>Enter the start and end dates of the &lt;Specific range&gt;.</td>
</tr>
<tr>
<td>Include Invoices with these Posting Dates (O)</td>
<td>This frame determines the date or date range for the inclusion of invoices with specific posting dates.</td>
</tr>
<tr>
<td>Date (R)</td>
<td>Enter the posting date on invoices to include in the report. Select an entry from the drop-down list. If you select &lt;Specific range&gt;, the associated date text boxes are visible.</td>
</tr>
<tr>
<td>Start/End (O)</td>
<td>Enter the start and end dates of the &lt;Specific range&gt;.</td>
</tr>
<tr>
<td>Include invoices marked as (R)</td>
<td>Mark this checkbox to filter the invoices. Select from Posted, Not posted, and Do not post. You must select one of these options.</td>
</tr>
<tr>
<td>Create output query (O)</td>
<td>Mark this checkbox to create a query of the records included in the report.</td>
</tr>
</tbody>
</table>
General Tab for Invoice Generation Report

This report consists of invoices that have already been generated, and invoices that are scheduled for generation.

<table>
<thead>
<tr>
<th>Name (Type*)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Include Invoices with these Posting Dates (O)</td>
<td>This frame determines the date or date range for the inclusion of invoices with specific posting dates.</td>
</tr>
<tr>
<td>Date (R)</td>
<td>Enter the posting date of invoices to include in this report. Select an entry from the drop-down list. If you select &lt;Specific range&gt;, the associated date text boxes are visible.</td>
</tr>
<tr>
<td>Include invoices marked as (R)</td>
<td>Options are Posted, Not posted, and Do not post. At least one of these options must be selected.</td>
</tr>
<tr>
<td>Show account/project summary (O)</td>
<td>Mark these checkboxes to show an account summary and/or project summary in the report.</td>
</tr>
<tr>
<td>Create output query (O)</td>
<td>Mark this checkbox to create a query of the records included in the report.</td>
</tr>
</tbody>
</table>
General Tab for Invoice Payment History

This report is a listing of all invoices that have made at least one payment or one credit applied. You can also see the payment schedule for all remaining payments.

<table>
<thead>
<tr>
<th>Name (Type*)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Include (B)</td>
<td>Click this button to display a menu with options regarding the specific records to include in the report function.</td>
</tr>
<tr>
<td>Include Invoices with these Dates (O)</td>
<td>This frame determines the date or date range for the inclusion of invoices.</td>
</tr>
<tr>
<td>Date (R)</td>
<td>Enter dates of invoices to include in the report. Select an entry from the drop-down list. If you select &lt;Specific range&gt;, the associated date text boxes are visible.</td>
</tr>
<tr>
<td>Include Invoices with these Due Dates (O)</td>
<td>This frame determines the date or date range for the inclusion of invoices with specific due dates.</td>
</tr>
<tr>
<td>Date (R)</td>
<td>Enter due dates of invoices to include in the report. Select an entry from the drop-down list. If you select &lt;Specific range&gt;, the associated date text boxes are visible.</td>
</tr>
<tr>
<td>Show remaining scheduled payments for partially paid invoice (O)</td>
<td>If an invoice has been partially paid, the program requires you to schedule payments so that the balance is zero after all scheduled payments are made. If you mark this checkbox, the history includes any remaining scheduled payments.</td>
</tr>
<tr>
<td>Create output query (O)</td>
<td>Mark this checkbox to create a query of the records included in the report. Before the report is previewed, printed, or exported, the standard Save Query screen displays for entry of the new query name.</td>
</tr>
</tbody>
</table>
General Tab for Open Invoice Reports

This report is a listing of all open invoices and credit memos that meet the specified criteria. Summary report shows the total of all open invoices/credit memos, discounts, and the net amount due for each vendor.

Name (Type*) | Description
---|---
Include (B) | This button displays a menu with options regarding the specific records to include in the report function.
Calculate Invoice Aging as of (R) | This frame determines the date or date range for the inclusion of invoice aging. Select an entry from the drop-down list. If you select <Specific range>, enter the appropriate date in the associated date text box.
Base aging on (R) | Choose to age the transaction based on the invoice date or the due date.
Show total discount lost as of this date (O) | Mark this checkbox to have the total discount lost calculated as of the “calculate” date. The discount date is compared to the calculate date, and a running total of all expired discounts is kept.
Show invoices open as of (O) | Mark this checkbox to show invoices that were unpaid as of the date specified, and any payments or credits applied after this date are not included as part of the “Amount Due” calculation.
Create output query (O) | Mark this checkbox to create a query of the records included in the report. Before the report is previewed, printed, or exported, the standard Save Query screen displays for entry of the new query name.
General Tab for Project Distribution Report

The **Project Distribution Report** provides credit and debit information for selected vendors.

<table>
<thead>
<tr>
<th>Name (Type*)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Include (B)</td>
<td>Click this button to display a menu with options regarding the specific records to include in the report function.</td>
</tr>
<tr>
<td>Include Transactions with these Dates (O)</td>
<td>This frame determines the date or date range for the inclusion of invoices. Enter the date of transactions to include in the report. Select an entry from the drop-down list. If you select &lt;Specific range&gt;, the associated date text boxes are visible.</td>
</tr>
<tr>
<td>Date (R)</td>
<td>Enter the posting date of transactions to include in the report. Select an entry from the drop-down list. If you select &lt;Specific range&gt;, the associated date text boxes are visible.</td>
</tr>
<tr>
<td>Start/End (O)</td>
<td>Enter the start and end dates of the &lt;Specific range&gt;.</td>
</tr>
<tr>
<td>Include Transactions with these Posting Dates</td>
<td>This frame determines the date or date range for the inclusion of invoices with specific posting dates. Enter the start and end dates of the &lt;Specific range&gt;.</td>
</tr>
<tr>
<td>Include transactions marked as (R)</td>
<td>Select from Posted, Not posted, and Do not post. At least one of these options must be selected.</td>
</tr>
<tr>
<td>Include adjustment transactions (O)</td>
<td>Mark this checkbox to include adjustment transactions for invoices and credit memos appear in the report flagged as “Adj. Invoice” or “Adj. Credit Memo”.</td>
</tr>
<tr>
<td>Create output query (O)</td>
<td>Mark this checkbox to create a query of the records included in the report. Before the report is previewed, printed, or exported, the standard Save Query screen displays for entry of the new query name.</td>
</tr>
</tbody>
</table>
General Tab for Purchase Journal

The **Purchase Journal** report lists all invoices in the **Accounts Payable** system for a specified date range.

<table>
<thead>
<tr>
<th>Name (Type*)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Include (B)</td>
<td>Click this button to display a menu with options regarding the specific records to include in the report function.</td>
</tr>
<tr>
<td>Include Invoices with these Invoice Dates (O)</td>
<td>This frame determines the date or date range for the inclusion of invoices.</td>
</tr>
<tr>
<td>Date (R)</td>
<td>Enter the date of invoices to include in the report. Select an entry from the drop-down list. If you select &lt;Specific range&gt;, the associated date text boxes are visible.</td>
</tr>
<tr>
<td>Include Invoices with these Posting Dates</td>
<td>Determines the date or date range for the inclusion of invoices with specific posting dates.</td>
</tr>
<tr>
<td>Date (R)</td>
<td>Enter the posting dates of invoices to include in the report. Select an entry from the drop-down list. If you select &lt;Specific range&gt;, the associated date text boxes are visible.</td>
</tr>
<tr>
<td>Start/End (O)</td>
<td>Enter the start and end dates of the &lt;Specific range&gt;.</td>
</tr>
<tr>
<td>Include invoices marked as (R)</td>
<td>Mark this checkbox to filter the invoices. Select from Posted, Not posted, and Do not post. At least one of these options must be selected.</td>
</tr>
<tr>
<td>Create output query (O)</td>
<td>Mark this checkbox to create a query of the records included in the report. Before the report is previewed, printed, or exported, the standard Save Query screen displays for entry of the new query name.</td>
</tr>
</tbody>
</table>
General Tab for Recurring Invoice Report

This report consists of all recurring invoices whose next scheduled invoice date falls within the date range specified. Also included is the detail for each recurring invoice.

<table>
<thead>
<tr>
<th>Name (Type*)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Include (B)</td>
<td>Click this button to display a menu with options regarding the specific records to include in the report function.</td>
</tr>
<tr>
<td>Include Recurring invoices with these Next Invoice Dates (O)</td>
<td>This frame determines the date or date range for the inclusion of recurring invoices.</td>
</tr>
<tr>
<td>Date (R)</td>
<td>Enter the dates of recurring invoices to include in the report. Select an entry from the drop-down list. If you select &lt;Specific range&gt;, the associated date text boxes are visible.</td>
</tr>
<tr>
<td>Show account distributions (O)</td>
<td>Mark this checkbox to have the General Ledger account distributions display for each recurring invoice listed.</td>
</tr>
<tr>
<td>Show project distributions (O)</td>
<td>Mark this checkbox to have the General Ledger project distributions display for each recurring invoice listed.</td>
</tr>
<tr>
<td>Create output query (O)</td>
<td>Mark this checkbox to create a query of the records included in the report.</td>
</tr>
</tbody>
</table>
General Tab for Transaction Register

This report is a listing of all transactions that meet the specified criteria. This report is intended to be a data entry reconciliation report that you can run each day.

<table>
<thead>
<tr>
<th>Name (Type*)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Include (B)</td>
<td>Click this button to display a menu with options regarding the specific records to include in the report function.</td>
</tr>
<tr>
<td>Include these Transaction Types (R)</td>
<td>You can choose to include Invoices, Credit Memos, or both. You must select at least one option.</td>
</tr>
<tr>
<td>Show account distributions (O)</td>
<td>Mark this checkbox to have the General Ledger account distributions display for each recurring invoice listed.</td>
</tr>
<tr>
<td>Show project distributions (O)</td>
<td>Mark this checkbox to have the General Ledger project distributions display for each recurring invoice listed.</td>
</tr>
<tr>
<td>Create output query (O)</td>
<td>Mark this checkbox to create a query of the records included in the report. Before the report is previewed, printed, or exported, the standard Save Query screen displays for entry of the new query name.</td>
</tr>
</tbody>
</table>
Funds Tab

Use the Funds tab to determine which accounts to include based on fund(s).

<table>
<thead>
<tr>
<th>Name (Type*)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Include Only these funds (O)</td>
<td>Mark this checkbox to determine which accounts to include based on funds.</td>
</tr>
<tr>
<td>Funds (D)</td>
<td>All available funds are listed in this frame.</td>
</tr>
<tr>
<td>Funds to include (D)</td>
<td>The funds you want to include are moved from the Funds frame into this frame by highlighting the selected fund and using the right arrow.</td>
</tr>
</tbody>
</table>

Accounts Tab

The Accounts tab determines which General Ledger accounts to include in the report.
The Dates tab allows you to include (or filter) records with a specific date. For example, you can designate that an invoice must have a certain date (or fall into a certain range) for the invoice date, due date, and post date.

<table>
<thead>
<tr>
<th>Name (Type*)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Include Only These Accounts (O)</td>
<td>Marking this checkbox allows you to filter specific accounts for the report. The controls within this frame are enabled and you must specify at least one account to include. Choose from Selected and Range.</td>
</tr>
<tr>
<td>Selected (B)</td>
<td>Select this option to display a grid for the entry of account numbers. The search icon on the account number provides for an account lookup. You can specify an unlimited number of accounts to include.</td>
</tr>
<tr>
<td>Range (B)</td>
<td>Select this option to display a grid for the entry of a range or multiple ranges of account numbers. If you specify a “from” or “to” account number, the other becomes required. You can specify an unlimited number of accounts to include.</td>
</tr>
</tbody>
</table>

**Dates Tab**

The Dates tab allows you to include (or filter) records with a specific date. For example, you can designate that an invoice must have a certain date (or fall into a certain range) for the invoice date, due date, and post date.

<table>
<thead>
<tr>
<th>Name (Type*)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Include Invoices with these Dates (O)</td>
<td>This frame determines the date or date range for the inclusion of invoices.</td>
</tr>
<tr>
<td>Date (R)</td>
<td>Enter the transaction dates of transactions to include in the report. Select an entry from the drop-down list. If you select &lt;Specific range&gt;, the associated date text boxes are visible.</td>
</tr>
<tr>
<td>Start/End (O)</td>
<td>Enter the start and end dates of the &lt;Specific range&gt;.</td>
</tr>
<tr>
<td>Include Invoices with these Due Dates (O)</td>
<td>This frame determines the date or date range for the inclusion of invoices.</td>
</tr>
<tr>
<td>Date (R)</td>
<td>Enter the due dates of invoices to include in the report. Select an entry from the drop-down list. If you select &lt;Specific range&gt;, the associated date text boxes are visible.</td>
</tr>
<tr>
<td>Start/End (O)</td>
<td>Enter the start and end dates of the &lt;Specific range&gt;.</td>
</tr>
<tr>
<td>Include invoices whose discounts will expire in this range (O)</td>
<td>Mark this checkbox to see all invoices that are either due or whose discounts expire within the specified date range. Any invoice that expires in the date range and meets all other criteria appear in the report.</td>
</tr>
</tbody>
</table>
Banks Tab

Use the Banks tab to determine the bank account certain records (such as paid invoices) should be from in order to be included in the report.

<table>
<thead>
<tr>
<th>Name (Type*)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Include Invoices with these Posting Dates</td>
<td>This frame determines the date or date range for the inclusion of invoices with specific posting dates.</td>
</tr>
<tr>
<td>Date (R)</td>
<td>Enter the posting dates of invoices to include in the report. Select an entry from the drop-down list. If you select &lt;Specific range&gt;, the associated date text boxes are visible.</td>
</tr>
<tr>
<td>Start/End (O)</td>
<td>Enter the start and end dates of the &lt;Specific range&gt;.</td>
</tr>
<tr>
<td>Include invoices marked as (R)</td>
<td>Select from Posted, Not posted, and Other. You must select at least one of these options.</td>
</tr>
</tbody>
</table>
**Aging Tab**

The Aging tab allows you to specify the aging periods (set up in Configuration) used to filter the records for this report.

<table>
<thead>
<tr>
<th>Name (Type*)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Aging Period Definition grid (D)</td>
<td>You cannot limit the number of aging periods shown in the report. All four aging periods appear. The information in the aging spread defaults from Configuration. The Aging column description defaults to the short description defined in Configuration. The “to” values and Aging column descriptions are required.</td>
</tr>
</tbody>
</table>

**Attributes Tab**

The Attributes tab allows you to filter records based on attributes defined on the record. This tab is divided into two sections: Include and Exclude.

<table>
<thead>
<tr>
<th>Name (Type*)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Include Invoices Having these Attributes (O)</td>
<td>Mark this checkbox to enable the Include grid and specify attributes to use as “include” filters for the report.</td>
</tr>
</tbody>
</table>
The Projects tab determines which projects to include in the report. This tab appears only if you have *General Ledger’s Project, Grant, and Endowments module*.

<table>
<thead>
<tr>
<th>Name (Type*)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Exclude Invoices Having these Attributes (O)</td>
<td>Mark this checkbox to enable the Exclude grid and specify attributes to use as “exclude” filters for the report.</td>
</tr>
<tr>
<td>Attribute grids (O)</td>
<td>Include and Exclude grids are enabled only if you mark the appropriate checkbox. Select record attributes by highlighting them in a drop-down list displayed by clicking the down arrow in the Category field.</td>
</tr>
</tbody>
</table>

**Format Tab**

The Format tab allows you to designate formatting for the report. Specifically, formatting for headings, criteria, details, page footers, report footers, or miscellaneous options.

<table>
<thead>
<tr>
<th>Name (Type*)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Include Only these Projects (O)</td>
<td>Mark this checkbox to enable the projects boxes. Specify at least one project type to include by using the standard buttons to move from Projects frame to Projects to include frame.</td>
</tr>
</tbody>
</table>
Format Tab: Headings

Access the headings options by selecting **Headings** on the Format tab.

<table>
<thead>
<tr>
<th>Name (Type*)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title (O)</td>
<td>Enter the report title. This field defaults to the standard report name. If you leave this field blank, no title prints.</td>
</tr>
<tr>
<td>Subtitle (O)</td>
<td>Enter text for the report subtitle. This field defaults to blank.</td>
</tr>
<tr>
<td>Align (O)</td>
<td>This field designates the alignment for all headers. The field is disabled if the Title and Subtitle fields are blank and you do not select the Print organization name in header option. Available entries are Left, Center, and Right.</td>
</tr>
<tr>
<td>Print organization name in header (O)</td>
<td>Mark this checkbox to print the organization name on the top line of the report.</td>
</tr>
<tr>
<td>Print Page # in Heading (O)</td>
<td>Mark this checkbox to print the page number as part of the report heading.</td>
</tr>
<tr>
<td>Format (O)</td>
<td>Enabled if the Page # option is selected. Select page number format from the drop-down list.</td>
</tr>
<tr>
<td>Align (O)</td>
<td>This field determines the alignment for the page number. Select from Left, Center, and Right.</td>
</tr>
<tr>
<td>Print Report Date in Heading (O)</td>
<td>Mark this checkbox to print the page number as part of the report heading.</td>
</tr>
<tr>
<td>Format (O)</td>
<td>Select page number format from the drop-down list.</td>
</tr>
<tr>
<td>Align (O)</td>
<td>This field determines the alignment for the page number. Select from Left, Center, and Right.</td>
</tr>
<tr>
<td>Print report heading on each page (O)</td>
<td>Mark this checkbox to print the report heading at the top of each page of the report; otherwise, the heading prints only on the first page.</td>
</tr>
</tbody>
</table>
Format Tab: Criteria

Access the criteria options by selecting Criteria on the Format tab.

<table>
<thead>
<tr>
<th>Name (Type*)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Print Report Criteria (O)</td>
<td>Mark this checkbox to print report criteria on either the first page of the report or on a separate page. You must select one of these options.</td>
</tr>
<tr>
<td>Criteria to print (L)</td>
<td>This grid lists all the report criteria fields and is enabled only if you select Print Report Criteria. You must select at least one item in the checklist.</td>
</tr>
</tbody>
</table>

Format Tab: Detail

Access the detail options by selecting Detail on the Format tab.

Information on this tab varies depending on the specific report functions you are performing. The tab shown below is one that displays most of the possible options.

<table>
<thead>
<tr>
<th>Name (Type*)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Report format (R)</td>
<td>You can print the report in either Detail or Summary format. The default is Detail.</td>
</tr>
</tbody>
</table>
**Format Tab: Page Footer**

Access the page footer options by selecting **Page Footer** on the Format tab.

<table>
<thead>
<tr>
<th>Name (Type*)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Break Down Report by Bank Account (O)</td>
<td>Mark this checkbox to break the report down by bank account, meaning that all transactions associated with a given bank account are listed together. If you select this option, the frames are enabled.</td>
</tr>
<tr>
<td>Define Break header (O)</td>
<td>This option allows you to specify how the bank name appears in the break header. A label underneath these options displays a sample of what you have selected.</td>
</tr>
<tr>
<td>Define Break footer (O)</td>
<td>This option allows you to specify how the bank name appears in the break footer. A label underneath these options displays a sample of what you have selected.</td>
</tr>
<tr>
<td>Print the bank account (O)</td>
<td>This option allows you to print the bank account ID, Description, or both as part of the header.</td>
</tr>
</tbody>
</table>

**Name (Type*) Description**

- **Page footer text (O)**: In this frame, you can enter text to print at the bottom of each page of the report. Maximum length is 254 characters. The Text field defaults to blank.
- **Align (R)**: Align the text you enter. Select from Left, Right, or Center.
- **Print Page # in footer (O)**: Mark this checkbox to print the page number as part of the page footer.
- **Page # Format and Align (R)**: These fields are required if printing page # in footer. Select the page format and alignment from the drop-down list.
- **Print Report Date in Footer (O)**: Mark this checkbox to print the report date as part of the report footer.
- **Report Date Format and Align (R)**: These fields are required if printing report date. Select the date format and alignment.
Format Tab: Report Footer

Access the report footer options by selecting **Report Footer** on the Format tab.

<table>
<thead>
<tr>
<th>Name (Type*)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Report footer text (O)</td>
<td>Enter any text in the field that you want to print at the end of the report. Maximum length is 254 characters.</td>
</tr>
<tr>
<td>Footer text alignment (O)</td>
<td>Select the alignment for the report footer. Select from Left, Center, and Right.</td>
</tr>
</tbody>
</table>

Format Tab: Miscellaneous

Access the miscellaneous options by selecting **Miscellaneous** on the Format tab.
Export Screen

When exporting a report function, you can select many different options for your exported data file. You select the format of and the name for the data file, in addition to designating specifics about the export and the records included. You may also designate whether to have a control report printed and whether to include a header on that report.

The format of the export can be one of several, including but not limited to: Data Interchange Format (DIF), Excel 2.1, 3.0, 4.0, or 5.0 (XLS), Internet Document (HTML), Lotus 1-2-3 (WK1 or WK3), Rich Text Format, Microsoft Word File, etc.

Once you create the export file, a control report appears in a preview window. You can then print the report.

Preferences

All Reports Tab

Report preferences include save and display options, as well as font options and paper orientation.

<table>
<thead>
<tr>
<th>Name (Type*)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Automatically save report parameters (O)</td>
<td>Parameters are automatically saved whenever a report parameter form is closed.</td>
</tr>
</tbody>
</table>
You can access the General Ledger tab from preferences in *Reports*. This tab only appears if you have Blackbaud’s *General Ledger*.

<table>
<thead>
<tr>
<th>Name (Type*)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show only my reports (O)</td>
<td>A user only sees reports created by that user in the main report window.</td>
</tr>
<tr>
<td>Double click preference (O)</td>
<td>These options determine what happens when you double click a saved report from the main report window.</td>
</tr>
<tr>
<td>Font Options (O)</td>
<td>These options allow you to specify fonts and font sizes for your reports. You can apply them to the detail section or to the entire report. You can also choose to use the paper orientation defined for reports or as defined in Print Setup.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Name (Type*)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Omit Header/Total Accounts for one line item (O)</td>
<td>Mark this checkbox to omit header and total accounts on income statements and balance sheets if there is only one line between them.</td>
</tr>
<tr>
<td>Omit Header/Total Accounts if criteria do not match (O)</td>
<td>Mark this checkbox to omit header and total accounts on income statements if they do not match report criteria.</td>
</tr>
</tbody>
</table>
Import

In This Chapter

Import Main Screen .............................................. 269
Import Parameter Files ........................................... 270
Required Import Fields .......................................... 295
  Vendors .................................................................. 295
  Invoice .................................................................. 295
  Recurring Invoice ................................................ 296
  Purchase Order ..................................................... 296
    Purchase Order Line Items ................................... 297
    Purchase Order Miscellaneous Line Items .............. 297
    Purchase Order Comment Line Items .................... 297
  Receipts ................................................................ 297
  Credit Memos ....................................................... 298
  Field Code Names ................................................ 299
**Import** provides you with a single, concise facility to import data into *Accounts Payable* and other Blackbaud *Windows* based programs.

In **Import**, you set up and save import parameter files that you can use repeatedly. The program supports four different import file formats:

- Import file without field names — Separated
- Import file without field names — Fixed Width
- Import file contains header record
- Import file has a separate header record

You have the flexibility, with all four file formats, to define import parameter files that include the fields you need. You can use imported information to create new records and/or update existing records. Both of these functions can be accomplished in one import; however, we do not recommend this since each function imposes different required field limitations.

The four import file formats vary in how the included fields are defined or identified. The simplest and easiest to use format, **Import file without field names — Separated**, differentiates fields by the order they are arranged. You select and order the fields in the parameter file and use text qualifiers and field separators in the import document to identify field boundaries.

The **Import file without field names — Fixed Width** format identifies each field by where the value is placed in a numbered stream of characters.

Two other file formats, **Import file contains header record** and **Import file has a separate header record**, use a header record to identify the imported fields. The only difference between these last two is that one places the header record at the top of the import document and the other has the header record in a separate file.

As you proceed through the import process, you can examine the raw import data before running the actual import. The program also provides an option that allows you to validate record data without actually performing an import.

If you are new to importing, we recommend that you review this entire chapter to gain an understanding of the different import formats. Each format presents different process requirements and limitations that make them more or less suitable to a given situation. Select the format that best suites your needs and establish a set of standard import files for use by your reporting entities. You may also find the import process a quick and efficient means of entering information into your database.

We begin this chapter with a section that describes the **Import** main screen. Following that, the **Import Parameter Files** section describes the procedures and requirements for creating each of the four different imports.

Imports that use a header record require that header record to be defined using field codes. Field codes are established for, and correspond to, the fields in each type of *Account Payable* record. A complete listing of **Required Import Fields** and **Field Code Names** is found at the end of this chapter just before the **Reference** section.
The steps of creating an import vary depending on the record type. The following diagram identifies the steps involved in the creation of an import file. An “X” in the column below an import format signifies a required action.

| Action                                                      | Separated
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Select/Order desired import fields including record identifier</td>
<td>X (Import file does not contain field names)</td>
</tr>
<tr>
<td>Select text qualifier and separator</td>
<td>X</td>
</tr>
<tr>
<td>Create header record</td>
<td>X</td>
</tr>
<tr>
<td>Define field lengths and overall record length</td>
<td>X</td>
</tr>
</tbody>
</table>

**Import Main Screen**

The main screen of *Import* is a list view screen with folders for program names and record types listed in the left box and parameter files listed in the right box. The screen also provides a description of the highlighted item which is displayed across the bottom.

*Import* is a shared Blackbaud module. This means that you can use it with more than one Blackbaud program. On the main screen, a folder appears on the left for each Blackbaud program present in the database with *Import* capabilities. When you open a program folder, additional folders appear for each record type associated with that program.
**Accounts Payable** has 10 record types: **Vendors**, **Invoices**, **Recurring Invoices**, **Credit Memos**, **Purchase Orders**, **Receipts**, **PO Line Items**, **PO Misc Line Items**, **PO Comment Line Items**, and **Receipt Line Items**. For each record type you can create and save for reuse multiple parameter files. The parameter file determines what information is included in the import and how the import file is structured.

## Import Parameter Files

Each parameter file includes a series of tabs. Whenever a record type folder is highlighted, both the Add a new and saved import parameter files appear in the right box. You can create a new parameter file by highlighting the record type and selecting File, New or double clicking the Add a new icon.

There are three ways to open an existing parameter file:
- Double click the parameter file icon,
- Highlight the parameter file and select File, Open, or
- Right click the icon to access the shortcut menu and select Open.

From the parameter file, the View Data button accesses the browse screen so you can review the contents of the import file. This button is enabled when you select a file name.

The Import Now button begins the import process. For new parameters, this button is only available on the last screen.

Since you must complete the Import wizard sequentially when you are defining new parameters, the tabs appear as you step through the screens. When you open a new parameter file, only the first tab is available, then when you click Next the second tab displays.

A saved parameter file has all available tabs displayed, based on the type of import.

The program supports four different import file formats:
- Import file without field names – Separated
Import File Without Field Names - Separated

Creating an import file without field names is probably the easiest of the four types to accomplish. Even though you are not required to create a header or define field or record lengths, the procedure still requires the import document and parameter file formats match. The import parameter file is established to reflect the format of the import document. This procedure guides you through establishing import parameters.

The fields to be imported are selected and ordered on the Fields tab. The order of the import fields on the Fields tab must match the arrangement of field values in the import file. On the File Format tab, you select a separator and text qualifier. The separator is used in the import file as a break between import fields. The text qualifier identifies the actual field value to be imported.

The fields you select to import, in the order they are listed on the Fields tab, with the separators and text qualifiers you choose on the File Format tab, determine the required format of record information in the import document.

- Creating an import file without field names - Separated
  1. From Import, open the Accounts Payable folder on the left side of the screen. Highlight the record type for which you are importing information. The parameter files appear on the right.
  2. On the left, highlight the desired record type and select File, New or double click the Add a new <record type> Import icon on the right. For the purpose of explaining the procedure, we use the record type Vendors.
3. However, the procedure is similar for each record type. The Options tab appears.

4. Mark the checkboxes if you want to **Create new Vendor records (import information)** and/or **Overwrite existing Vendor records (update information)**. If you mark **Create new Vendor records (import information)**, the import must include the required fields for that record type. If you are updating existing records, a record identifier must be included in each import record. See the Required Import Fields section.

5. Mark the option to indicate you want the program to **Automatically create a new table entry** or **Do not create a new table entry and process the record as an exception** in the case where a table entry does not exist.

6. Mark the **Validate Vendor data without performing an import** checkbox if you want the program to validate vendor data without performing an import to examine the data in the import file and ensure its compatibility with the import process.

7. Mark the **Create an output query of Vendors that are imported** checkbox if you want to create a query of records that are imported.

8. Mark the **Create an output query of Vendors that are updated** checkbox if you want to create a query of records that are updated.

9. Mark the **Create a control report** checkbox if you want to create a control report of the import process, once it takes place. When marked, you have the option to **Include exception detail**. Mark this option to have detail information about any import exceptions that appear on the control report.
10. Click Next. The File Format tab appears.

11. Enter the file path and name or click the browse icon to locate and select the file to import. You must format import files must as *.txt, *.csv, or *.prn files.

12. In the Import File Format frame, select Import file does not contain field names. Select field names in Step 3.

13. Mark Fields are Separated by Characters. Mark the checkbox for those characters you want to use as field separators in the import document. If you select Other, enter the character.

14. In the Text qualifier field, select Quotation, Apostrophe, {Custom}, or {None}. If you select {Custom}, enter the qualifier of your choice. The Text qualifier is used in the import document to identify the field text to be imported.

Example: Select Semicolon as a separator and Quotation as a Text qualifier on the File Format tab. On the Fields tab, move Vendor Name, Address, and ZIP to the Import these vendor fields box. With these selections the import document has to be formatted as follows to complete a successful import:

“Smith Supply”;“123 American St”;“29887”

The other two options in the Import File Format frame are used in other procedures described later in this chapter. The import document must be formatted using the separator and text qualifier you select here. The import values must also be arranged in the order you set the field names on the Fields tab.
15. Click **Next**. The Fields tab appears.

16. If updating existing records, select **Import ID** or **Vendor ID** to match records. Available options only include those fields that you identify as included in the import. If your import only includes **Vendor ID**, then that will be the only option available in this field.

17. Select the fields you want to import in the order in which they appear in the import file. To select a field, highlight the field in the **Vendor fields** box and use the arrow button to move the field to the **Import these vendor fields** box. You can click **Browse** to view a complete list of field values currently in the database.

18. If you select the Account Distribution field, the following screen appears.
19. In the **Repeat the fields ___ times per line in the import file**, enter or scroll to the number of accounts to which you are distributing. The fields you select in the next step are duplicated this number of times in the import.

20. Move the fields necessary to properly distribute the import. Refer to the **Required Import Fields** section for minimum requirements. Fields must be arranged in the order in which they appear in the import.

21. Click **OK** to return to the Fields tab. Click **Next**. The Summary screen appears.

22. Click **View Data** to examine the import information in the specified import file.
23. Verify the information is correct and click **Close** to return to the Summary tab. You can click **View Data** from any tab after an import file has been selected.

24. You can also click **Find** on the View Import Data screen to locate a specific field value in the data display. The following screen appears.

![Find Screen](image)

25. Select the **Field** for which you want to locate a value.

26. In the **Find what** field, enter the value you want to locate and click **Find First**. If this value is in multiple fields, click **Find Next** until the desired record is located.

27. Click **Close** to return to the View Import Data screen. At this point you can click either **Save** or **Import Now**.

28. Click **Save** to save the import parameter file. The following screen appears.

![Save Import As Screen](image)

29. Enter a **Name** and **Description** for the parameter file. Use this option to save your parameter file for later use.

30. Mark the checkboxes if you want to allow others to run and/or modify this import and click **Save**.
31. Click **Import Now** to begin the import process. The following screen appears.

32. Enter a **Name** and **Description** for the parameter file.

33. Mark the checkboxes if you want to allow others to run and/or modify this import. Click **Save and Import** or **Import without Saving**.

**Import File Without Field Names - Fixed Width**

You must already have an import document formatted and ready to import to complete this procedure. Review the information in this section and create a sample import document to test your import file content requirements. Start with a simple record and expand until you have a usable parameter file established. Remember to allow a sufficient number of characters for fields with variable size values such as a name or address field. Fill unused characters with spaces.

When you import information with the fixed width format, you must select and order the desired import fields. You also must assign each record a set number of characters. This type of import does not use separators or text qualifiers. It differentiates the fields of a record by location in a character stream of established proportions. An import record is made up of the individual fields pertaining to each individual or organization. You decide how many characters are in a record. An import document can contain one or many records.

Field names are selected and ordered on the Fields tab. The order of the import fields on the Fields tab must match the arrangement of field values in the import file. The size (number of characters) of individual fields within a record is established on the File Layout tab.

> **Creating an import file without field names - Fixed Width**

1. From **Import**, open the **Accounts Payable** folder on the left. Highlight the record type for which you are importing. The parameter files appear at right.

2. Double click **Add a new <record type> Import**.
3. For the purpose of explaining the procedure, we use the record type Vendors; however, the procedure is the same for each record type. The Options tab appears.

4. Mark the checkboxes if you want to Create new Vendor records (import information) and/or Overwrite existing Vendor records (update information). If you mark Create new Vendor records (import information) checkbox, the import must include the required fields for the selected record type. If you are updating existing records, a record identifier must be included in each import record. See the Required Import Fields section later in this chapter.

5. Mark the option to indicate you want the program to Automatically create a new table entry or Do not create a new table entry and process the record as an exception in the case where a table entry does not exist.

6. Mark the Validate Vendor data without performing an import checkbox to validate vendor data without performing an import to examine the data in the import file and ensure its compatibility with the import process.

7. Mark the Create a control report checkbox if you want to create a control report of the import process, once it takes place. When marked, you have the option to Include exception detail. Mark this option to have detail information about any import exceptions that appear on the control report.
8. Click Next. The File Format tab appears.

9. Enter the file path and name or browse to find the import file. Import files must be formatted as *.txt, *.csv, or *.prn files.

10. Mark Import file does not contain field names. Select field names in Step 3.

11. Mark Fields have fixed widths and the Record is ___ characters wide and enter the total number of characters in the import record(s).

Example: On the File Format tab, select the Fields have fixed widths and the Record is ___ characters wide option. Enter 34 in the number field to import new vendor records with 13 characters in the Vendor Name field, 16 in Address, and 5 in ZIP. On the Fields tab, move Vendor Name, Address, and ZIP to the Import these vendor fields box. With these selections the import document has to be formatted as follows to complete a successful import:

Smith Supply 123 American St 29887
Jones Supply 246 Constitution 29887

Notice that there are no spaces between the end of one record and the beginning of the next.
12. Click Next. The Fields tab appears.

13. Select the fields to import and the order in which they appear in the import file. If updating existing records, select Import ID or User Defined ID as an identifier to match records in the import with records in Accounts Payable.

The identifier you select to match records must be one of the fields contained in the import document.

14. If you select the Account Distribution field, the following screen appears.

15. In the Repeat the fields ___ times per line in the import file, enter or scroll to the number of accounts to which you are distributing. The fields you select in the next step are duplicated this number of times in the import.

16. Move the fields necessary to properly distribute the import. Refer to the Required Import Fields section on page 295 for minimum requirements. Fields must be arranged in the order in which they appear in the import.
17. Click **OK** to return to the Fields tab.

18. Click **Next**. The File Layout tab appears.

![Field Definition Grid]

19. The Field Distribution grid lists the fields you have selected to import. The first records in the import document are displayed in the **Import Record Display** with each character numbered. The number you entered as the total number of characters in each record is shown in parenthesis above the display.

20. For each **Field**, enter the field **Width** as displayed in the **Import Record Display**. If you discover that you need to increase the total number of characters defined for the overall width, you can return to the File Format tab and increase the number you entered.
21. Click **Next**. The Summary tab appears.

22. Check the summary information to ensure import parameters and information is set up properly.

23. Click **View Data** to view the import information from the specified import file.

24. Verify the information is correct and click **Close** to return to the Summary tab. You can click **View Data** from any tab after an import file has been selected.
25. You can also click **Find** on the View Import Data screen to locate a specific field value in the data display. The following screen appears.

![Find Screen](Image)

26. Select the **Field** for which you want to locate a value.

27. In the **Find what** field, enter the value you want to locate and click **Find First**. If this value is in multiple fields, click **Find Next** until the desired record is located.

28. Click **Close** to return to the View Import Data screen. At this point you can click either **Save** or **Import Now**.

29. Click **Save** to save the import parameter file. The following screen appears.

![Save Import As Screen](Image)

30. Enter a **Name** and **Description** for the parameter file. Use this option to save your parameter file for later use.

31. Mark the checkboxes if you want to allow others to run and/or modify this import and click **Save**.

32. Click **Import Now** to begin the import process. The following screen appears.

![Save Import As Screen](Image)

33. Enter a **Name** and **Description** for the parameter file.

34. Mark the checkboxes if you want to allow others to run and/or modify this import.
35. Click **Save and Import** or **Import without Saving**.

**Import File Containing a Header Record**

You must already have an import document formatted and ready to import to complete this procedure. Review the information in this section and create a sample import document to test your import file content requirements. Start with a simple record and expand until you have a usable parameter file established.

Use this procedure to import record information where the record fields are defined in the first line of the import document. The header record identifies the fields to which you are importing information. The header record is located on the first line of the import document. Following that, you create import records using the same format and sequence as the header record. Each import record contains field values for one individual or organization and must contain at least one of the three record identifiers - `<record type>` ID, SSN, or import ID. Use the field code names listed at the end of this chapter, with the separators and text qualifiers you define on the File Format tab, to create the header record in the import document.

- **Create an import file containing a header record**

  1. From **Import**, open the Accounts Payable folder on the left. Highlight the record type for which you are importing information. The parameter files appear at right.

  2. Double click **Add a new `<record type>` Import**. For the purpose of explaining the procedure, we use the record type Vendors. However, the procedure is the same for each record type. The Options tab appears.
3. Mark the checkboxes if you want to **Create new Vendor records (import information)** and/or **Overwrite existing Vendor records (update information)**. If you mark **Create new Vendor records (import information)** checkbox, the import must include the required fields for the selected record type. If you are updating existing records, a record identifier must be included in each import record. See the **Required Import Fields** section on page 295.

4. Mark the option to indicate you want the program to **Automatically create a new table entry** or **Do not create a new table entry and process the record as an exception** in the case where a table entry does not exist.

5. Mark the **Validate Vendor data without performing an import** checkbox if you want the program to validate vendor data without performing an import to examine the data in the import file and ensure its compatibility with the import process.

6. Mark the **Create an output query of Vendors that are imported** checkbox if you want to create a query of records that are imported.

7. Mark the **Create an output query of Vendors that are updated** checkbox if you want to create a query of records that are updated.

8. Mark the **Create a control report** checkbox if you want to create a control report of all the import process, once it takes place. When marked, you have the option to **Include exception detail**. Mark this option to have detail information about any import exceptions that appear on the control report.

9. Click **Next**. The File Format tab appears.

10. Enter the file path and name or click the browse icon to locate and select the file.
11. In the **Import File Format** frame, select **Field names are on the first line of the import file**.

12. The **Fields have Fixed Widths and the Record is ___ characters wide** option becomes disabled.

13. In the **Fields are Separated by Characters** frame, Mark the checkbox for those characters you want to use as a separator. If you select **Other**, enter the character.

14. In the **Text qualifier** field, select from **Quotation**, **Apostrophe**, {Custom}, or {None}. If you choose {Custom}, enter the qualifier of your choice.

   **Example:** Select **Semicolon** as a separator and **Quotation** as a Text Qualifier on the File Format tab. To import a vendor’s name, address, and ZIP enter the following header on the first line of the import document:

   “VENDOR _NAME”; “ADDRESS”; “ZIP”

15. Below that, enter the vendor’s information using the same separator and qualifier as follows:

   “Smith Supply”; “123 American St”; “29887”

   Notice that each separator is followed by a space, both in the header and in the import record. This is required for the import to function properly.

16. If you select to include an Account Distribution in the import, add the selected fields to the end of the header and each record. To distribute an amount to two different accounts, add the following to the end of the header record:

   “ACCT_ACCOUNT_NO._1”; “ACCT_AMOUNT_1”; “ACCT_ACCOUNT_NO._2”; “ACCT_AMOUNT_2”

17. Notice that the import field names are duplicated once for each distribution. The number at the end of the field name groups the fields into specific distributions. To further distribute the import, repeat the field names and change the last number.

18. In each import record, add the distribution information in the same order. The following sample of the Account Distribution portion of an import record shows $1000 distributed evenly between two GL accounts.

   “01-54010-10”; “500”; “01-54030-15”; “500”
19. Click Next. The Fields tab appears.

20. Review the import file field names and descriptions as they are listed in the grid. If you need to make corrections to the import file, you can do so before importing into Accounts Payable.

21. When updating existing records, select a record identifier in the Use field. The record identifier is a field in the import used to match imported information to your existing records.

22. Click Next. The Summary screen appears.
23. View the import parameters to determine if the import is set up correctly.
24. Click **View Data** to view the import information from the specified import file.

![View Import Data](image)

25. Verify the information is correct and click **Close** to return to the Summary tab. You can click **View Data** from any tab after an import file has been selected.

26. You can also click **Find** on the View Import Data screen to locate a specific field value in the data display. The following screen appears.

![Find](image)

27. Select the **Field** for which you want to locate a value.

28. In the **Find what** field, enter the value you want to locate and click **Find First**. If this value is in multiple fields, click **Find Next** until the desired record is located.

29. Click **Close** to return to the View Import Data screen. At this point you can click either **Save** or **Import Now**.
30. Click **Save** to save the import parameter file. The following screen appears.

![Save Import As](image)

31. Enter a **Name** and **Description** for the parameter file. Use this option to save your parameter file for later use.

32. Mark the checkboxes if you want to allow others to run and/or modify this import and click **Save**.

33. Click **Import Now** to begin the import process. The following screen appears.

![Save Import As](image)

34. Enter a **Name** and **Description** for the parameter file.

35. Mark the checkboxes if you want to allow others to run and/or modify this import.

36. Click **Save and Import** or **Import without Saving**.

### Import File With a Separate Header Record

You must already have an import document formatted and ready to import to complete this procedure. Review the information in this section and create a sample import document to test your import file content requirements. Start with a simple record and expand until you have a usable parameter file established.

Use this procedure to import record information where the record fields are defined in a file other than the import document. The header and import records are formatted just as in the previous procedure except the header record is located in a separate file. Use the field code names listed at the end of this chapter with the separators you define on the File Format tab to format the header record and import document.
Create an import file with a separate header record

1. From Import, open the Accounts Payable folder on the left. Highlight the record type for which you are importing information. The parameter files appear at right.

2. Double click Add a new <record type> Import. For the purpose of explaining the procedure we use the record type Vendors. However, the procedure is the same for each record type. The Options tab appears.

3. Mark the checkboxes if you want to Create new Vendor records (import information) and/or Overwrite existing Vendor records (update information). If you mark Create new Vendor records (import information) checkbox, the import must include the required fields for the selected record type. If you are updating existing records, a record identifier must be included in each import record. See the Required Import Fields section.

If Overwrite existing <type> records is marked, all records in the import must contain a record identifier. Clear this checkbox when only creating new records. Both options can be selected at the same time; however we recommend that you perform only one of these operations in each import.

4. Mark the option to indicate you want the program to Automatically create a new table entry or Do not create a new table entry and process the record as an exception in the case where a table entry does not exist.

5. Mark the Validate Vendor data without performing an import checkbox if you want the program to validate vendor data without performing an import to examine the data in the import file and ensure its compatibility with the import process.

6. Mark the Create an output query of Vendors that are imported checkbox if you want to create a query of records that are imported.

3. Mark the checkboxes if you want to Create new Vendor records (import information) and/or Overwrite existing Vendor records (update information). If you mark Create new Vendor records (import information) checkbox, the import must include the required fields for the selected record type. If you are updating existing records, a record identifier must be included in each import record. See the Required Import Fields section.

If Overwrite existing <type> records is marked, all records in the import must contain a record identifier. Clear this checkbox when only creating new records. Both options can be selected at the same time; however we recommend that you perform only one of these operations in each import.

4. Mark the option to indicate you want the program to Automatically create a new table entry or Do not create a new table entry and process the record as an exception in the case where a table entry does not exist.

5. Mark the Validate Vendor data without performing an import checkbox if you want the program to validate vendor data without performing an import to examine the data in the import file and ensure its compatibility with the import process.

6. Mark the Create an output query of Vendors that are imported checkbox if you want to create a query of records that are imported.
7. Mark the **Create an output query of Vendors that are updated** checkbox if you want to create a query of records that are updated.

8. Mark the **Create a control report** checkbox if you want to create a control report of all the import process, once it takes place. When marked, you have the option to **Include exception detail**. Mark this option to have detail information about any import exceptions that appear on the control report.

9. Click **Next**. The File Format tab appears.

10. Enter the file path and name or click the browse icon to locate and select the file.

11. Import files must be formatted as *.txt, *.csv, or *.prn files.

12. In the **Import File Format** frame, select **Field names are in a separate file**, and enter the file path and name. You can use the browse button to locate the appropriate file. When this option is marked, the **Fields have Fixed Widths and the Record is ___ characters wide** option is disabled.

13. In the **Fields are Separated by Characters** frame. Mark the checkbox for those characters you want to use as a separator. If you select **Other**, enter the character.

14. In the **Text qualifier** field, select from **Quotation, Apostrophe, {Custom}, or {None}**. If you choose **{Custom}**, enter the qualifier of your choice.

   **Example:** Select **Semicolon** as a separator and **Quotation** as a **Text Qualifier** on the File Format tab. To import a vendor name, address, and ZIP, enter the following header on the first line of the header document:

   "VENDOR_NAME"; "ADDRESS"; "ZIP"
15. On the import document, enter the vendor’s information using the same separator and qualifier as follows:

“Smith Supply”; “123 American St”; “29887”

Notice that each separator is followed by a space, both in the header and in the import record. This is required for the import to function properly.

16. If you select to include an Account Distribution in the import, add the selected fields to the end of the header and each import record. To distribute an amount to two different accounts, add the following to the end of the header record:

“ACC_ACCOUNT_NO._1”; “ACC_AMOUNT_1”; “ACC_ACCOUNT_NO._2”; “ACC_AMOUNT_2”

17. Notice that the import field names are duplicated once for each distribution. The number at the end of the field name groups the fields into specific distributions. To further distribute the import, repeat the field names and change the last number.

18. In each import record, add the distribution information in the same order. The following sample of the Account Distribution portion of an import record shows $1000 distributed evenly between two GL accounts.

“01-54010-10”; “500”; “01-54030-15”; “500”

19. Click Next. The Fields tab appears. There are two versions of this screen depending on the import file format information you designated on the File Format tab. The following screen appears if the field names are in a separate file.

20. Review the import file field names and descriptions as they are listed in the grid. If you need to make corrections to the import file, you can do so before importing into Accounts Payable.
21. When updating existing records, select a record identifier in the **Use** field. The record identifier is a field in the import used to match imported information to your existing records.

22. Click **Next**. The Summary screen appears.

23. Review the import parameters to determine if the import is set up correctly.

24. You can also click **View Data** to view the import information from the specified import file.

25. Verify the information is correct and click **Close** to return to the Summary tab. You can click **View Data** from any tab after an import file has been selected.
26. You can also click **Find** on the View Import Data screen to locate a specific field value in the data display. The following screen appears.

![Find Screen](image)

27. Select the **Field** for which you want to locate a value.

28. In the **Find what** field, enter the value you want to locate and click **Find First**. If this value is in multiple fields, click **Find Next** until the desired record is located.

29. Click **Close** to return to the View Import Data screen. At this point you can click either **Save** or **Import Now**.

30. Click **Save** to save the import parameter file. The following screen appears.

![Save Import As](image)

31. Enter a **Name** and **Description** for the parameter file. Use this option to save your parameter file for later use.

32. Mark the checkboxes if you want to allow others to run and/or modify this import and click **Save**.

33. Click **Import Now** to begin the import process. The following screen appears.

![Save Import As](image)

34. Enter a **Name** and **Description** for the parameter file.

35. Mark the checkboxes if you want to allow others to run and/or modify this import. Click **Save and Import** or **Import without Saving**.
Viewing an import data file

1. From Import, open the Accounts Payable folder on the left side of the screen. Highlight the import type and select File, New from the menu. The Import <record type> screen appears.

2. Click Next to view the File Format tab. Enter the File name or click the browse icon to find the import file.

3. Click View Data to view the import information from the specified import file.

Required Import Fields

This section provides a listing of the import fields required for each type of import. The required fields for each record type are listed separately for easy reference. Import requirements are determined by the type of record for which you are importing data. The import process works with most any combination of import fields that you select; however, unless the required fields are imported, the program will not create or update your records.

You can use imported information to create new records or update existing records. The required fields for these two functions are normally very different. Because of these differences we recommend that you perform these two functions in separate imports. When you are creating a new record, you must import the fields required to create and save a record as if you are doing so from your own computer terminal. To update an existing record, all that is normally required is the record Import ID or record number and the fields you desire to update.

The <Record Type>Import ID for a particular record can be identified by opening the record and selecting File, Properties. The User-defined ID is the <Record Type> ID, such as a Vendor ID, found in the each record.

The following are minimum requirements for importing information in to Accounts Payable.

Vendors

The following field is required to create a new vendor record:

Vendor Name

If you are updating existing records, one of the following fields must be included in the import record:

Vendor Import ID
Vendor ID

If Phone # is selected, Phone Type is required.

If Attribute is selected, Attribute Category and Attribute Description are required.

Invoice

The following fields are required to create a new invoice record:
Vendor Import ID or Vendor ID (This is the record to which you are adding an invoice.)
Invoice Amount (Amount Due)
Account Distribution
  (GL) Account Number
  Amount or Percent
Invoice Date
Date Due
Bank ID
Post Status
Remit to
Payment method
Post Date is required if Post Status is Not Yet Posted.
If Attribute is selected, Attribute Category and Attribute Description are required.
If you are updating existing invoice records, the following field must be included in the import record:
Invoice Import ID
Also, the Invoice amount field must be left blank.

Recurring Invoice

The following fields are required to create a new recurring invoice record:
Vendor Import ID or Vendor ID (This is the record to which you are adding a recurring invoice.)
Amount Due
Account Distribution
  (GL) Account Number
  Amount or Percent
Bank ID
Default Post Status
If Attribute is selected, Attribute Category and Attribute Description are required.
If you are updating existing invoice records, the following field must be included in the import record:
Invoice Import ID
Invoice #

Purchase Order

The following fields are required to create a new purchase order record:
Vendor Import ID or Vendor ID (This is the record to which you are adding a purchase order.)
Order Date
Bank ID
PO Type
Status
If Attribute is selected, Attribute Category and Attribute Description are required.

For a blanket purchase order Expires On is a required field.

If you are updating existing purchase order records, one of the following fields must be included in the import record:

- PO 
- Purchase Order Import ID

### Purchase Order Line Items

The following fields are required to create a new purchase order line item:

- Unit of Measure
- Quantity Ordered
- Unit Cost
- Account Distribution
  - (GL) Account Number
  - Amount or Percent
- Description
- Post Status
- PO Type
- Order Status
- Post Date is required if Post Status is Not Yet Posted.

If you are updating existing line items, the following field must be included in the import record:

- Line Item Import ID

### Purchase Order Miscellaneous Line Items

The required import fields for a PO Misc Line Item are Import ID, PO #, Amount, Description, Misc code ID, Post date, and Post status, as well as the standard account distribution fields.

### Purchase Order Comment Line Items

The required import fields for a PO Comment Line Item are Import ID, PO #, and Comment.

### Receipts

The following fields are required to create a new receipt record:

- Extended Cost
- Purchase Order Number
- Purchase Order Import ID
- Received By
- Receipt Date

If you are updating existing receipt records, the following field must be included in the import record:

- Receipt Import ID
Credit Memos

The following fields are required to create a new credit memo record:

**Vendor Import ID** or **Vendor ID** (This is the record to which you are adding a credit memo.)

Credit Date

Credit Amount

Account Distribution

(4L) Account Number

Amount or Percent

Bank ID

Post Status

**Post Date** is required if Post Status is Not Yet Posted.

If you are updating existing credit memo records, the following field must be included in the import record:

Credit Memo Import ID
Field Code Names

Use the field code names listed below with the separators you define on the File Format tab to format the header and import records. These field code name are only used when creating imports that use a header record.

<table>
<thead>
<tr>
<th>Code Description</th>
<th>Field Code</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Vendors</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Vendor</strong></td>
<td></td>
</tr>
<tr>
<td>Credit Limit</td>
<td>CREDIT_LIMIT</td>
</tr>
<tr>
<td>Discount Days</td>
<td>DISCOUNT_DAYS</td>
</tr>
<tr>
<td>Discount Percent</td>
<td>DISCOUNT_PERCENT</td>
</tr>
<tr>
<td>Due Days</td>
<td>DUE_DAYS</td>
</tr>
<tr>
<td>Has Credit Limit</td>
<td>HAS_CREDIT_LIMIT</td>
</tr>
<tr>
<td>One check per invoice</td>
<td>ONE_CHECK_PER_INVOICE</td>
</tr>
<tr>
<td>Tax ID</td>
<td>TAX_ID</td>
</tr>
<tr>
<td>Vendor ID</td>
<td>VENDOR_ID</td>
</tr>
<tr>
<td>Vendor on hold</td>
<td>VENDOR_ON_HOLD</td>
</tr>
<tr>
<td>Import ID</td>
<td>IMPORT_ID</td>
</tr>
<tr>
<td><strong>1099 Information</strong></td>
<td></td>
</tr>
<tr>
<td>1099 Address</td>
<td>1099_ADDRESSES</td>
</tr>
<tr>
<td>1099 City</td>
<td>1099_CITY</td>
</tr>
<tr>
<td>1099 Country</td>
<td>1099_COUNTRY</td>
</tr>
<tr>
<td>1099 Name</td>
<td>1099_NAME</td>
</tr>
<tr>
<td>1099 Name 2</td>
<td>1099_NAME_2</td>
</tr>
<tr>
<td>1099 State</td>
<td>1099_STATE</td>
</tr>
<tr>
<td>1099 Vendor</td>
<td>1099_VENDOR</td>
</tr>
<tr>
<td>1099 Zip</td>
<td>1099_ZIP</td>
</tr>
<tr>
<td>Default Box #</td>
<td>DEFAULT_BOX_#</td>
</tr>
<tr>
<td>Code Description</td>
<td>Field Code</td>
</tr>
<tr>
<td>----------------------------------</td>
<td>---------------------------</td>
</tr>
<tr>
<td><strong>Biographical</strong></td>
<td></td>
</tr>
<tr>
<td>Alias</td>
<td>ALIAS</td>
</tr>
<tr>
<td>First Name</td>
<td>FIRST_NAME</td>
</tr>
<tr>
<td>Last Name</td>
<td>LAST_NAME</td>
</tr>
<tr>
<td>Position</td>
<td>POSITION</td>
</tr>
<tr>
<td>Print Position</td>
<td>PRINT_POSITION</td>
</tr>
<tr>
<td>Suffix</td>
<td>SUFFIX</td>
</tr>
<tr>
<td>Suffix 1</td>
<td>SUFFIX_1</td>
</tr>
<tr>
<td>Suffix 2</td>
<td>SUFFIX_2</td>
</tr>
<tr>
<td>Title</td>
<td>TITLE</td>
</tr>
<tr>
<td>Title 1</td>
<td>TITLE_1</td>
</tr>
<tr>
<td>Title 2</td>
<td>TITLE_2</td>
</tr>
<tr>
<td>Vendor Name</td>
<td>VENDOR_NAME</td>
</tr>
<tr>
<td><strong>Address</strong></td>
<td></td>
</tr>
<tr>
<td>Address</td>
<td>ADDRESS</td>
</tr>
<tr>
<td>City</td>
<td>CITY</td>
</tr>
<tr>
<td>Country</td>
<td>COUNTRY</td>
</tr>
<tr>
<td>State</td>
<td>STATE</td>
</tr>
<tr>
<td>ZIP</td>
<td>ZIP</td>
</tr>
<tr>
<td><strong>Phones</strong></td>
<td></td>
</tr>
<tr>
<td>Phone #</td>
<td>PHONE_#</td>
</tr>
<tr>
<td>Phone Type</td>
<td>PHONE_TYPE</td>
</tr>
<tr>
<td><strong>Bank</strong></td>
<td></td>
</tr>
<tr>
<td>Account #</td>
<td>ACCOUNT_#</td>
</tr>
<tr>
<td>Account Type</td>
<td>ACCOUNT_TYPE</td>
</tr>
<tr>
<td>Allow Electronic Payments</td>
<td>ALLOW_ELECTRONIC_PAYMENTS</td>
</tr>
<tr>
<td>Bank Address</td>
<td>BANK_ADDRESS</td>
</tr>
<tr>
<td>Bank City</td>
<td>BANK_CITY</td>
</tr>
<tr>
<td>Code Description</td>
<td>Field Code</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>------------------------------</td>
</tr>
<tr>
<td>Bank Country</td>
<td>BANK_COUNTRY</td>
</tr>
<tr>
<td>Bank Name</td>
<td>BANK_NAME</td>
</tr>
<tr>
<td>Bank Notes</td>
<td>BANK_NOTES</td>
</tr>
<tr>
<td>Bank Phone Number</td>
<td>BANK_PHONE_NUMBER</td>
</tr>
<tr>
<td>Bank Phone Type</td>
<td>BANK_PHONE_TYPE</td>
</tr>
<tr>
<td>Bank State</td>
<td>BANK_STATE</td>
</tr>
<tr>
<td>Bank Zip Code</td>
<td>BANK_ZIP_CODE</td>
</tr>
<tr>
<td>Default Payment Method</td>
<td>DEFAULT_PAYMENT_METHOD</td>
</tr>
<tr>
<td>Discretionary code</td>
<td>DISCRETIONARY_CODE</td>
</tr>
<tr>
<td>Routing #</td>
<td>ROUTING_#</td>
</tr>
</tbody>
</table>

**Attributes**

- Attribute Category: ATTRIBUTE_CATEGORY
- Attribute Comments: ATTRIBUTE_COMMENTS
- Attribute Date: ATTRIBUTE_DATE
- Attribute Description: ATTRIBUTE_DESCRIPTION

**Invoices**

**Invoice**

- Bank ID: BANK_ID
- Date Due: DATE_DUE
- Description: DESCRIPTION
- Discount Amount: DISCOUNT_AMOUNT
- Discount Expiration Date: DISCOUNT_EXPIRATION_DATE
- Discount Percent: DISCOUNT_PERCENT
- Hold Payment: HOLD_PAYMENT
- Invoice #: INVOICE_#
- Invoice Amount: INVOICE_AMOUNT
- Invoice Date: INVOICE_DATE
- Invoice Import ID: INVOICE_IMPORT_ID
- Notes: NOTES
<table>
<thead>
<tr>
<th>Code Description</th>
<th>Field Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>Payment Method</td>
<td>PAYMENT_METHOD</td>
</tr>
<tr>
<td>PO#</td>
<td>PO_#</td>
</tr>
<tr>
<td>Post Date</td>
<td>POST_DATE</td>
</tr>
<tr>
<td>Post Status</td>
<td>POST_STATUS</td>
</tr>
<tr>
<td>Inactive</td>
<td>INACTIVE</td>
</tr>
<tr>
<td>Invoice #</td>
<td>INVOICE_#</td>
</tr>
<tr>
<td>Invoice Amount</td>
<td>INVOICE_AMOUNT</td>
</tr>
<tr>
<td>Invoice Import ID</td>
<td>INVOICE_IMPORT_ID</td>
</tr>
<tr>
<td>Notes</td>
<td>NOTES</td>
</tr>
<tr>
<td>Number of Invoices</td>
<td>NUMBER_OF_INVICES</td>
</tr>
<tr>
<td>Payment Method</td>
<td>PAYMENT_METHOD</td>
</tr>
<tr>
<td>Post Date</td>
<td>POST_DATE</td>
</tr>
<tr>
<td>PO #</td>
<td>PO_#</td>
</tr>
<tr>
<td>Remit To</td>
<td>REMIT_TO</td>
</tr>
<tr>
<td>Vendor Import ID</td>
<td>VENDOR_IMPORT_ID</td>
</tr>
<tr>
<td>Vendor ID</td>
<td>VENDOR_ID</td>
</tr>
</tbody>
</table>

**Attributes**

<table>
<thead>
<tr>
<th>Attribute Comments</th>
<th>ATTRIBUTE_COMMENTS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Attribute Date</td>
<td>ATTRIBUTE_DATE</td>
</tr>
<tr>
<td>Attribute Description</td>
<td>ATTRIBUTE_DESCRIPTION</td>
</tr>
<tr>
<td>Attribute Type ID</td>
<td>ATTRIBUTE_TYPE_ID</td>
</tr>
<tr>
<td>Attribute Category</td>
<td>ATTRIBUTE_CATEGORY</td>
</tr>
</tbody>
</table>

**Account Distribution**

<table>
<thead>
<tr>
<th>Account No.</th>
<th>ACCT_ACCOUNT_NO_&lt;number&gt;</th>
</tr>
</thead>
<tbody>
<tr>
<td>Percent</td>
<td>ACCT_PERCENT_&lt;number&gt;</td>
</tr>
<tr>
<td>Amount</td>
<td>ACCT_AMOUNT_&lt;number&gt;</td>
</tr>
<tr>
<td>Project ID</td>
<td>ACCT_PROJECT_ID_&lt;number&gt;</td>
</tr>
<tr>
<td>Transfer</td>
<td>ACCT_TRANSFER_&lt;number&gt;</td>
</tr>
<tr>
<td>Comment</td>
<td>ACCT_COMMENT_&lt;number&gt;</td>
</tr>
<tr>
<td>Code Description</td>
<td>Field Code</td>
</tr>
<tr>
<td>----------------------------------</td>
<td>--------------------------</td>
</tr>
<tr>
<td><strong>Credit Memos</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Credit Memo</strong></td>
<td></td>
</tr>
<tr>
<td>Applied Amount</td>
<td>APPLIED_AMOUNT</td>
</tr>
<tr>
<td>Bank ID</td>
<td>BANK_ID</td>
</tr>
<tr>
<td>Credit Amount</td>
<td>CREDIT_AMOUNT</td>
</tr>
<tr>
<td>Credit Date</td>
<td>CREDIT_DATE</td>
</tr>
<tr>
<td>Credit Memo #</td>
<td>CREDIT_MEMO_#</td>
</tr>
<tr>
<td>Credit Memo Import ID</td>
<td>CREDIT_MEMO_IMPORT_ID</td>
</tr>
<tr>
<td>Description</td>
<td>DESCRIPTION</td>
</tr>
<tr>
<td>Notes</td>
<td>NOTES</td>
</tr>
<tr>
<td>Post Date</td>
<td>POST_DATE</td>
</tr>
<tr>
<td>Post Status</td>
<td>POST_STATUS</td>
</tr>
<tr>
<td>Vendor Import ID</td>
<td>VENDOR_IMPORT_ID</td>
</tr>
<tr>
<td>Vendor ID</td>
<td>VENDOR_ID</td>
</tr>
<tr>
<td><strong>Attributes</strong></td>
<td></td>
</tr>
<tr>
<td>Attribute Category</td>
<td>ATTRIBUTE_CATEGORY</td>
</tr>
<tr>
<td>Attribute Comments</td>
<td>ATTRIBUTE_COMMENTS</td>
</tr>
<tr>
<td>Attribute Date</td>
<td>ATTRIBUTE_DATE</td>
</tr>
<tr>
<td>Attribute Description</td>
<td>ATTRIBUTE_DESCRIPTION</td>
</tr>
<tr>
<td>Attribute Type ID</td>
<td>ATTRIBUTE_TYPE_ID</td>
</tr>
<tr>
<td><strong>Purchase Orders</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Purchase Orders</strong></td>
<td></td>
</tr>
<tr>
<td>Attention</td>
<td>ATTENTION</td>
</tr>
<tr>
<td>Bank ID</td>
<td>BANK_ID</td>
</tr>
<tr>
<td>Buyer</td>
<td>BUYER</td>
</tr>
<tr>
<td>Comments</td>
<td>COMMENTS</td>
</tr>
<tr>
<td>Confirm to</td>
<td>CONFIRM_TO</td>
</tr>
<tr>
<td>Copy from PO</td>
<td>COPY_FROM_PO</td>
</tr>
<tr>
<td>Department</td>
<td>DEPARTMENT</td>
</tr>
<tr>
<td>Code Description</td>
<td>Field Code</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-----------------------------------</td>
</tr>
<tr>
<td>FOB</td>
<td>FOB</td>
</tr>
<tr>
<td>Notes</td>
<td>NOTES</td>
</tr>
<tr>
<td>Order date</td>
<td>ORDER_DATE</td>
</tr>
<tr>
<td>Order status</td>
<td>ORDER_STATUS</td>
</tr>
<tr>
<td>PO #</td>
<td>PO_#</td>
</tr>
<tr>
<td>PO Type</td>
<td>PO_TYPE</td>
</tr>
<tr>
<td>Purchase Order Import ID</td>
<td>PURCHASE_ORDER_IMPORT_ID</td>
</tr>
<tr>
<td>Post date</td>
<td>POST_DATE</td>
</tr>
<tr>
<td>Post status</td>
<td>POST_STATUS</td>
</tr>
<tr>
<td>Ship to</td>
<td>SHIP_TO</td>
</tr>
<tr>
<td>Ship via</td>
<td>SHIP_VIA</td>
</tr>
<tr>
<td>Terms</td>
<td>TERMS</td>
</tr>
<tr>
<td>Vendor Import ID</td>
<td>VENDOR_IMPORT_ID</td>
</tr>
<tr>
<td>Vendor ID</td>
<td>VENDOR_ID</td>
</tr>
</tbody>
</table>

**Attributes**

- Attribute Category: ATTRIBUTE_CATEGORY
- Attribute Comments: ATTRIBUTE_COMMENTS
- Attribute Date: ATTRIBUTE_DATE
- Attribute Description: ATTRIBUTE_DESCRIPTION

**Receipts**

**Receipt**

- Description: DESCRIPTION
- Purchase Order Import ID: PURCHASE_ORDER_IMPORT_ID
- Purchase Order Number: PURCHASE_ORDER_NUMBER
- Receipt #: RECEIPT_
- Receipt Date: RECEIPT_DATE
- Receipt Import ID: RECEIPT_IMPORT_ID
- Received by: RECEIVED_BY
<table>
<thead>
<tr>
<th>Code Description</th>
<th>Field Code</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>PO Line Items</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Line Item</strong></td>
<td></td>
</tr>
<tr>
<td>Date Promised</td>
<td>DATE_PROMISED</td>
</tr>
<tr>
<td>Date Required</td>
<td>DATE_REQUIRED</td>
</tr>
<tr>
<td>Deliver To</td>
<td>DELIVER_TO</td>
</tr>
<tr>
<td>Department</td>
<td>DEPARTMENT</td>
</tr>
<tr>
<td>Description</td>
<td>DESCRIPTION</td>
</tr>
<tr>
<td>Line Item Import ID</td>
<td>LINE_ITEM_IMPORT_ID</td>
</tr>
<tr>
<td>Line Item Type</td>
<td>LINE_ITEM_TYPE</td>
</tr>
<tr>
<td>Notes</td>
<td>NOTES</td>
</tr>
<tr>
<td>PO #</td>
<td>PO_#</td>
</tr>
<tr>
<td>Post Date</td>
<td>POST_DATE</td>
</tr>
<tr>
<td>Post Status</td>
<td>POST_STATUS</td>
</tr>
<tr>
<td>Product ID</td>
<td>PRODUCT_ID</td>
</tr>
<tr>
<td>Quantity Ordered</td>
<td>QUANTITY_ORDERED</td>
</tr>
<tr>
<td>Requested by</td>
<td>REQUESTED_BY</td>
</tr>
<tr>
<td>Requisition #</td>
<td>REQUISITION_#</td>
</tr>
<tr>
<td>Unit Cost</td>
<td>UNIT_COST</td>
</tr>
<tr>
<td>Unit of Measure</td>
<td>UNIT_OF_MEASURE</td>
</tr>
<tr>
<td>Vendor Part #</td>
<td>VENDOR_PART_#</td>
</tr>
<tr>
<td><strong>Account Distribution</strong></td>
<td></td>
</tr>
<tr>
<td>Account No.</td>
<td>ACCT_ACCOUNT_NO_.&lt;number&gt;</td>
</tr>
<tr>
<td>Percent</td>
<td>ACCT_PERCENT_.&lt;number&gt;</td>
</tr>
<tr>
<td>Amount</td>
<td>ACCT_AMOUNT_.&lt;number&gt;</td>
</tr>
<tr>
<td>Project ID</td>
<td>ACCT_PROJECT_ID_.&lt;number&gt;</td>
</tr>
<tr>
<td>Transfer</td>
<td>ACCT_TRANSFER_.&lt;number&gt;</td>
</tr>
<tr>
<td>Comment</td>
<td>ACCT_COMMENT_.&lt;number&gt;</td>
</tr>
<tr>
<td>Code Description</td>
<td>Field Code</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-----------------------------------</td>
</tr>
<tr>
<td><strong>Receipt Line Items</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Line Item</strong></td>
<td></td>
</tr>
<tr>
<td>Action</td>
<td>ACTION</td>
</tr>
<tr>
<td>Extended Cost</td>
<td>EXTENDED_COST</td>
</tr>
<tr>
<td>Line Item Import ID</td>
<td>LINE_ITEM_IMPORT_ID</td>
</tr>
<tr>
<td>Location</td>
<td>LOCATION</td>
</tr>
<tr>
<td>PO Line #</td>
<td>PO_LINE_#</td>
</tr>
<tr>
<td>PO #</td>
<td>PO_#</td>
</tr>
<tr>
<td>Post Date</td>
<td>POST_DATE</td>
</tr>
<tr>
<td>Post Status</td>
<td>POST_STATUS</td>
</tr>
<tr>
<td>Quantity Received</td>
<td>QUANTITY_RECEIVED</td>
</tr>
<tr>
<td>Receipt Import ID</td>
<td>RECEIPT_IMPORT_ID</td>
</tr>
<tr>
<td>Receipt Number</td>
<td>RECEIPT_NUMBER</td>
</tr>
<tr>
<td>Unit Cost</td>
<td>UNIT_COST</td>
</tr>
<tr>
<td><strong>Account Distribution</strong></td>
<td></td>
</tr>
<tr>
<td>Account No.</td>
<td>ACCT_ACCOUNT_NO_&lt;number&gt;</td>
</tr>
<tr>
<td>Percent</td>
<td>ACCT_PERCENT_&lt;number&gt;</td>
</tr>
<tr>
<td>Amount</td>
<td>ACCT_AMOUNT_&lt;number&gt;</td>
</tr>
<tr>
<td>Project ID</td>
<td>ACCT_PROJECT_ID_&lt;number&gt;</td>
</tr>
<tr>
<td>Transfer</td>
<td>ACCT_TRANSFER_&lt;number&gt;</td>
</tr>
<tr>
<td>Comment</td>
<td>ACCT_COMMENT_&lt;number&gt;</td>
</tr>
</tbody>
</table>
# Global Change

## In This Chapter

<table>
<thead>
<tr>
<th>Function</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Global Change Functions</td>
<td>308</td>
</tr>
<tr>
<td>Change Parameters</td>
<td>308</td>
</tr>
<tr>
<td>Add</td>
<td>309</td>
</tr>
<tr>
<td>Replace</td>
<td>309</td>
</tr>
<tr>
<td>Partial replace</td>
<td>309</td>
</tr>
<tr>
<td>Delete</td>
<td>309</td>
</tr>
<tr>
<td>Increase/Decrease</td>
<td>309</td>
</tr>
<tr>
<td>Copy</td>
<td>310</td>
</tr>
<tr>
<td>Swap</td>
<td>310</td>
</tr>
<tr>
<td>Move</td>
<td>310</td>
</tr>
<tr>
<td>Performing a Global Change</td>
<td>310</td>
</tr>
<tr>
<td>Preferences</td>
<td>315</td>
</tr>
</tbody>
</table>
With **Global Change** you can add, change, and delete information in a field based on a query of records in your database. For example, if your area code changes, you can perform a global change to replace the old area code with the new area code.

**Global Change** operates hierarchically. First you select the program in which you want to work. Next you select a category or record type in the program. Then you select a subcategory and, finally, the name of the field. Changes are made at the field level. Because global changes are based on records in a query, changes must be made by record type.

From the main screen, you can create, open, edit, and save parameter files for future use. A parameter file is an established set of criteria which you can save and use again and again to perform a specific function.

The main screen has two windows: programs and record types are listed in the left window, and saved parameter files appear in the right window. Double clicking a record type, or the **Add a New** parameter file icon in the right window, opens a new parameter file. Double clicking a saved parameter file opens the selected parameter file.

As part of the global change process, you can preview your intended global changes before they are actually made. You can also create a query of the records affected by the global change, which you can use in other modules. Finally, you can create an exception query of the records that, for one reason or another, could not be changed by the global change process.

The global change process includes several global change functions. You can add, replace, partially replace, delete, increase/decrease, copy, swap, and move information in selected fields in your database.

In **Accounts Payable**, you can globally change fields on these record types:

- Vendors
- Invoices
- Credit Memos
- Recurring Invoices
- Purchase Orders
- Receipts

### Global Change Functions

Each global change function (add, replace, partially replace, delete, increase/decrease, copy, swap, and move) has its own parameters. Function availability depends on the field type. Not all global change functions listed are available for all fields.

For example, you cannot delete, move, or replace required fields with a **<blank>**. You can only copy unique required fields.

### Change Parameters

Change parameters are criteria you establish enabling you to change your database globally. Change parameters include the global change function and the values associated with that function.
Add

The Add function adds a value to a field. This value can either replace the current value or make no changes to the current data, depending on whether you mark Overwrite existing value.

If you do not mark the Overwrite existing value checkbox, only empty fields receive the new value. Fields with information are not modified.

If the checkbox is marked, existing values can be overwritten. The new value is added to empty fields and it replaces values in fields with existing values.

For example, for a global change of Add-Title-Ms. with the Overwrite checkbox marked, all records in the selected query have their Title fields overwritten with the value Ms., regardless of what the title was before. Without the checkbox marked, Ms. is added only to records with no Title defined. Records that currently have Mrs., Dr., or any other value remain unchanged.

You can add a new value to some tables during the global change Add process if you mark the Automatically add table entries checkbox.

Replace

The Replace function searches for records that exactly match the value.

Checkbox fields can be replaced with Unchecked/Checked values. You can leave the With field blank to clear values from the field.

For example, to replace any value in the State field with SC, leave Replace blank and specify SC. All records in the query have their state changed to SC.

When available, mark Match case to make the search case sensitive. This enables you to make entries consistent if they have been entered two different ways.

You can add a new value to some tables during the global change Replace process if the Automatically add table entries checkbox is marked.

Partial replace

The Partial replace function is not available for table fields. Partial replace searches for records that contain the value you enter. When available, mark Match case to make the search case-sensitive.

For example, you can use the Partially Replace global change function to change the area codes for records within a query. Since the entire phone number, including area code, is part of one long field, Partial Replace allows you replace part of the phone number (the area code or first three digits) with a new value. Partially replace 803 with 843. Any records in the query with a phone number that includes 803 have those numbers replaced with 843.

Delete

The Delete function allows you to delete all of the values in the specified field that contain the value in the Delete field. You cannot use blanks (non-values) for the Delete global change function.

Increase/Decrease

For fields that contain a numeric value, you can use Increase or Decrease as the global change function. You can increase/decrease values by an exact amount or by a percentage.
For fields that contain a date value, you can use Increase or Decrease to increase or decrease the date by a specified number of days, weeks, months, or years. Increases and decrease take into account different length months and leap years.

For example:

Increasing by 1 day replaces 07/06/1999 with 07/07/1999, or 07/31/1999 with 08/01/1999.

Decreasing by 1 week replaces 07/08/1999 with 07/01/1999, or 06/02/1999 with 05/026/1999.

Increasing by 1 month replaces 07/13/1999 with 08/13/1999, or replaces 01/30/1999 with 02/28/1999 (the last day of the next month).

### Copy

The Copy global change function places the entire value from the source field to a compatible target field. In the Copy to field, use the lookup button to search for and select the target field. Mark the Overwrite existing value checkbox and all target fields get the value copied from the source field. If this checkbox is not marked, only blank target fields receive the copied value.

You can add a new value to some tables during the global change Copy process.

### Swap

The Swap global change function places the entire value from the source field to the target field and the original value of the target field in the source field. In the Swap with field, use the lookup button to search for and select the target field.

You can add a new value to some tables during the global change Swap process if you mark the Automatically add table entries checkbox.

### Move

The Move global change function places the entire value from the source field to the target field and deletes the value from the source field.

In the Move to field, use the lookup button to search for and select the target field. Mark the Overwrite existing value checkbox and all target fields get the value copied from the source; otherwise, only blank target fields get the value.

You can add a new value to some tables during the global change Move process if you mark the Automatically add table entries checkbox.

### Performing a Global Change

Before performing a global change, you should always make sure you have a working backup of your database.

When you perform a global change, you are making a change at field level for the program, record type, and subcategory you have selected. Also, because you perform a change for selected records based on a query definition, the change is limited to those records in the selected query.
Performing a global change

1. From Global Change, double click the Accounts Payable folder on the left side of the screen to view the global change record types.

2. Highlight the record type and select File, New. The Global Change <record type> screen appears.
If a query does not exist that meets your criteria, you can click **Add New** to create a new query.

3. Click **Include** to access the search screen and select the query of records to globally change. The search screen appears.

![Search Screen](image.png)

4. If a large number of queries display, you can use the filters to locate the query you want to include.

5. When you have highlighted the query, click **Open**. The Global Change <record type> screen appears.

![Global Change Screen](image.png)

In the **Available Fields** frame, you can filter the fields you view in the box by selecting a field category from the **Show** drop-down list, or you can show **All fields**. If you show **All fields**, double click a folder to view individual fields.
6. Highlight the field you want to globally change, and click **Select**. The Edit Change Parameters screen appears for the selected field.

7. Select the global **Operation** to perform. Available options change depending on the field type. Your choices can include Add, Replace, Partial replace, Delete, Increase, Decrease, Copy, Swap, and Move.

8. Depending on the field type and the global **Operation**, enter the appropriate information in the additional fields.
   - For **Add**, enter information in the **Add** field.
   - For **Replace**, enter information in the **Replace** and **With** fields.
   - For **Partial replace**, enter information in the **Partially replace** and **With** fields.
   - For **Delete**, enter information in the **Delete** field.
   - For **Increase** or **Decrease** the **Operation** requires you to select whether to **Modify by** Amount or Percentage, or whether to **Modify by** Day(s), Week(s), Month(s), or Years. Then enter the amount, the percent, or the number of days, weeks, months, or years in the corresponding field.
   - For **Copy**, enter information in the **Copy** to field.
   - For **Swap**, enter information in the **Swap** with field.
   - For **Move**, enter information in the **Move** to field.

9. If you want all records in the query changed, including those with existing information in the selected field, mark **Overwrite existing value**.

10. Once all information is entered, click **OK**.

11. You can click **Browse Changes** to view the modifications that will take place when you run the global change later. This allows you to edit change parameters prior to previewing or performing the global change.

12. Mark **Create a query of vendors that are changed** to have a query of all of the records affected by this global change.

13. Mark **Create exception query** to have a query of the records that should have been but were not changed in this process.

14. Mark **Preview changes** to view a list of records that will be affected by this global change before the changes take place.
15. This gives you the opportunity to preview the results before global changes are made. If the results are incorrect, you can cancel the global change process and correct the global change parameters without any changes being made.

16. Mark **Automatically add table entries** if you want to add or replace existing table entries with table entries that are not currently in the database. This adds new table entries to the selected fields as well as the appropriate table in *Configuration*.

17. If you entered new table entries in a change parameter field and you do not mark this box, the fields are unchanged and the reason given for the exception is that you can only use existing table values unless you mark **Automatically add table entries**.

18. Click **Change Now** to run the global change process. The Save Global Change As screen appears.

19. Enter a **Name** and **Description**. Select whether others can run or modify this global change. If you want to save this global change parameter file, click **Save and Change**. If you click **Change without Saving**, the screen returns to the Global Change main screen without saving a file of the changes made.

20. If you marked **Create a query of vendors that are changed**, **Create exception query**, or both, screens appear for you to name and save the queries.

21. Finally, a Global Change screen appears showing you how many records processed successfully and how many records were completely changed, partially changed, and unchanged.

22. You can click **Print Control Report** if you want to view a report that shows the action taken to globally change records, as well as exceptions. The Control Report lists how many records were processed, completely changed, partially changed, or unchanged.

23. Click **OK** to return to *Global Change*.

---

### Editing change parameters

1. In the **Fields to Change** frame on the Global Change <record type> screen, highlight the change parameter you want to edit.

2. Click the **Criteria** button. The Edit Change Parameters screen appears.
3. Make necessary changes.
4. When you are finished, click OK.

Preferences

Select Edit, Preferences to access the *Global Change* preferences options. In this module, you can select a preference for display options: whether to Group fields by tab within each category or whether to Display fields alphabetically within each category.

For example, if you select the **Group fields by tab within each category** option, the fields in the Addresses category for Vendors are listed as they appear on the address screen:

- Description
- Name
- Alias
- City
- State
- ZIP

The list continues, displayed in the order in which they appear on the address screen.

With the **Display fields alphabetically within each category** option marked, these same fields are listed alphabetically:

- Alias
- City
- Contact First Name
- Contact Last Name
- Contact Position

The list continues, displayed in alphabetical order.

Setting preferences

*Global Change* preferences determine how options are displayed. These preferences are not applied throughout the program but are specific to the workstation where they are set.

1. From *Global Change*, select **Edit, Preferences**. The Preferences screen appears.
2. Mark either **Group fields by tab within each category** (which displays fields in the tab order in which they appear in a category) or **Display fields alphabetically within each category** (which displays fields from each tab in alphabetical order).

3. Click **OK**.
Glossary

Symbols

* (asterisk) – a wildcard operator used in Global Change. Using * as a wildcard tells the program that * can stand for any string of characters. For example, when searching for someone whose last name is Johnson, but you are not sure how to spell it, you want to search for Jo*son or Jo*s?n (if you are not sure of the ending). This would return results like Jonson, Jonsen, Johnson, Johnsen, etc.

< > – information contained between the greater than and less than sign is used as an example. The exception occurs when you define criteria as punctuation written out between the signs, then the greater than/less than signs represent the punctuation mark. For example, <hyphen> means the hyphen symbol is included.

% (percent) – found in Query and Export, the percent sign can replace a series of characters. For example, if you query to find a note written by someone with a last name beginning with “John,” you can use the criteria “Author Like John%.” The program selects notes with Author beginning with “John” (e.g., Johnson, Johnston, Johns, and Johnathan-Willis).

? (question mark) – a wildcard operator used in Global Change. Using ? as a wildcard tells the program that ? can stand for one character. For example, if you are searching for someone whose last name is Johnson, but you are not sure if it is spelled with an o or an e at the end, you want to search for Johns?. This would return results like Johnson, Johnsen, Johnsan, etc.

A

Accounting Queue – Blackbaud’s optional module that is used to perform a sequence of tasks that can be executed automatically and unattended.

account number segments – a series of numbers, which creates a Blackbaud General Ledger account number. For example, 01-11100-00-00. The first number in the series is always the fund code. This is followed by user-determined segments, which could be the actual account number, department code, and/or location code. Account number segments are defined in Configuration on the Account Number tab.

Accounts – a Blackbaud module found in General Ledger where you add, edit, and delete account records as well as enter budget information, organize and maintain your Chart of Accounts, and copy a range of accounts from one fund to another.

Accounts Payable – Blackbaud’s comprehensive check writing and payment information program. It helps you manage your expenses and plan your payment schedule.

Accounts Receivable – Blackbaud’s comprehensive billing and customer information program. It helps you manage your receivables and plan your cash flow. Along with customer account management, you can use this program for billing and payment applications, creating invoices, statements, and correspondence, as well as producing reports.

accrual – the accumulation of assets, expenses, liabilities, or revenue items whose value has been determined but for which no cash has yet been transferred.

accumulated depreciation – the cumulative amount of all depreciation (includes prior years and year-to-date depreciation).

accumulated depreciation account – the account to which accumulated depreciation is expensed. It is a contra asset account.

accumulated depreciation journal reference – the transaction identification numbers defined on the General Ledger tab in Configuration. These transaction numbers serve as an identifier for all accumulated depreciation when posting to a general ledger.

ACH – Automated Clearing House. A regional entity that electronically processes fund transfers between banks.

ACH Credit – an electronic funds transfer (EFT) initiated by an employer to a designated financial institution for the amount of a tax payment.

ACH Debit – an electronic funds transfer (EFT) in which a designated bank, with employer authorization, notifies the employer’s bank to transfer funds.

ACRS (Accelerate Cost Recovery System) – a method of depreciation used for assets that were placed in service after 1980, but before 1987.

Add – a Global Change function that adds a value to a field. This value can either replace the current value or make no changes to the current data, depending on whether you mark Overwrite existing value.

adjustment – a debit or credit added to your bank account to bring the account in balance.
adjustment type – a category of adjustments, such as ATM fees, minimum balance fees, or monthly service charges, associated with general ledger debit and credit accounts. When you create an adjustment, you first select an adjustment type, enter an amount, and then the program automatically fills in the corresponding general ledger information to create your adjustment.

Adobe Acrobat Reader – a free download from Adobe that allows electronic distribution of formatted documents.

AFN – Accounting for Nonprofits.

Alternate ACRS – method of depreciation that uses a modified Straight Line depreciation calculation. This method should only be used for assets that were placed in service after 1980, but before 1987.

Alternate Depreciation System (ADS) – ADS uses a Straight Line depreciation method. The ADS must be used for the following: tangible property used outside the United States, tax-exempt property, tax-exempt bond-financed property, imported property covered by executive order, or farming property under some circumstances.

annotate – notes you type to add detail about a specific account. This feature is found on the Edit menu in Bank Accounts.

annual wage – the fixed salary paid to an employee over the course of a calendar year.

appendix – supplemental information found after the last chapter in a Blackbaud user’s guide that provides detail about optional features.

<Ask> – a criteria operator that allows you to choose the field value query criteria at the time you run the query. When you run the query, an “Ask at Runtime” wizard appears, prompting you to select criteria for any fields defined by the <Ask> criteria operator.

asset – property (tangible or intangible) that has value.

Assets – a Blackbaud module in Fixed Assets where you to create an asset using the Asset Wizard, depreciate assets using a variety of schedules, track and calculate depreciation, and post and adjust transactions.

Asset Wizard – a utility in Fixed Assets that collects specific information from the user and creates an asset record.

attributes – a reporting tool that lets you group information based on a common theme. With attributes defined, you can filter information to your specification.

B

backup withholding – taxes withheld from an individual’s income when the proper Taxpayer Identification Number (TIN) can not be identified or when required by the Internal Revenue Service. The rate is typically 31 percent.

balance forward – a system configuration that automatically applies payments and credits to the total balance with the oldest charges paid first.

Bank Account Reconciliation – a Blackbaud optional module designed to provide in-depth details about bank activity while balancing bank accounts. Bank Account Reconciliation can be added to these Windows programs: Accounts Payable, Accounts Receivable, Miscellaneous Cash Receipts, Payroll and Student Billing; and it works with General Ledger for Windows and The Raiser’s Edge for Windows.

Bank Accounts – a shared module contained within Blackbaud accounting programs. From the Bank Accounts main screen, you initiate procedures for Bank Account Reconciliation (if installed) and Check Writer. Bank Accounts now contains the functionality for both.

bank list – a list of all bank accounts added in your Blackbaud software. From this list, you can filter the account information you want to display, open the bank account register, edit the bank account information, add a new bank account, or delete a bank account.

bank summary report – an overview statement of your account based on filters you select in the Reports module of your main Blackbaud accounting program. This report is useful when providing bank information to auditors or board members.

Begins With – a Query and Export criteria operator, which selects records with an entry that begins with the value you define. For example, if you choose Vendor Name Begins With Bel, vendors whose Vendor Name has “Bel” at the beginning (Bell, Bellingham, Bellmont, etc.) are selected. You can use wildcard characters with this operator.

Between – a Query and Export criteria operator, which lets you select a range of entries that records could have in order to be selected. For example, if you select Amount is Between $50 and $100, the program selects records of invoices that fall within this amount range.

bitmap – a file format for online art.

biweekly payroll – paid 26 times a year.
Blackbaud Systems – a catch-all phrase for main Blackbaud programs such as General Ledger, Student Billing, Payroll, etc.

Blank – a Query and Export criteria operator, which selects any record with a blank field you define. For example, if you choose the criteria Alias is Blank, the program selects all records with an empty Alias field.

Budget Management – a Blackbaud optional module used to enhance and expand your budget development capabilities within General Ledger.

button – a picture or word icon appearing on screens and toolbars. When clicked, buttons let you perform functions, such as saving, without using the menu bar.

C

Cash Receipts – a Blackbaud module in which you create deposits and add payment and deposit receipts. You can also print deposit tickets and receipts.

cash receipts journal – a set of parameters you define in Accounts Receivables to standardize receipt appearance.

change parameters – criteria you establish to change your database globally.

chart of accounts – a list of revenue and expense sources appearing in ascending account number order by category. This chart is maintained in General Ledger, Accounts module.

Check Writer – formerly a Blackbaud shared module. Its functionality now resides within the Bank Accounts module of Accounts Payable and Payroll.


CODA – Cash or Deferred Arrangement. This is a type of employee benefit plan, also know as 401K.

computer-based training – a self-paced, interactive form of multimedia training completed on a computer. Also known as CBTs, they can be delivered on a CD-ROM or over a network to a student workstation anywhere and at any time. Blackbaud CBTs are called Interactive Workshops.

Configuration – a shared module within Blackbaud accounting programs. This is where you define program settings and create tables that increase efficiency, accuracy, and speed data entry.

consolidation code – a General Ledger code comprised of letters or numbers that can be program-generated or user-generated. Consolidation codes filter accounts and create combinations of multiple regular accounts within multiple funds as defined in the Chart of Accounts. They are established in Configuration on the Consolidations tab.

Consumer Credit Protection Act – a federal law that limits the amount of an employee’s wages that may be subject to garnishment.

Contains – a Query and Export operator, which selects records that have your defined entry anywhere in the field. For example, if you define criteria for Vendor Name Contains Z, records with the letter “Z” anywhere in the vendor name field are selected. You can use wildcard characters with this operator.

Copy – a Global Change function that places the entire value from the source field into a compatible target field.

credit – an increase in a revenue, net worth, or liability account.

credit hold – a designation you assign to a customer record when you do not want orders from the customer to be processed without full payment.

credit limit – a monetary cap you assign to a credit record allowing customers to place orders without payment up to a certain limit.

credit memo – an entry that lets you reimburse charges previously applied.

Customers – a Blackbaud module in Accounts Receivable where you establish individual records for your customers. Each customer record maintains name, address, phone and contact information, as well as miscellaneous items such as tax, credit, statement, and discount information.

D

database validation – a procedure that scans and verifies the accuracy of your database. The program generates an error message if a discrepancy exists.

debit – an expense or deduction from a revenue, net worth, or liability account.

debit memo - an entry that lets you increase a customer’s balance, such as finance charges, membership dues, and non-sufficient fund checks.
deduction – an amount subtracted from an employee’s gross wages for a designated purpose, such as health insurance.

Delete – a Global Change function that allows you to delete all of the values in a specific field.

directory – the location on a drive where you store the names and locations of files.

documentation – written explanations about program functions accompanying Blackbaud software. This can include a user’s guide, an online user’s guide, and online Help.

Does Not Begin With – a Query and Export criteria operator, which selects records that do not begin with your defined entry. For example, if you choose Vendor Name Does Not Begin With Bel, vendors whose Vendor Name does not have “Bel” at the beginning are selected. You can use wildcard characters with this operator.

Does Not Contain – a Query and Export criteria operator, which selects records without your defined entry anywhere in the field. For example, if you define criteria for Vendor Name Does Not Contain Z, only records without a “Z” anywhere in the vendor name field are selected. You can use wildcard characters with this operator.

Does Not Equal – a Query and Export criteria operator, which selects only the records with entries that do not match the defined criteria. For example, if you choose City Does Not Equal Charleston, the program selects every record that does not have “Charleston” entered as the city.

dunning letters – automatically generated requests for past due payment. You set up these letters in the Mail module of Blackbaud programs.

dynamic query – a query type that automatically refreshes and updates results each time the query is used, providing the most current results.

electronic funds transfer (EFT) – a general banking system in which transactions, such as deposits and bill payments, are made through computer databases and electronic files. Money does not physically change hands; it transfers electronically from the payer’s account into the payee’s account. This is often referred to as EFT or direct deposit. Blackbaud's Electronic Funds Transfer module adds fields and options to modules in Accounts Payable and Payroll.

electronic reconciliation – a process that lets you compare your bank’s Quicken Interchange Format (.QIF) with your Blackbaud file and then reconcile your account based on matches between the two.

employee – under the common-law rule, an individual who performs services subject to the will and control of an employer.

Employees – a Blackbaud module found in Payroll where you enter biographical, wage, and tax information for employees as well as track attendance. In addition, this program lets you store information concerning an employee’s off-site activities, such as attending seminars and conferences.

employer – a person or organization for whom a worker performs a service as an employee.

Employer’s Quarterly Federal Tax Return – the name of the Form 941 filed quarterly, reconciling the federal income tax and the FICA taxes withheld and paid.

Equals – a Query and Export criteria operator. When you choose Equals as your operator, records selected for the query must have the exact entry you define.

Excel – a spreadsheet program by Microsoft.

exception query – a query that contains all files that could not be incorporated into the function (report, etc.) because they did not meet all criteria.

exempt employee – an executive, administrative, professional, or outside sales person who is exempt from or not subject to the overtime and minimum wage provisions of the Fair Labor Standards Act, as amended.

expense – any cost incurred in the production, selling, and distribution of goods and services; expenses are deducted from revenues on the income statement to arrive at a net income.

export – to send to another program, such as Microsoft Excel.

Export (module) – see Query and Export module.
Family and Medical Leave Act of 1993 (FMLA) – a federal law requiring employers with 50 or more employees to grant up to 12 weeks of unpaid leave to employees for the birth or adoption of a child; the care of a seriously ill child, spouse, or parent; or for their own serious illness.

FAS 117 – This stands for Financial Accounting Standard No. 117. It is a standard for nonprofit fund accounting financial statements as published by the Financial Accounting Standards Board.

Fee schedules – a tool to automate the billing process for standard fees such as tuition, room and board, and other standard tuition related fees.


Filters – a search and display feature that lets you control the amount of information appearing on grid screens. For example, Bank Account Reconciliation filters let you display bank account information based on Blackbaud program, transaction type, and transaction status.


Fixed asset – permanent, long-life assets of a business: (i.e., land, buildings, equipment, and vehicles).

Fixed Assets – Blackbaud’s asset management program. This program provides everything an organization needs to manage its assets, including the ability to enter or import asset information, generate depreciation transactions automatically following IRS rules, and account for and record the disposal of assets.

Flat rate method – a formula used to calculate the federal tax due, using the rate of 28 percent.

Form 4562 Depreciation Summary Report – provides summary depreciation information to help prepare IRS Form 4562-Depreciation and Amortization.

Fund – a self-balancing set of accounts that represents a separate legal entity. Examples of funds include unrestricted, restricted, plant, and endowment. Funds must be added to General Ledger before you can enter accounts.

Fund code – the first segment of an account number when General Ledger is configured for fund accounting.


garnish – to attach, such as money due, from a debtor while it is in the hands of a third party.

garnishee – a person or business served with a garnishment.

garnishment – a court order served on a person or firm as the result of a lawsuit to require that employer to withhold money from an employee’s pay and disperse according to the court’s direction.

general journal batch – a compiled group of debit and credit transactions that you can post to your ledger accounts.

general ledger – the primary ledger, when used with subsidiary ledgers containing all balance sheet and income statement accounts. The general ledger is used as a central reference or index for transaction posting.

General Ledger – a Blackbaud program designed to enhance the efficiency of your general ledger and improve the organization of your business office.

GL interface files – files that enable General Ledger to interact with Blackbaud DOS systems and The Raiser’s Edge. By creating interface files, you assign the General Ledger accounts an alternate account number that other programs can recognize.

Global Change – a shared module within Blackbaud programs that allows you to change multiple fields at once using various change parameters.

Global change functions – add, replace, partial replace, move, swap, delete, increase/decrease, copy.

Greater Than – a Query and Export operator. If you select Greater Than as your operator, you indicate that records selected must have a value greater than the one you define.

Greater Than or Equal To – Query and Export operator. Selecting Greater Than or Equal To as your operator limits the records selected to those that have a value greater than or equal to the one you define.

Gross earnings – grand total of all regular, overtime, and other compensation paid to an employee before any deductions for taxes, etc.

Group – multiple users with the same access rights to a Blackbaud program as defined by the Supervisor in the program’s Security module.
group consolidation management – a procedure in General Ledger that makes the association between ledger accounts and one or more consolidations easy.

**H**

header accounts – one of three types of entries displayed in the General Ledger Chart of Accounts. Header accounts are designated by an “H” at the end of the account number. They are used for description purposes only. Activity cannot be posted to a header account. For example, there could be a header account called “Investments” followed by a listing of regular accounts, which contain investments.

Help files – a type of online help that lets you access information from your computer about the program in which you are working.

hyperlink – text or graphic in a Help file or web page that, when clicked, moves the user to a specific location. For example, the notepad graphic is a hyperlink found with procedures in the Bank Account Reconciliation Help files. When you click the notepad, it moves you to a blank page where you can type notes about the procedure.

**I**

icon – a picture that represents a particular object, command file, or group of files.

import – a type of file conversion that lets you load a file from a format other than the application program’s original format. For example, you can import batches from The Raiser’s Edge into Bank Account Reconciliation.

Import – a shared Blackbaud module that lets you import various file types into Fixed Assets, Accounts Payable, Accounts Receivable, Miscellaneous Cash Receipts, Payroll, and Student Billing.

inactive (entries) – entries that have been defined, but cannot be used in tables. You make entries active or inactive from the Tables tab in Configuration.

Increase/Decrease – Global Change function that can be used for fields containing a numeric value. You can increase/decrease values by an exact amount or by a percentage.

installation guide – a written explanation accompanying your software that helps you load your new software.

Interest Income Allocation – a Blackbaud optional module used with General Ledger and Project, Grant, and Endowment Management to define “pools” of projects for investment purposes.

interfund – a balancing entry between funds. This procedure automates the creation of General Ledger transactions to transfer money between funds. This is accomplished through Interest Income Allocation with Project, Grant and Endowment Management. Both are Blackbaud optional modules.

involuntary deduction – pay withheld from an employee’s paycheck at the request of someone other than the employee. For example, child support.

IRS – Internal Revenue Service.

Is Not Blank – a Query and Export criteria operator, which selects any record with anything in your defined entry. For example, if you select the criteria Alias Is Not Blank, the program selects records with an entry in the Alias field.

**J**

Journal Entry – a Blackbaud module in General Ledger where you create batches of transactions for posting to your General Ledger accounts. Through Journal Entry, you can create, import, validate, delete, reverse, display, print, and post batches.

journal reference – transaction identification numbers used during the posting process.

**L**

legend – an explanatory list of colors found on screens. For example, the Bank Account Reconciliation legend lets you select the color of specific bank account references.

Less Than – a Query and Export criteria operator. When you select Less Than as your operator, you limit the records selected to ones that have an entry less than the value you are defining.

Less Than or Equal To – a Query and Export criteria operator. When Less Than or Equal To is selected as the operator, the records selected must have an entry either equal to or less than the value you define.

leveling – a process in General Ledger that lets you determine how an account should total within a given category (e.g. asset, liability, fund balance, revenue, expense, gift, or transfer).
Like – a *Query and Export* criteria operator. The Like operator allows you to use wildcards (special characters) to replace a character or set of characters in a field.

**M**

MACRS – a depreciation method used for assets placed in service after 1986. MACRS consists of two systems GDS (the main one) and ACRS.

MACRS ADS – a Straight Line depreciation method used for the following: tangible property used outside the United States, tax-exempt property, tax-exempt bond-financed property, imported property covered by executive order, or farming property under some circumstances. This depreciation method can only be used for assets placed in service after 1986.

Mail – a shared module within Blackbaud programs where you can specify mailing parameters for labels, forms, envelopes, letters and cards.

mandatory deductions – deductions required or mandated by law, such as federal income tax.

media – any stored information related to an asset record (i.e., an article, warranty information, demonstration video, etc.)

menu bar – a horizontal strip of selections found under the title bar at the top of a window.

merge – to combine or join two queries to make a third query.

merge operators – AND, OR, XOR, and SUB. These operators allow you to determine how queries merge.

Microsoft Windows – an operating system required to run Blackbaud programs.

minimum wage – lowest legal amount an employer may pay an employee per hour.

Miscellaneous Cash Receipts – a Blackbaud program designed to complement *General Ledger for Windows* by handling the small details that can clutter a ledger. It helps you identify where small cash amounts originate, produce a detailed profile of each transaction, and print a deposit ticket.

module – a component of a program. A module is created separately and then combined with other modules to form a program. For example, the Security module is a shared component of all Blackbaud programs.

Move – a *Global Change* function that places the entire value from the source field into the target field and deletes the value from the source field.

**N**

NACHA – National Automated Clearing House Association. This is the national umbrella organization for regional automated clearinghouses.

net pay – the total earnings of the employee minus all the deductions. This is also known as take-home pay.

Not Between – a *Query and Export* criteria operator. Choosing Not Between as the operator allows you to select a range of entries that records must not have to be included in the query. For example, if you select Amount is Between $50 and $100, records of invoices that fall within this amount range are selected.

Not Blank – a *Query and Export* operator. The Not Blank operator selects any record with anything in the entry you define.

Not Like – a *Query and Export* operator. The Not Like operator selects records that do not have the entry you define. You can use wildcard characters with this operator.

Not One Of – a *Query and Export* operator. Choosing Not One Of as the operator means records selected must not have one of the entries you define.

O

OFLT – Worker’s Compensation Old Fund Liability Tax.

on the fly – adding an entry to a table when it does not appear on the Tables tab in *Configuration*. There are several places in Blackbaud programs where you can add information directly into a field instead of selecting a pre-defined value from the drop-down list. When you do this, the program asks you if you want to create a table entry. Click Yes to add the entry to the table.

One of – a *Query and Export* criteria operator. Choosing One of as the operator means records selected must have one of the entries you define.

online help – information accessed from a computer about the program in which you are working.

online manual (user’s guide) – the manual in a PDF format, which you can open and read via Adobe Acrobat Reader. It is accessible from your CD-ROM or by selecting Help, Online Documentation.
open item – a system configuration that lets you select a specific charge item when applying a payment. Payments can be applied automatically based on user-defined criteria.

Optional (O) – used in the reference section to signify that the information referenced in the field is optional. It does not have to be entered in the program.

OR – a Query and Export operator that joins two queries to make one. All records in both queries are included; however, records that appear in both queries are not duplicated.

Or (button) – a Query and Export criteria operator. Clicking Or tells the program that any output information can meet either criteria to be used.

output query – a query that lists the results of a function.

overtime – hours worked in excess of the prescribed maximum weekly (or in some states, daily) requirements.

**P**

parameter file – an established set of criteria, which you can save and use over and over to perform a specific function.

Parenthesis ( ) – a combining operator used in Query and Export to separate a portion of the criteria formula.

Partial replace – a Global Change function that searches for records containing at least part of the value. You cannot leave the Replace field blank for partial replaces, but you can use standard wildcards (such as ? and *). This function is not available for code table fields.

password – a secret sequence of typed characters required to use a computer program. This prevents unauthorized users from entering a program.

payer-based processing – a processing method that focuses billing activity on the individuals and organizations responsible for paying a student’s charges.

Payroll – a Blackbaud program that simplifies your payroll and human resource management, saving you time and making in-house payroll processing a cost effective alternative to outsourcing.

payroll period – periods of service for which an employer usually pays wages.

**payroll register** – term used to describe a multicolumn form used in assembling and summarizing the data needed at the end of each payroll period. It lists all employees who earned remuneration, the amount of remuneration, the deductions, and the net amount paid.

Percentage Method of Withholding – a procedure for calculating the amount of tax withheld, using mathematical formulas and usually intended for use by employers with computerized payroll systems. May also be computed using the charts and tables in the Circular E.

per diem – daily allowance, usually for travel, entertainment, or miscellaneous out-of-pocket expenses while conducting a business transaction.

Portable Document File (PDF) – a document that maintains its formatting and displays correctly on any output device. For example, the Blackbaud user’s guides are saved in a PDF format and displayed in the Help files. This format also allows users to click on hyperlinks and jump from topic to topic.

post – the process of entering a transaction into Blackbaud’s General Ledger and updating your account balances.

Post – a Blackbaud module in General Ledger where you can post both general journal batches and batches from other Blackbaud programs to General Ledger.

preferences – computer program settings that offer individual customization. For example, Preferences in Bank Accounts let you select grid colors and lines.

prenote authorization file – an electronic test record sent to a bank to ensure correct transmission of coding, amounts, account numbers, etc. Banks often require a prenote authorization file before accepting electronic funds transfers (EFTs).

Pre-purge Report – creates a report for your records before any data is actually purged.

preview – an advance look at a document before printing.

procedure – a series of steps that explains how to perform a task within a computer program.

program – a software system. Blackbaud’s programs are composed of modules.

Project, Grant, and Endowment Management – an optional module in Blackbaud’s General Ledger designed to track details of subsidiary funds. When used with Bank Accounts, a Projects grid appears at the bottom of the New Adjustment screen.
**Purchase Orders** – an optional module in Blackbaud’s Accounts Payable program that allows you to process purchase orders and receipts for your organization.

**purge** – to erase information from your database. We recommend always making a backup copy of your database before purging. Purged files cannot be recovered.

**Purge Asset Control Report** – a report listing the assets that were purged.

**Q**

**.QIF** – an abbreviation for Quicken Interchange Format. This popular format is used by banks to electronically store bank account statements.

**query** – to question the database for specific information. Or, a set of defined criteria used to select and export records. When you create a query, you create a definition for the records you want to include. When you run a procedure using the query, your Blackbaud program processes only those records matching the query definition. You can also extract information from the records in the query by defining the output fields of the query. For example, you can create a query of deposits for electronic funds transfer (EFT) payments only.

**Query and Export** – a shared module within Blackbaud programs where you can create, open, run, and delete queries. Other options include refreshing, merging, and exporting queries.

**query criteria operators** – data field requirements used to narrow and focus a search within filtered information. When you define a query, you establish a set of values, or requirements, that a record must meet to be included. Query criteria operators include: Equals, Does Not Equal, Blank, Not Blank, and <Ask>.

**R**

**The Raiser’s Edge** – Blackbaud’s fund-raising software designed to enhance your fund-raising efforts and improve the organization of your development office. You can import and view batches from The Raiser’s Edge into Bank Account Reconciliation.

**reconciliation** – a function in Bank Account Reconciliation by which your account becomes balanced once you enter preliminary data.

**recurring invoice** – a template from which regular invoices are created according to a schedule you define. Recurring invoices let you maintain a consistent format for customers who receive invoices on a regular basis.

**reference** – a section at the end of most Bank Account Reconciliation chapters where screens within the chapter are displayed and screen fields are described.

**regular accounts** – one of three types of entries displayed in the General Ledger Chart of Accounts. Regular accounts are designated by an “R” at the end of the account number. These accounts display account activity.

**regular rate of pay** – hourly rate used to pay overtime to an employee. This is a calculated rate based on the amount of hours and wages for a specific pay period.

**Replace** – a Global Change function that is available only for fields that use code tables (i.e., have pre-defined values). Replace searches for records that exactly match the value. You can leave the Replace field blank to replace all values with the new value.

**Reports** – a shared module found in all Blackbaud accounting programs where you generate specific reports based on data parameters you establish.

**Required (R)** – used in the reference section to signify that the information referenced in the column is required. Required information must be entered before the program will save.

**reversing invoices** – a procedure to convert any invoice transaction to a credit memo or sales return.

**row** – a single horizontal section in a table or grid.

**S**

**salary** – a fixed compensation paid to an employee for regular work or services.

**sales tax codes** – a way to designate the federal tax, state tax, and local option sales tax to use as part of a customer record or invoice transaction. You can specify the tax rate and whether or not it is compounded.

**salvage value** – the estimated value of the property at the end of its useful life. This must be less than the depreciation basis.

**SDI** – State Disability Insurance.

**Security** – a shared module within Blackbaud programs where you establish access rights for groups of users.
security groups – a collection of users with the same access privileges within a Blackbaud program.

security users – Individuals given access privileges within a Blackbaud program based on security group membership.

semimonthly payroll – paid 24 times per year.

separater character – the symbol that appears between your General Ledger account number segments. From Utilities and Housekeeping, select Change Separator Character, and choose from dash, comma, slash, backslash, semicolon, or period.

shared module – a component of a program that is created separately and then combined with other modules to form a program. For example, the Security module is a shared component of all Blackbaud programs.

shift differential – rate adjustment paid to employees working certain shifts.

shortcut keys – tools to speed data entry. Function keys are the primary source for shortcuts. When a function key is available, the status bar at the bottom of the open window tells you which key to press.

shortcut menu – a menu displayed when you place your cursor in a field or grid, and then click the right mouse button. A shortcut menu lets you access commonly used commands.

Sounds Like – a Query and Export criteria operator. The Sounds Like operator can be used when you want to select records based on a field for which you do not know the exact spelling.

source codes – a code used to define the origin of a transaction. Some examples are accounts payable, accounts receivable, cash receipts, general journal, adjustments, fixed assets, purchase orders, and gifts. Source codes are added on the Tables tab in Configuration.

statement codes – a code used to define the frequency with which customers receive invoices, such as weekly, monthly, quarterly and annually. By defining these codes you create a statement cycle.

static query – a type of query that provides a record of the information you select at the time you establish the query. If you run a report two months later using the same query, the system uses the list of records stored in the original query.

status bar – displays important messages across the bottom of the screen to assist you in the program. For example, when the cursor is in a field with a Table Lookup available, the message “Press F7 for Table Lookup” displays in the status bar.

Straight Line Depreciation – depreciation method that expenses an asset value in equal amounts over its useful life.

Students – a module in Blackbaud’s Student Billing program where you create and maintain records containing information about students, parents/guardians, and organizations. This is where you set up billing schedules and payment distributions. You also enter charges, credits, and refunds.

student-based processing – a processing method that focuses billing activity on the student record. While anyone can make payments, all transaction activity is recorded on the student record.

Student Billing – a Blackbaud program designed to simplify the production of billing statements, while offering the capacity for storing detailed information about students, parent/guardians, and organizations.

SUB – the order of the queries is important when using SUB to merge queries, because the merged query contains only those records that are exclusively in the first (primary) query. All records that appear only in the second (secondary) query and records that appear in both queries are eliminated.

SUI – State Unemployment Insurance.

Sum of Years Digits – accelerated depreciation method. Under this method, depreciation is determined by multiplying the asset’s cost less salvage value by a fraction in which the sum of the year’s digits is the denominator and the number of years remaining in the asset’s life is the numerator.

supervisor – a user with the password who can enter the computer program. The supervisor establishes access rights for all users through Security, a shared module.

supplemental wages – items paid in addition to regular wages. Examples of supplemental wages include: awards, bonuses, retroactive wage increases, and tips.

SUTA – State Unemployment Tax.

Swap – Global Change function that allows you to place the entire value from the source field to the target field and the original value of the target field in the source field.
**system** – the internal computer operating component that runs the programs a user installs. In this manual “program” is used instead of “system.”

**Systems Basics** – the name of a chapter in most manuals where you learn about the screens and functions available in the program or optional module.

**T**

**table lookup** – a feature that lets you select and enter information into fields by pressing F7. This can save typing time.

**tabs** – an organizational device that holds specific information within pages on a screen. For example, the Add a Group screen in Security includes multiple tabs.

**term discounts** – a way to define whether customers can receive price reductions based on early payment.

**title bar** – a horizontal strip identifying a program or file and located at the top of a screen. For example, the title bar on Security displays a lock and key icon and the module name.

**toolbar** – a horizontal strip with buttons that, when clicked, perform specific tasks. It is located under the title bar at the top of a screen. For example, the Bank Account Reconciliation toolbar has buttons for New, Bank Account List, Reconcile, Reconciliation Setup, Bank Summary, and more.

**total accounts** – one of three types of entries displayed in the General Ledger Chart of Accounts. Total accounts are designated by a “T” at the end of the account number. These accounts provide sub-totals on financial statements for the balances of regular accounts.

**U**

**UHIC** – Unemployment Health Insurance Contribution.

**useful life** – the period of time that a business asset is determined to have commercial value for depreciation purposes; the IRS determines useful life depreciation periods.

**user preferences** – preferences you can create in Configuration that are unique to your user id.

**user’s guide** – a published manual that explains how to use a Blackbaud program.

**Users in System Form** – used in Utilities and Housekeeping to show how many users are logged into a Blackbaud program. There are several processes in Utilities and Housekeeping that require all users to exit the system before you can perform the process.

**utilities** – a command found on the Bank Accounts main screen where you can initiate Post to General Ledger, Purge Voided Checks, Reconciliation History, and Raiser’s Edge Import.

**Utilities and Housekeeping** – a shared module within Blackbaud programs where you perform general database tasks such as viewing system statistics.

**V**

**Validate Database** – a procedure used in Utilities and Housekeeping that analyzes your database to determine data corruption or any inconsistencies.

**Vendors** – a module in Blackbaud's Accounts Payable where you establish individual records for your vendors.

**vertical truncation report** – a report that details where information on labels will be cut off vertically.

**voluntary deductions** – amounts withheld from an employee’s pay at the request of the employee, such as health insurance premiums or union dues.

**W**

**W-2 form** – Income and Tax Statement. A six-part combined federal/state form given to employees and furnished to the Social Security Administration by January 31 of each year. It shows total wages and other compensation paid, as well as taxes withheld and other requested amounts.

**W-3 form** – Transmittal of Income and Tax Statements. Used to summarize and transmit the paper W-2 forms submitted to the SSA.

**W-4 form** – Withholding certificate used to determine the correct withholding tax on the federal level. Completed by the employee and used by the employer.

**wildcard criteria operator** – a special character or a series of characters (such as ?, *, and %) used to define the conditions a record must meet to be selected.
wizard – a utility that collects specific information from the user and creates a unique file. This unique file may be used as a template. For example, Bank Account Reconciliation requires users to run a Setup Wizard for each bank account. This creates a template of the account for use in all future reconciliations.

worker’s compensation – benefits paid to employees who suffer work-related injuries or illness.

workweek – a fixed and regularly recurring period of 168 consecutive hours, such as seven consecutive 24-hour periods.

X

XOR – determines the final query, which contains all records that appear in either query, but excludes any records that appear in both queries.

Y

year-to-date depreciation – the depreciation that has occurred from the beginning of the year until the current date.

Year-to-Date Depreciation Report – lists depreciable basis, prior year’s depreciation, and year-to-date depreciation expense for selected assets.
Index

Numerics
1099 activity report 219
1099 forms, printing 214
1099 information
   adding 102
   editing 110
1099 information tab, Vendors 102

A
account distribution report 218, 219
account distributions
   adding 49
   deleting 50
   editing 50
account information, viewing 146
Accounting Queue additional module 3
Accounts Payable
   buttons 18
   manual format 4
   modules 2
   optional modules 3
   overview 2
accounts payable tab, Security 61
accounts tab, Reports 223, 255
activity tab, Vendors 107
adding
   1099 information 102
   account distributions 49
   addresses 45
   attributes to tables 41
   bank accounts 143
   countries 54
   credit memos 133
   defaults 110
   electronic signatures 88
   groups 59
   miscellaneous line items 47
   notes to bank accounts 147
   products 43
   project distributions 49
   queries 181
   recurring invoices 128
   table entries 37
   users 64
   vendors 100
additional modules 3
   Accounting Queue 3
   Bank Account Reconciliation 3
   Electronic Funds Transfer 4
   Purchase Orders 4
addresses
   adding 45
   deleting 46
   editing 46
addresses tab
   Configuration 44
adjustment types tab, Bank Accounts 145
advanced tab, Query and Export 173
aged accounts payable report 218
aging information tab, Configuration 51
aging information, establishing 51
aging tab, Reports 233, 258
all reports tab, Reports 264
applying credit memos to invoices 137
attributes
   adding to tables 41
   defining 41
   deleting 112
attributes tab
   Bank Accounts 152
   Configuration 40
   Mail 202
   Reports 225, 258
   Vendors 104
attributes/notes tab, Vendors
   credit memos 136
   recurring invoices 131
   vendors 122
auto applying credit memos 138

B
bank account profile, previewing 148
Bank Account Reconciliation additional module 3
bank accounts
   adding 143
   adding notes 147
   deleting 146
   editing account information 146
   making inactive 147
   viewing account information 146
Bank Accounts module
   overview 140
   preferences 141
Bank Accounts tabs
   adjustment types tab 145
   attributes tab 152
   blackbaud systems tab 144
   check format tab 155
   check position tab 142
   criteria tab 151
   direct disbursement tab 153
   format tab 154
   interfund entries tab 145
   invoices tab 153
   notes tab 146
print format tab 156
bank drafts, recording 163
bank information tab, Vendors 106
bank register legend, establishing 143
banks tab, Reports 224, 257
batch reconciliation report 219
blackbaud systems tab, Bank Accounts 144
Blackbaud’s General Ledger, posting to 82
budget checking
    setting options 36
buttons, Account Payable 18

C

calculator icon 21
calendar icon 22
cards
    rolodex/index, printing 209
    rolodex/index, setting formats 212
cash disbursement journals report 219
cash requirements report 218
change parameters, global change 308
change password screen 20
changing user passwords 69
check alignment, testing 157
check format tab, Bank Accounts 155
check position tab, Bank Accounts 142
checks
    clearing 163
    printing 151
    renumbering 164
    testing alignment 157
    voiding selected checks 164
    voiding unwritten checks 165
clearing checks 163
combining operators 170
common screens 19
Configuration module
    overview 28
tabs 28
Configuration tabs
    addresses tab 44
    aging information tab 51
    attributes tab 40
    distributions tab 48
    general ledger tab 52
    general tab 29
    international tab 53
    misc. line items tab 46
    preferences tab 31
    products tab 42
    tables tab 36
country settings
    adding 54
    deleting 55
    editing 54
creating
import files containing a header record 284
import files with a separate header record 290
import files without field names 271
new records 100
reports 221
credit memo report 218
credit memo tab, Vendors 134
credit memos
    adding 133
    applying to invoices 137
    auto applying 138
    deleting 136
    editing 136
    posting rules 77
    unapplying 138
criteria operators 169
criteria tab
    Bank Accounts 151
    Query and Export 182
currency tab, Query and Export 174

d

database, validating 87
date tab, Query and Export 176
dates tab, Reports 232, 256
default check format, establishing 32
defaults
    adding 110
    deleting 111
    editing 111
    loading vendor defaults 112
defining
    attributes 41
definition
    duplicate vendor and invoice information 35
    search options 114
deleting
    addresses 46
    attributes 112
    bank accounts 146
    country settings 55
country settings
    credit settings 55
    defaults 111
definitions 50
electronic signatures 90
groups 64
invoices 125
miscellaneous line items 47
notes 113
products 44
table entries 39
tables 42
users 68
vendor records 109
direct disbursement tab, Bank Accounts 153
distributions tab, Configuration 48
duplicate vendor and invoice information, defining
### E

- **editing**
  - editing amounts 110
  - addresses 46
  - bank account information 146
  - change parameters 314
  - country settings 54
  - credit memos 136
  - defaults 111
  - distributions 50
  - electronic signatures 89
  - groups 62
  - invoice fields 123
  - miscellaneous line items 47
  - notes 112
  - products 44
  - queries 185
  - query options 186
  - table entries 38
  - users 66
  - vendor records 109

- **Electronic Funds Transfer**
  - additional module 4
  - electronic funds transfers 4

- **electronic signatures**
  - adding 88
  - deleting 90
  - editing 89

- **envelopes**
  - printing 207
  - setting formats 209

- **establishing**
  - default check format 32
  - organization specific settings 30

- **Excel**
  - exporting to 24

- **Export**
  - queries 191
  - to excel 24

### F

- **fields tab, Import** 280
- **fields to include tab, Mail** 203
- **file format tab, Import** 279
- **file layout tab, Import** 281

- **format tab**
  - Bank Accounts 154
  - Mail 204
  - Reports 259
  - Utilities and Housekeeping 83

- **frequency, recurring invoices** 129

- **funds tab, Reports** 222, 255

### G

- **general ledger accounts tab, Security** 65
- **General Ledger settings, establishing** 52
- **general ledger tab, Configuration** 52

- **general tab**
  - Configuration 29
  - Mail 201
  - Query and Export 172
  - Reports 221, 239

- **generating, recurring invoices** 132

- **gl distribution tab, Vendors** 135
  - invoices 120
  - recurring invoices 130
  - vendors 103

- **Global Change module**
  - overview 308
  - preferences 315

- **global changes, performing** 311

- **group profile report**
  - previewing 63
  - printing 63

- **groups**
  - adding 59
  - deleting 64
  - editing 62

### H

- **help, online** 7

- **hold payment report** 218

### I

- **import**
  - viewing a data file 295

- **import files**
  - containing a header record 284
  - with separate header records 290
  - without field names - fixed width 277
  - without field names - separated 271

- **Import module**
  - overview 268
  - parameter files 270

- **import parameter files** 270

- **Import tabs**
  - fields tab 280
  - file format tab 279
  - file layout tab 281
  - options tab 278
  - summary tab 282

- **inactive bank accounts** 147

- **inactive vendors, purging** 92

- **index cards**
  - printing 209
setting formats 212
inserting table entries 38
interfund entries tab, Bank Accounts 145
international tab, Configuration 53
introduction to Accounts Payable 2
invoice expense allocation report 218
invoice generation report 219
invoice payment history report 219
invoice reports 218
invoice tab, Vendors 119
invoices
  paying 127
  payment schedules 126
  reports 218
invoices tab, Bank Accounts 153

K
keys for shortcuts 6

L
label truncation reports, printing 206
labels
  printing 200
  setting formats 206
loading vendor defaults 112

M
Mail module
  overview 196
  preferences 197
Mail tabs
  attributes tab 202
  fields to include tab 203
  format tab 204
  general tab 201
manual checks, recording 162
manual format 4
merging operators 170
merging two queries 190
misc. line items tab, Configuration 46
miscellaneous line items
  adding 47
  deleting 47
  editing 47
miscellaneous preferences, entering 33
modules 2

N
new records
  creating 100
locating 114
notes
  deleting 113
  editing 112
notes tab
  Bank Accounts 146
  Vendors 108
number tab, Query and Export 175

O
online help 7
online manual
  opening 11
open invoice report 219
optimizations tab, Query and Export 181
optional modules 3
options tab, Import 278
organization specific settings, establishing 30
output tab, Query and Export 183
overviews
  Accounts Payable 2
  Bank Accounts 140
  Configuration 28
  Global Change 308
  Import 268
  Mail 196
  Query and Export 168
  Reports 218
  Security 58
  Utilities and Housekeeping 72
  Vendors 96

P
passwords
  changing 69
  overview 68
  screen 20
paying invoices 127
payment schedules for invoices 126
payments/credits tab, Vendors 122
performing a global change 311
post to General Ledger screen 82
posting adjustments, rules 80
posting checks, rules 79
posting credit memos
  examples 78
  rules 77
posting details tab, Utilities and Housekeeping 82
posting direct disbursements, rules 79
posting regular invoices
  examples 74
  rules 73
posting regular invoices with interfund entries, rules 74
posting to Blackbaud’s General Ledger 82
pre-check report, running 158
preferences
  Bank Accounts 141
  Global Change 315
  Mail 197
miscellaneous 33
Query and Export 171
Reports 220
preferences tab, Configuration 31
pre-posting reports
  previewing 84
  printing 84
previewing
  bank account profiles 148
  group profile report 63
  pre-posting reports 84
  query lists 189
  user profile reports 67
print format tab, Bank Accounts 156
print setup screen 19
printing
  1099 forms 214
  checks 151
  envelopes 207
  group profile report 63
  label truncation reports 206
  labels 200
  pre-posting reports 84
  query lists 189
  query results 185
  reports 234
  rolodex cards 209
  tables 40
  user profile reports 67
products
  adding 43
  deleting 44
  editing 44
products tab, Configuration 42
project distribution report 219
project distributions
  adding 49
  deleting 50
  editing 50
projects tab, Reports 234, 259
purchase journal report 219
Purchase Orders additional module 4
purgings
  inactive vendors 92
  vendor activity 90
  voided checks 166
  purging activity, rules 80

Q
queries

adding 181
adding to a list of favorites 192
editing 185
exporting 191
merging 190
options 186
running 185
Query and Export module
  adding queries 181
  combining operators 170
  criteria operators 169
  merging operators 170
  overview 168
  preferences 171
  wildcard characters 170
Query and Export tabs
  advanced tab 173
  criteria tab 182
  currency tab 174
  date tab 176
  general tab 172
  number tab 175
  optimizations tab 181
  output tab 183
  results tab 185
  selected fields tab 187
  sort tab 184
  tables tab 177
  yes/no tab 177
query lists
  previewing 189
  printing 189
query preferences 177, 178
query results, printing 185
query types 168

R
reconciliation reports 219
recording
  bank drafts 163
  manual checks 162
recurring info tab, Vendors 128
recurring invoice report 219
recurring invoices
  adding 128
  frequency 129
  generating 132
recurring tab, Vendors 108
reference sections
  Reports module 238
refreshing static queries 191
regular invoices with interfund entries, posting rules 74
regular invoices, posting rules 73
renumbering checks 164
reports
INDEX

1099 activity report 219
account distribution report 218, 219
aged accounts payable report 218
batch reconciliation report 219
cash disbursement journals report 219
cash requirements report 218
creating reports 221
credit memo report 218
hold payment report 218
invoice expense allocation report 218
invoice generation report 219
invoice payment history report 219
open invoice report 219
printing 234
project distribution report 219
purchase journal report 219
recurring invoice report 219
transaction register report 219
vendor activity report 219
vendor profile report 219
vendor year to date analysis report 219

Reports module
creating reports 221
overview 218
preferences 220
reference 238

Reports tabs
accounts tab 223, 255
aging tab 233, 258
all reports tab 264
attributes tab 225, 258
banks tab 224, 257
dates tab 232, 256
format tab 259
funds tab 222, 255
general tab 221, 239
projects tab 234, 259

reports, accounts payable 218
required import fields 295
results tab, Query and Export 185
rolodex cards
printing 209
setting formats 212
rules
deleting credit memos 136
deleting invoices 125
general posting 72
posting adjustments 80
posting checks 79
posting credit memos 77
posting direct disbursements 79
posting regular invoices 73
posting regular invoices with interfund entries 74
purging activity 80

S
scheduling invoice payments 126
search screen 21
searching
options 114
records 114
Security module
options 61
overview 58
users 64
Security tabs
accounts payable tab 61
general ledger accounts tab 65
shared components tab 60
shared tables tab 60
selected fields tab, Query and Export 187
setting Security options 61
setting vendor preferences 97
shared components tab, Security 60
shared tables tab, Security 60
shortcut keys 6
shortcut menus 19
signatures
adding 88
deleting 90
editing 89
sort tab, Query and Export 184
standard modules 2
static queries, refreshing 191
status bar 15
summary tab, Import 282
summary tab, Vendors 105
system preferences 34
system statistics, viewing 86

T
table entries
adding 37
deleting 39
editing 38
inserting 38
organizing 39

tables
deleting 42
printing 40

tables tab
Configuration 36
Query and Export 177
tabs, defined 23
testing check alignment 157
text format 4
title bar 14
toolbar 15
toolbar buttons 15
transaction details, viewing 166
transaction register report 219

types of queries 168

U

unapplying credit memos 138

user preferences 31

user profile report
    previewing 67
    printing 67

users
    adding 64
    deleting 68
    editing 66

Security 64

Utilities and Housekeeping module
    overview 72

Utilities and Housekeeping tabs
    format tab 83
    posting details tab 82

V

validating the database 87

vendor activity report 219

vendor activity, purging 90

vendor preferences, setting 97

vendor profile report 219

vendor records
    adding 100
    deleting 109
    editing 109

vendor reports 219

vendor tab, Vendors 101

vendor year to date analysis report 219

vendors
    adding 100
    entering biographical information 100, 101

reports 219

Vendors module
    overview 96
    preferences 97

Vendors tabs
    1099 information tab 102
    activity tab 107
    attributes tab 104
    attributes/notes tab 122
    attributes/notes tab (credit memos) 136
    attributes/notes tab (recurring invoices) 131
    bank information tab 106
    credit memo tab 134
    gl distribution tab 103
    gl distribution tab (credit memo) 135
    gl distribution tab (invoices) 120
    gl distribution tab (recurring invoices) 130
    invoice tab 119

notes tab 108

payments/credits tab 122

recurring info tab 128

recurring tab 108

summary tab 105

vendor tab 101

viewing
    account information 146
    system statistics 86

transaction details 166

voided checks, purging 166

voiding
    selected checks 164
    unwritten checks 165

W

wildcard characters 170

Y

yes/no tab, Query and Export 177